WebEx Meeting Center
User Guide

For Hosts, Presenters, and Participants
# Table of Contents

## Chapter 1  Setting up and Preparing for a Meeting ............................ 1

- About setting up Meeting Center ................................................................. 1
- Setting up Meeting Center ........................................................................... 2
  - System requirements for Meeting Center for Windows ......................... 2
  - Setting up Meeting Center for Windows ..................................................... 2
- Uninstalling for Windows .............................................................................. 3
- Preparing for a meeting.................................................................................. 4
  - Checking your system for UCF Compatibility ........................................... 4
  - About WebEx Connect .............................................................................. 5
  - About sharing a remote computer .............................................................. 5

## Chapter 2  Joining a Meeting ................................................................. 7

- About joining ................................................................................................ 7
- About the Join Meeting page ......................................................................... 8
- Joining a meeting from an instant message ................................................. 8
- Joining from an email invitation .................................................................... 9
- Joining from the Meeting Center calendar .................................................. 10
- Joining a meeting from the host’s personal page ......................................... 11
- Joining a meeting using the meeting number .............................................. 11
- Joining a meeting from the host’s personal page using the meeting number ... 11
Joining a meeting from your Meeting Center Web site using the meeting number .......................................................................................................................... 12

Joining a meeting from your iPhone .......................................................................................................................... 12

Joining a meeting from your BlackBerry device ........................................................................................................ 13

Registering for a meeting ............................................................................................................................................. 13

About registering for a meeting .................................................................................................................................. 14

Registering from an email message .......................................................................................................................... 14

Registering from the meeting calendar ..................................................................................................................... 15

Registering from the host’s personal page .................................................................................................................. 16

Obtaining information about a scheduled meeting .................................................................................................... 17

About obtaining meeting information ....................................................................................................................... 17

About the Meeting Information page ....................................................................................................................... 17

Obtaining information from an email message .......................................................................................................... 18

Obtaining information from the meeting calendar .................................................................................................... 19

Obtaining information from the host’s personal page ................................................................................................ 19

Adding a meeting to your calendar program ............................................................................................................ 20

About adding a meeting to your calendar program .................................................................................................... 20

Adding a meeting to your calendar program ............................................................................................................ 20

Chapter 3 Using the Calendar ................................................................................................................................... 23

About the meeting calendar ....................................................................................................................................... 23

Viewing the meeting calendar ................................................................................................................................... 24

Selecting a date on the meeting calendar ................................................................................................................ 25
Searching for a meeting on the meeting calendar .......................................................... 26
Sorting the meeting calendar .......................................................................................... 27
Refreshing the meeting calendar .................................................................................... 28
Selecting a language and time zone on the meeting calendar ........................................ 28
Registering for a meeting from the meeting calendar .................................................... 29

  About the Register for a Meeting page ...................................................................... 29
About the Today view .................................................................................................... 30
About the Daily view ..................................................................................................... 31
About the Weekly view .................................................................................................. 33
About the Monthly view ................................................................................................ 35
About the Search Results page ...................................................................................... 36

Chapter 4 Scheduling a Meeting .................................................................................... 39

  Choosing the scheduler that works for you ................................................................. 39
About the Quick Scheduler ............................................................................................ 40

    About the Quick Scheduler page .............................................................................. 40
Using the Quick Scheduler ............................................................................................ 48
About the Advanced Scheduler ..................................................................................... 49
Choosing a level of security for a scheduled meeting .................................................. 49
Using the Advanced Scheduler ...................................................................................... 50
Page-by-page guide to the Advanced Scheduler .......................................................... 52

    About the Required Information page ..................................................................... 53
About the Date & Time page ......................................................................................... 57
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Audio Conference page</td>
<td>61</td>
</tr>
<tr>
<td>About the Invite Attendees page</td>
<td>66</td>
</tr>
<tr>
<td>About the Select Attendees page</td>
<td>69</td>
</tr>
<tr>
<td>About the Registration page</td>
<td>71</td>
</tr>
<tr>
<td>About the Agenda &amp; Welcome page</td>
<td>74</td>
</tr>
<tr>
<td>About the Meeting Options page</td>
<td>79</td>
</tr>
<tr>
<td>About the Attendee Privileges page</td>
<td>82</td>
</tr>
<tr>
<td>About the Review page</td>
<td>85</td>
</tr>
<tr>
<td>Managing and maintaining your scheduled meetings</td>
<td>85</td>
</tr>
<tr>
<td>Adding a scheduled meeting to your calendar program</td>
<td>86</td>
</tr>
<tr>
<td>Editing a scheduled meeting</td>
<td>87</td>
</tr>
<tr>
<td>Starting a scheduled meeting</td>
<td>88</td>
</tr>
<tr>
<td>Starting a meeting from your iPhone</td>
<td>89</td>
</tr>
<tr>
<td>Canceling a scheduled meeting</td>
<td>90</td>
</tr>
<tr>
<td>Saving time when scheduling a meeting</td>
<td>91</td>
</tr>
<tr>
<td>Using meeting templates</td>
<td>91</td>
</tr>
<tr>
<td>Setting up a recurring meeting</td>
<td>95</td>
</tr>
<tr>
<td>Allowing another user to schedule meetings for you</td>
<td>96</td>
</tr>
<tr>
<td>About the Meeting Scheduled page (for meeting hosts)</td>
<td>97</td>
</tr>
<tr>
<td>About the Meeting Information page (for meeting hosts)</td>
<td>98</td>
</tr>
<tr>
<td>About the Meeting Information page (for attendees)</td>
<td>99</td>
</tr>
<tr>
<td>About the Meeting Updated page</td>
<td>99</td>
</tr>
</tbody>
</table>
Chapter 5  Scheduling a Personal Conference Meeting.................................101
  About Personal Conference meetings............................................................101
  Setting up a Personal Conference meeting ................................................102
  Starting a Personal Conference meeting ....................................................102
  Managing and maintaining your scheduled Personal Conference meetings .......103
  Adding a scheduled Personal Conference meeting to your calendar program 104
  Editing a Personal Conference meeting ....................................................105
  Canceling a Personal Conference meeting ................................................106
  About the Personal Conference Meeting Information page (host) ..................107
  About the Personal Conference Meeting Information page (for attendees) .......108

Chapter 6  Assigning Sounds to Participant Actions............................................111

Chapter 7  Granting Privileges During a Meeting ................................................113
  Selecting participants......................................................................................114
  About Default privileges ...............................................................................115
  Granting or removing privileges ....................................................................115
    Granting or removing Chat privileges .......................................................115
    Granting or removing document privileges ...............................................116
    Granting or removing viewing privileges ................................................117
    Granting or removing meeting privileges ................................................118

Chapter 8  Using WebEx Audio ........................................................................119
  Joining or leaving an audio conference........................................................120
  About Using your computer for audio............................................................121
Fine tuning your microphone and speaker settings ......................................... 122
Switching audio devices during a meeting ....................................................... 122
Inviting a contact to join by phone ................................................................. 123
Muting and unmuting microphones in an audio conference ............................... 124
  Muting and unmuting all participant microphones simultaneously ............... 126
Asking to speak in an audio conference ......................................................... 126
Using caller authentication to start or join an audio conference ...................... 127
  Specifying call-in authentication for your host account .................................. 128
  Using an authentication PIN ........................................................................ 129
  Editing or updating your stored phone numbers ............................................. 129

Chapter 9  Using Integrated Voice Conferences ............................................. 131
  Asking to speak .......................................................................................... 132
  Allowing a participant to speak ................................................................. 133
  Speaking in a voice conference ................................................................. 133
  Muting and unmuting microphones in an audio conference .......................... 134
    Muting and unmuting all participant microphones simultaneously .......... 135
  Understanding the speaker queue for a voice conference ............................ 135
  Fine tuning your microphone and speaker settings ..................................... 136

Chapter 10  Setting Up a One-Click Meeting .................................................. 137
  About setting up a One-Click Meeting ....................................................... 137
  Setting up your One-Click Meeting on the Web ........................................... 138
  About the One-Click Settings page ............................................................. 138
Installing WebEx Productivity Tools ................................................................. 142
Starting a One-Click Meeting .......................................................................... 143
Removing WebEx Productivity Tools ............................................................... 147

Chapter 11  A Quick Tour of the Meeting Window............................................ 149

Working with panels ....................................................................................... 150
Using panels to interact with other participants .............................................. 151
Managing panels ............................................................................................. 153
Restoring the panel layout .............................................................................. 153
Accessing panel options ............................................................................... 154
Resizing the content viewer and panels area ............................................... 155
Accessing panels from the Meeting Controls Panel ....................................... 156
Viewing Panel alerts ....................................................................................... 157

Chapter 12  Managing a Meeting................................................................. 159

Inviting more people to your in-progress meeting ....................................... 159
Inviting people by instant message to a meeting in progress .................... 160
Inviting people by email to a meeting in progress ....................................... 162
Inviting participants by phone to a meeting in progress ........................... 163
Inviting participants by text message (SMS) to a meeting in progress .... 164
Reminding invitees to join your meeting ..................................................... 164
Making a participant the presenter when you are in the meeting window ...... 165
Making someone else the presenter when you are sharing ....................... 167
Making someone else the host ...................................................................... 167
Transferring the host role ...................................................................................... 168
Reclaiming the host role ........................................................................................ 169
Obtaining information about a meeting after it starts .......................................... 170
Editing a message or greeting during a meeting ................................................... 170
Restricting access to a meeting ............................................................................ 171
Removing a participant from a meeting ................................................................. 172
Leaving a meeting .................................................................................................  172
Sending a meeting transcript to participants ......................................................... 173
Ending a meeting .................................................................................................. 174

Chapter 13  Managing Recorded Meetings ............................................................. 177

Opening the My Recorded Meetings Page ........................................................... 177
  About the Recording Information page ............................................................... 178
  About the My Recorded Meetings page............................................................... 179
Uploading a recorded meeting file ......................................................................... 181
Editing information about a recorded meeting ....................................................... 182
  About the Add/Edit Recorded Meetings page .................................................... 182
Sending an email to share a recorded meeting ...................................................... 183

Chapter 14  Sharing Presentations, Documents, and Whiteboards ...................... 185

Granting sharing privileges ................................................................................... 186
Content viewer tools .............................................................................................. 186
  Changing views in a file or whiteboard ............................................................. 187
Using annotation tools on shared content............................................................ 188
Sharing presentations or documents ................................................................. 189
  Sharing a document or presentation .............................................................. 189
  Tips for sharing documents and presentations .............................................. 190
  Choosing an import mode for document or presentation sharing .................. 191
Sharing a whiteboard .................................................................................... 192
  Starting whiteboard sharing ....................................................................... 192
Navigating presentations, documents, or whiteboards ...................................... 193
  Navigating slides, pages, or whiteboards using the toolbar ......................... 193
  Advancing pages or slides automatically ....................................................... 194
  Animating and adding effects to shared slides .............................................. 195
  Using keyboard shortcuts to control a presentation ...................................... 196
Working with pages or slides ..................................................................... 197
  Adding new pages to shared files or whiteboards ....................................... 197
  Pasting images in slides, pages, or whiteboards ......................................... 197
Managing views of presentations, documents, or whiteboards .......................... 198
  Zooming in or out ..................................................................................... 198
  Controlling full-screen view ....................................................................... 199
  Viewing thumbnails .................................................................................... 200
  Synchronizing all participant views ............................................................ 201
  Clearing annotations ................................................................................... 202
  Clearing pointers ....................................................................................... 203
Saving, opening, and printing presentations, documents, or whiteboards .......... 203
Saving a presentation, document, or whiteboard.............................. 204
Opening a saved document, presentation, or whiteboard............... 205
Printing presentations, documents, or whiteboards..................... 205
If you are a meeting participant.......................................................... 206
Displaying pages, slides, or whiteboards........................................ 206
Synchronizing your view of pages, slides, or whiteboards............. 207

Chapter 15  Sharing Web Content......................................................... 209

About sharing Web content................................................................. 209
Sharing Web content.......................................................................... 210
Differences between sharing Web content and sharing a Web browser .... 210

Chapter 16  Sharing Software................................................................. 213

Sharing applications.......................................................................... 214
Starting application sharing............................................................... 215
Sharing several applications at once.................................................. 216
Stopping application sharing for all participants............................ 217
Sharing your desktop......................................................................... 217
Starting desktop sharing.................................................................... 218
Stopping desktop sharing.................................................................. 218
Sharing a Web browser..................................................................... 219
Starting Web browser sharing.......................................................... 219
Stopping Web browser sharing......................................................... 220
Sharing a remote computer................................................................. 220
Starting remote computer sharing ................................................................. 221
Sharing additional applications on a shared remote computer .................. 222
Stopping remote computer sharing ............................................................... 223
Managing a shared remote computer ............................................................ 224
Reducing the screen resolution for a shared remote computer .................. 225
Disabling and enabling the keyboard when sharing a remote computer ...... 226
Adjusting the size of the view of a shared remote computer ...................... 227
Hiding the contents on a shared remote computer's screen ...................... 227
Sending a Ctrl+Alt+Del command to a shared remote computer ............ 228
Selecting an application on a shared remote computer ............................. 228
Controlling views of shared software ......................................................... 229
Pausing and resuming software sharing ...................................................... 230
Controlling full-screen view of shared software ......................................... 231
Synchronizing views of shared software .................................................... 231
Selecting a monitor to share ....................................................................... 232
Controlling your view as a participant ....................................................... 234
Closing your participant sharing window .................................................. 235
Switching your participant view ................................................................. 235
Annotating shared software ....................................................................... 236
Starting and stopping annotation .............................................................. 237
Using annotation tools .............................................................................. 238
Letting a participant annotate shared software ........................................... 239
Chapter 17 Using Chat ................................................................. 251

Sending chat messages ................................................................. 251
Assigning sounds to incoming chat messages .......................... 252
Printing chat messages ................................................................. 253
Saving chat messages ................................................................. 253
  Saving chat messages to a new file ........................................... 253
  Saving changes to a chat file ................................................. 254
Creating a copy of previously saved chat messages .............. 254
Opening a chat file during a meeting ....................................... 254

Granting participants control of shared software ................. 242
Requesting remote control of shared software ...................... 243
Letting a participant remotely control shared software ............ 244
Automatically letting participants remotely control shared software .......... 244
Stopping remote control of shared software ......................... 245

Sharing applications with detailed color (Windows) ............ 246
Sharing applications with detailed color (Mac) ......................... 247
Tips for sharing software .......................................................... 248
Taking public notes (meeting minutes) .......................................................... 275
Providing closed captions .............................................................................. 276
Saving notes to a file ....................................................................................... 277
Sending a meeting transcript to participants .................................................. 278

Chapter 21 Sending and Receiving Video ....................................................... 281
Setting the main display .................................................................................. 282
Switching to and from full-screen mode ......................................................... 283
Display a list or thumbnail view of participants ............................................. 285
Setting webcam options .................................................................................. 286
Managing video during sharing ...................................................................... 287

Chapter 22 Using My WebEx .......................................................................... 289
About My WebEx ............................................................................................ 290
MC_About My WebEx2 .................................................................................... 291
Obtaining a user account ............................................................................... 291
Logging in to and out of the WebEx service site ............................................ 292
Using your list of meetings .............................................................................. 293
About your list of meetings ............................................................................ 293
Opening your meetings list ............................................................................ 293
Maintaining your scheduled meetings list ..................................................... 295
About the My WebEx Meetings page .............................................................. 295
About the My WebEx Meetings page - Daily tab ......................................... 296
About the My WebEx Meetings page - Weekly tab ........................................ 298
Setting up and Preparing for a Meeting

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of setting up Meeting Center</td>
<td>About setting up Meeting Center (on page 1)</td>
</tr>
<tr>
<td>set up Meeting Center for Windows</td>
<td>Setting up Meeting Center for Windows (on page 2)</td>
</tr>
<tr>
<td>remove Meeting Center from your computer</td>
<td>Uninstalling Meeting Center for Windows (on page 3)</td>
</tr>
<tr>
<td>make sure your system can handle Universal Communications Format (UCF) media files</td>
<td>Checking your system for UCF Compatibility (on page 4)</td>
</tr>
<tr>
<td>get an overview of setting up WebEx Connect</td>
<td>About WebEx Connect (on page 5)</td>
</tr>
</tbody>
</table>

About setting up Meeting Center

To participate in a meeting, you must set up Meeting Center on your computer. Once you schedule, start, or join a meeting for the first time, your meeting service Web site starts the setup process. However, to save time, you can set up the application at any time before scheduling, starting, or joining a meeting.
Setting up Meeting Center

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of system</td>
<td>System requirements for Meeting Center for Windows (on</td>
</tr>
<tr>
<td>requirements</td>
<td>page 2)</td>
</tr>
<tr>
<td>set up Meeting Center for Windows</td>
<td>Setting up Meeting Center for Windows (on page 2)</td>
</tr>
<tr>
<td>check your system for UCF</td>
<td>Checking your system for UCF Compatibility (on page 4)</td>
</tr>
<tr>
<td>compatibility</td>
<td></td>
</tr>
</tbody>
</table>

System requirements for Meeting Center for Windows

You can find the system requirements and other information about compatible browsers and operating systems on the User Guides page for your service:

1. Log in to your WebEx Meeting Center site.
2. On the WebEx Meeting Center navigation bar, click Support > User Guides.
3. On the right side of the page, under Release Notes and FAQs, click the link for release notes.

Setting up Meeting Center for Windows

Before installing Meeting Center, ensure that your computer meets the minimum system requirements. For details, see System requirements for Meeting Manager for Windows (on page 2).

If you are not using the Windows operating system, please refer to our FAQ, which includes information about setting up Meeting Center on other operating systems.

To go to the list of FAQs:

1. On your Meeting Center Web site, on the left navigation bar, click Support > User Guides.
2. On the User Guides page, under Release Notes and FAQs, click the link for FAQs (Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information about your operating system under Minimum System Requirements.
Chapter 1: Setting up and Preparing for a Meeting

To set up Meeting Center for Windows:

1. On the navigation bar, expand Set Up, and then click Meeting Manager.
   The Set Up page appears.
2. Click Set Up.
3. If a security dialog box appears, click Yes.
   Setup continues. A progress message box appears, indicating the progress of setup.
4. On the Setup Complete page, click OK.
   You can now start, schedule, or join a meeting.

**Note:**
- Alternatively, you can download the Meeting Manager for Windows Installer from the Support page on your Meeting Center Web site, and then install Meeting Manager on your Web browser. This option is useful if your system does not allow you to install Meeting Manager directly from the Set Up page.
- If you or another attendee plans to share Universal Communications Format (UCF) media files during a meeting, you can verify that the required components are installed on your system to play the media files. For details, see Checking your system for UCF Compatibility (on page 4).

### Uninstalling for Windows

You can easily uninstall or remove Meeting Manager for Windows on your computer.

1. Do one of the following:
   - For Windows 2000: On your computer's desktop, double-click My Computer, and then open the Control Panel folder.
   - For Windows XP: Click Start, and then click Control Panel.
2. Double-click Add/Remove Programs or Add or Remove Programs, depending on your computer's operating system.
   A dialog box appears, showing a list of programs installed on your computer.
3. In the list, select WebEx.
4. Click Add/Remove or Change/Remove, depending on your computer's operating system.
   A message appears, asking you to confirm that you want to remove the software.
Chapter 1: Setting up and Preparing for a Meeting

5. Click Yes.
   The Uninstall WebEx Software dialog box appears.
6. Select Meeting Manager.
7. Click Uninstall.
8. Once the software is removed, click Finish.
   Select an option to restart your computer now or later.

Preparing for a meeting

To take advantage of the many features available in a meeting, check your system and then install some tools to extend meeting capabilities.

- Check your system for UCF compatibility (if you have presentations with animations, save them as .ucf so meeting attendees can view these effects) More... (on page 4)
- Set up and install Cisco WebEx Connect More... (on page 5)
- Share a remote computer, if this feature is available More... (on page 5)

Checking your system for UCF Compatibility

If you intend to play or view Universal Communications Format (UCF) media files during the meeting, either as a presenter or an attendee, you can verify that the following components are installed on your computer:

- Flash Player, for playing a Flash movie or interactive Flash files
- Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a UCF multimedia presentation or standalone UCF media files.

To check your system for UCF compatibility:
1. On the navigation bar, do one of the following:
   - If you are a new meeting service user, click New User?.
   - If you are already a meeting service user, expand Set Up, then click Meeting Manager.
2. Click Verify your rich media players.
3. Click the links to verify that the required players are installed on your computer.
Chapter 1: Setting up and Preparing for a Meeting

Note: The option to check your system for required rich media players is available only if your Meeting Center Web site includes the UCF option.

About WebEx Connect

Use WebEx Connect, the instant messenger for business users to send secure instant messages, invite or remind participants, and manage a meeting. Connect integrates with Microsoft Outlook corporate directories and calendars, encrypts messages and scans them for viruses, and offers quick access to business conferencing services from WebEx.

To download WebEx Connect:
1. Log in to your Meeting Center Web site.
2. On the Meeting Center navigation bar, click Support > Downloads.
3. Scroll down to the section of the page describing WebEx Connect.
   Click the link to learn more about this product and download it.

About sharing a remote computer

Use remote computer sharing to show all meeting attendees a remote computer. Depending on how you set up the remote computer, you can show the entire desktop or just specific applications. Use remote computer sharing to show attendees an application or file that is available only on a remote computer.

Attendees can view your remote computer, including all your mouse movements, in a sharing window on their screens.

You can share a remote computer during a meeting for which you are the presenter, if:

- You have installed the Access Anywhere Agent on the remote computer
- You logged in to your Meeting Center Web site before joining the meeting, if you are not the original meeting host

For information about setting up a computer so you can access it remotely, refer to the Access Anywhere User's Guide.
Joining a Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of joining a meeting</td>
<td>About joining a meeting</td>
</tr>
<tr>
<td>join a meeting from an instant message</td>
<td>Joining a meeting from an instant message</td>
</tr>
<tr>
<td>join a meeting from an email invitation</td>
<td>Joining a meeting from an email invitation</td>
</tr>
<tr>
<td>join a meeting from the meeting calendar</td>
<td>Joining a meeting from the meeting calendar</td>
</tr>
<tr>
<td>join a meeting from the host's personal</td>
<td>Joining a meeting from the host's personal</td>
</tr>
<tr>
<td>meeting page</td>
<td>meeting page</td>
</tr>
<tr>
<td>join a meeting if the meeting is not listed on</td>
<td>Joining a meeting using the meeting number</td>
</tr>
<tr>
<td>the calendar or on the host's personal</td>
<td></td>
</tr>
<tr>
<td>meeting page</td>
<td></td>
</tr>
<tr>
<td>obtain information about a meeting, such as</td>
<td>Obtaining information about a scheduled</td>
</tr>
<tr>
<td>its agenda and meeting number</td>
<td>meeting</td>
</tr>
<tr>
<td>add a scheduled to your calendar program,</td>
<td>Adding a meeting to your calendar program</td>
</tr>
<tr>
<td>such as Microsoft Outlook</td>
<td></td>
</tr>
<tr>
<td>register for a meeting</td>
<td>Registering for a meeting</td>
</tr>
</tbody>
</table>

About joining

You can join a meeting in a number of ways. The simplest and quickest is by clicking the meeting URL, which the host can send you via an invitation email message or an instant message.
If the host has given you just the meeting number, you have a couple of ways to join the meeting. For details, see Joining a meeting using the meeting number (on page 11).

**Notes:**
- The meeting host may choose to record the meeting.
- If you are the host but you inadvertently land on the page for participants to join the meeting, click If you are the host, start your meeting.
- If you are the participant but you inadvertently land on the page for the host to start the meeting, click If you are not the host, join as a participant.

### About the Join Meeting page

To access this page: Click the meeting link in your invitation email message, and then click Join Now.

When joining a meeting, you may need to enter some details on the Join Meeting page:

- **Your name:** Enter the name you want attendees to use to identify you during the meeting.
- **Email address:** Enter your email address, in this format: name@your_company—for example, msmith@company.com.
- **Meeting password:** Enter the meeting password. The meeting host may have included the password in the email invitation or, for security reasons, provided it to you in another way. If the meeting does not require a password, the text box does not appear on this page.

### Joining a meeting from an instant message

1. From the instant message window, click the link to join the meeting.
Chapter 2: Joining a Meeting

On the Meeting Information page, enter the requested information. For instance, you may be asked to enter the meeting password.

3 Click **Join Now**.

The Meeting window appears.

### Joining from an email invitation

If you received an email invitation to a meeting, you can join the meeting by clicking a link in the invitation.

**Note:** As you fill in the information requested, you may also be asked to type your username and password. This page appears only if the meeting host requires that you have a user account to attend the meeting.

To join a listed meeting from an invitation email message:

1 Open your email invitation, and then click the link.
2 On the Meeting Information page, enter any requested information.
   For details, see *About the Join Meeting page* (on page 8).
3 Click **Join Now**.

The Meeting window appears.

**Note:** If you did not receive an email invitation to a meeting, you can also join a meeting directly from your Meeting Center Web site or from the host's Personal Meeting Room page. For details,
Joining from the Meeting Center calendar

If you do not have an email invitation for a meeting, you can join it from the meeting calendar, if the meeting host has listed it there.

To join a meeting listed on the meeting calendar:

1. On the navigation bar, expand Attend a meeting, and then click Browse Meetings.
   The Browse Meetings page appears.
2. On the meeting calendar, locate the meeting that you want to attend.
   Tips for quickly finding a meeting:
   - Select a view of the meeting calendar by clicking one of the following tabs: Today, Daily, Weekly, or Monthly. For more information about calendar views, see Viewing the meeting calendar. (on page 24)
   - Sort a meeting list by clicking the column headings. For details, see Sorting the meeting calendar. (on page 27)
   - View a meeting list for another date. For details, see Selecting a date on the meeting calendar (on page 25)
   - Search for a meeting. For details, see Searching for a meeting on the meeting calendar (on page 26).
3. Under Status, click Join.
4. On the Meeting Information page, enter any requested information.
5. Click Join Now.
   The Meeting window appears.

Tip:
- You can obtain detailed information about a selected meeting or its agenda before joining it. For details, see Obtaining information about a scheduled meeting (on page 17).
- You can display all meeting times in another time zone.
- You can refresh the meeting calendar to ensure that you are viewing the most recent information.
Joining a meeting from the host's personal page

You can join a meeting from the host's Personal Meeting Room page if the host has listed it there.

To join a listed meeting from the host's Personal Meeting Room page:

1. Go to the URL, or Web address, for the host's Personal Meeting Room page. The host must provide you with this URL.
2. On the Meetings tab and under Meetings in Progress, locate the meeting that you want to join.
3. Under Status, click Join.
4. On the Meeting Information page, enter any requested information
5. Click OK.

The Meeting window appears.

Tip: If the meeting is not in progress, you cannot join the meeting. To check whether the host has started the meeting, you can periodically click the Refresh button on the page.

Joining a meeting using the meeting number

If the meeting host has not included a link to the meeting on the meeting calendar or on his or her Personal Meeting page, you can still join that meeting. You need to obtain the meeting number from the meeting host.

You can join a meeting by providing the meeting number on either:

- Your Meeting Center Web site, see Joining a meeting from your Meeting Center Web site using the meeting number (on page 12).
- The host's Personal Meeting page on your Meeting Center Web site, if the host gave you the URL (Web address) for the page, see Joining a meeting from the host's personal page using the meeting number (on page 11).

Joining a meeting from the host's personal page using the meeting number

If you want to attend a meeting that is not on the host's Personal Meeting Room page, you can still join that meeting. Simply ask the host for the meeting number.
Chapter 2: Joining a Meeting

To join a meeting from the host's Personal Meeting Room page:

1. Go to the URL, or Web address, for the host's Personal Meeting Room page. The host must provide you with this URL.

2. On the Meetings tab and under Join an Unlisted Meeting, type the meeting number that the host gave to you in the Meeting number box.

3. Click Join Now.

4. On the Meeting Information page, enter the requested information.
   
   For details, see About the Join Meeting page (on page 8).

5. Click Join Now.

   The Meeting window appears.

Joining a meeting from your Meeting Center Web site using the meeting number

If the meeting you want to attend is not listed on the meeting calendar, you can still join the meeting. You just need to know the meeting number, which the meeting host can give you.

To join an unlisted meeting from your Meeting Center Web site:

1. On the navigation bar, expand Attend a meeting, and then click Unlisted Meeting.

   The Join an Unlisted Meeting page appears.

2. In the Meeting number box, type the meeting number that the host gave to you.

3. Click Join Now.

4. On the Meeting Information page enter any requested information.

5. Click Join Now.

   The Meeting window appears.

Joining a meeting from your iPhone

If you receive an invitation to a meeting on your iPhone, you can join the meeting by tapping the link in the invitation or from the Meet icon on your iPhone's home page.

To join a meeting from an email invitation link:

In your email invitation, tap the meeting link.
Chapter 2: Joining a Meeting

The WebEx Meeting Center application launches.

**To join a meeting from your Meet icon:**

Open your home page, and tap the Meet icon.
The WebEx Meeting Center application launches.

**Note:** If you have a WebEx account, we recommend that you sign in and save your account settings so you can join meetings quickly in the future.

For detailed information about all aspects of using your iPhone to start or attend meetings, visit our [website](http://www.webex.com/apple/).

---

### Joining a meeting from your BlackBerry device

If you have no WebEx account, join a meeting in one of these ways:

- Start the WebEx Meeting Center application and then select **Join Now** on the welcome screen.
- Select the appropriate link in your email invitation or the meeting item on your calendar.

If you have a WebEx account, follow these steps to join a meeting:

1. Start the WebEx Meeting Center application.
2. Sign in to your WebEx account if you have not signed in or saved your account settings.
   - We recommend that you save your account settings to join meetings quickly in the future.
3. Select the meeting on the My Meetings page.
4. Select **Join Meeting** on the menu.

---

### Registering for a meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of registering for a meeting</td>
<td><em>About registering for a meeting</em> (on page 14)</td>
</tr>
<tr>
<td>register for a meeting from an invitation email</td>
<td><em>Registering from an email message</em> (on page 14)</td>
</tr>
</tbody>
</table>
Chapter 2: Joining a Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>message</td>
<td>14)</td>
</tr>
<tr>
<td>register for a meeting from the meeting calendar on your Meeting Center Web site</td>
<td>Registering from the meeting calendar (on page 15)</td>
</tr>
<tr>
<td>register for a meeting from the host’s Personal Meeting Room page</td>
<td>Registering from the host’s personal page (on page 16)</td>
</tr>
</tbody>
</table>

About registering for a meeting

If a meeting host invites you to a meeting that requires registration, you receive an invitation email message. The email message contains a link that you can click to register for the meeting.

If you did not receive an email invitation to a meeting that requires registration, you can register for the meeting on either:

- The meeting calendar on your Meeting Center Web site
- The host's Personal Meeting Room page on your Meeting Center Web site, if the host gave you the URL, or Web address, for the page
- Registering from an email message
- Registering from the meeting calendar
- Registering from the host’s personal page
- Obtaining information about a scheduled meeting

Registering from an email message

If you received an invitation email message for a meeting that requires registration, you can register for the meeting from the message.

To register for a meeting from an invitation email message:

1. Open your invitation email, and then click the link to register for the meeting.
2. On the Meeting Information: [Topic] page that appears, click Register.
   The Register for [Topic] page appears.
3. Provide the required information.
Chapter 2: Joining a Meeting

4 Click **Register Now**.

Once the host approves your registration, you receive a registration confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all registration requests automatically, you join the meeting immediately.

**Registering from the meeting calendar**

If you did not receive an invitation email message for a meeting that requires registration, you can register for it from the meeting calendar on your Meeting Center Web site.

**To register for a meeting from the meeting calendar:**

1 On the navigation bar, expand **Attend a meeting**, and then click **Register**.

The Register for a meeting page appears, showing the meeting calendar. This calendar lists each meeting that requires registration for the current date.

2 On the meeting calendar, locate the meeting for which you want to register.

To locate a meeting quickly, you can:

- Sort the meeting list by clicking the column headings. For details, see *Sorting the meeting calendar* (on page 27).
- Display the meeting list for another date. For details, see *Selecting a date on the meeting calendar* (on page 25).
- Find a meeting. For details, see *Searching for a meeting on the training meeting* (on page 26).

3 Under **Topic**, select the option button for the meeting for which you want to register.

4 Click **Register**.

5 On the Register for [Topic] page that appears, provide the required information.

6 Click **Register Now**.

Once the host approves your registration, you receive a registration confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all registration requests automatically, you join the meeting immediately.

**Tip:**

- You can obtain detailed information about a selected meeting or its agenda before registering.
Chapter 2: Joining a Meeting

Registering from the host's personal page

You can register for a meeting from the host's Personal Meeting Room page on your Meeting Center Web site.

To register for a meeting from the host's Personal Meeting Room page:

1. Go to the URL, or Web address, for the host's Personal Meeting Room page. The host must provide you with this URL.

2. On the Meetings tab, do one of the following:
   - If the meeting is not currently in progress, under Scheduled Meetings, click Register.
   - If the meeting is currently in progress, under Meetings in Progress, click Join Now. On the Join Meeting: [Topic] page that appears, click Register.

3. If the Log In page appears, provide your user name and password, and then click Log In.

   The Log In page appears only if the meeting host requires that you have a user account to join the meeting. In this case, you must provide your user name and password before you can register for the meeting.

4. On the Register for [Topic] page that appears, provide the required information.

5. Click Register Now.

Once the host approves your registration, you receive a registration confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all registration requests automatically, you join the meeting immediately.
Chapter 2: Joining a Meeting

Obtaining information about a scheduled meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of obtaining information about a scheduled meeting</td>
<td>About obtaining meeting information (on page 17)</td>
</tr>
<tr>
<td>obtain meeting information from an invitation email message</td>
<td>Obtaining information from an email message (on page 18)</td>
</tr>
<tr>
<td>obtain meeting information from the host's Personal Meeting Center Room page</td>
<td>Obtaining information from the host's personal page (on page 19)</td>
</tr>
</tbody>
</table>

About obtaining meeting information

Before joining a meeting, you can obtain information about it from the Meeting Information page. The information you can view includes the host's name and email address, meeting number, and agenda. If you received an email invitation to a meeting, you can click a link in the message to view the meeting information.

If you did not receive an email invitation from the host, you can view the meeting information from either:

- The meeting calendar on your Meeting Center Web site
- The host's Personal Meeting Room page on your Meeting Center Web site, if the host gave you the URL, or Web address, for the page.

About the Meeting Information page

To access this page: In your invitation email message, click the appropriate link.

The Meeting Information: [Topic] page provides information about a selected meeting. The following is a description of the information you can view from that page.

<table>
<thead>
<tr>
<th>Term</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Status of the meeting can be: Not Started, Join Now, or Registration (Meeting Center only).</td>
</tr>
</tbody>
</table>
### Obtaining information from an email message

If you receive an email invitation for a meeting, you can view the meeting information from the email message.

**To obtain information about a meeting from an invitation email message:**

1. Open your invitation email message, and then click the link.
   
   The Meeting Information appears.

2. Optional. To view the meeting agenda, click **View Agenda**.

#### Table: Meeting Details

<table>
<thead>
<tr>
<th>Term</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date of the meeting—for example, July 28, 2009.</td>
</tr>
<tr>
<td>Starting time</td>
<td>Starting time for the meeting, including the time zone—for example, 10:00 am, Pacific Standard Time.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of the meeting in hours or minutes—for example, 1 hour or 30 minutes.</td>
</tr>
<tr>
<td>Meeting number</td>
<td>Number that the meeting server assigns to a meeting automatically.</td>
</tr>
<tr>
<td>Meeting password</td>
<td>Meeting password that the host specified.</td>
</tr>
<tr>
<td>Teleconference</td>
<td>Instructions for joining the teleconference, if the host included one for the meeting.</td>
</tr>
<tr>
<td>Host</td>
<td>Meeting host’s full name.</td>
</tr>
<tr>
<td>Alternate host</td>
<td>Appears only if the host designated one or more participants as alternate hosts.</td>
</tr>
<tr>
<td>Host’s email address</td>
<td>Host's email address.</td>
</tr>
<tr>
<td>Agenda</td>
<td>Displays the Agenda page, where you can view the meeting's detailed agenda provided by the host.</td>
</tr>
<tr>
<td>Add to My Calendar</td>
<td>Adds the meeting to your calendar program, such as Microsoft Outlook. Your calendar program must support the iCalendar standard, a common format for exchanging calendaring and scheduling information across the Internet.</td>
</tr>
</tbody>
</table>
Chapter 2: Joining a Meeting

Obtaining information from the meeting calendar

If you did not receive an email invitation, you can obtain meeting information from the meeting calendar on your Meeting Center Web site.

To obtain information about a meeting from the meeting calendar:

1. From the navigation bar on your Meeting Center Web site, expand Attend a meeting.
2. Click Browse Meetings.
3. On the meeting calendar, locate the meeting about which you want to obtain information.
4. Under Topic, click the link for the meeting.

   If the meeting requires a password, the Get Info page appears.
   If the meeting does not require a password, the Meeting Information page appears. You can skip to step 6.

5. If the Get Info page appears, type the password that the meeting host gave to you in the Meeting password box, and then click OK.
6. Optional. To view the meeting's agenda, click View Agenda.

The Agenda page appears.

Obtaining information from the host's personal page

You can obtain meeting information from the host's Personal Meeting Room page on your Meeting Center Web site.

To obtain meeting information from the host's Personal Meeting Room page:

1. Go to the URL, or Web address, for the host's Personal Meeting Room page. The host must provide you with this URL.
2. On the Meetings tab, locate the meeting about which you want to obtain information.
3. Under Topic, click the link for the meeting.

   If the meeting requires a password, the Get Info page appears.
   If the meeting does not require a password, the Meeting Information page appears.

4. If the Get Info page appears, type the password that the meeting host gave to you in the Meeting password box, and then click OK.
Chapter 2: Joining a Meeting

Optional. To view the meeting’s agenda, click **View Agenda**.

## Adding a meeting to your calendar program

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of adding a scheduled meeting to your calendar program</td>
<td>About adding a meeting to your calendar program (on page 20)</td>
</tr>
<tr>
<td>add a scheduled meeting to your calendar program</td>
<td>Adding a meeting to your calendar program (on page 20)</td>
</tr>
</tbody>
</table>

### About adding a meeting to your calendar program

You can add a scheduled meeting to your calendar program, such as Microsoft Outlook. This option is applicable only if your calendar program supports the iCalendar standard, a common format for exchanging calendaring and scheduling information across the Internet.

You can add a meeting to your calendar from *either*:

- The invitation email message that you receive from the host
- The Meeting Information page for the meeting, which you can access by clicking the link for the meeting on the meeting calendar or on the host’s Personal Meeting Room page

### Adding a meeting to your calendar program

You can add a scheduled meeting to your calendar program if your calendar program supports the iCalendar standard.

**To add a scheduled meeting to your calendar:**

1. Do one of the following, as appropriate:
   - In the invitation email message that you receive, click the link to add the meeting to your calendar.
   - On the Meeting Information page for the meeting, click **Add to My Calendar**.

   a meeting item opens in your calendar program.
2 Accept the meeting request. For example, in Outlook, click **Accept** to add the meeting item to your calendar.

**Note:** If the host cancels the meeting, the cancellation email message that you receive contains an option that lets you remove the meeting from your calendar program.
### Using the Calendar

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using the calendar</td>
<td>About the meeting calendar (on page 23)</td>
</tr>
<tr>
<td>view the meeting calendar</td>
<td>Viewing the meeting calendar (on page 24)</td>
</tr>
<tr>
<td>select a date on the meeting calendar</td>
<td>Selecting a date on the meeting calendar (on page 25)</td>
</tr>
<tr>
<td>search for a Meeting on the meeting calendar</td>
<td>Searching for a meeting on the meeting calendar (on page 26)</td>
</tr>
<tr>
<td>sort the meeting calendar</td>
<td>Sorting the meeting calendar (on page 27)</td>
</tr>
<tr>
<td>refresh the meeting calendar</td>
<td>Refreshing the meeting calendar (on page 28)</td>
</tr>
<tr>
<td>select a language and time zone on the meeting calendar</td>
<td>Selecting a language and time zone on the meeting calendar (on page 28)</td>
</tr>
<tr>
<td>register for a meeting from the meeting calendar</td>
<td>Registering for a meeting from the meeting calendar (on page 29)</td>
</tr>
</tbody>
</table>

### About the meeting calendar

The public meeting calendar on your Meeting Center Web site provides information about each listed meeting that is either scheduled or in progress. However, the meeting calendar does not provide information about any unlisted meeting.

You can navigate the meeting calendar to quickly find a listed meeting - either on the current date or any date - using one of several calendar views. For example, you can view a meeting list for today's date only or for an entire month.
When viewing a meeting list, you can sort the list and refresh it at any time.
You can view a list of meetings that require registration.

**Viewing the meeting calendar**

You can open one of the following calendar views of all listed meetings:

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today</td>
<td>Contains a list of meetings occurring on the current date, including all meetings currently in progress and all scheduled meetings that are not yet in progress.</td>
</tr>
<tr>
<td>Daily</td>
<td>Contains a single list of all meetings occurring on the current date, or on another date to which you have navigated.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Contains a list of scheduled meetings for each day of the selected week.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Indicates on which dates meetings are scheduled for the selected month.</td>
</tr>
</tbody>
</table>

To open a calendar view of all scheduled meetings:

1. On the navigation bar, expand **Attend a meeting** to view a list of links.
2. Click **Browse Meetings**.
   
   The meeting calendar appears.
3. Click the tabs to navigate to different views of the meeting calendar.
   
   You can also view a list that includes past meetings.

You can view a list of meetings that require registration.

**To include past meetings in your list of meetings:**

1. Select the **Today** or **Daily** tab.
2. Select the **Show past meetings** check box.
   
   The list of meetings displays accordingly for the tab.

**To display a list of only meetings that require registration:**

1. Select the **Today**, **Upcoming**, **Daily**, or **Weekly** tab.
2. Select the **Show only meetings that require registration** check box.
   
   The list of meetings that require registration displays accordingly for the tab.
Selecting a date on the meeting calendar

You can view a list of scheduled meetings for any date on the meeting calendar.

To display a list of scheduled meetings for the previous or next day:

1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).

2. On the Daily view of the calendar page, click the forward or backward arrow to navigate to the list of meetings for the next or previous day.

For details about the options on the Daily view, see About the Daily view (on page 31).

Note: You can use this procedure on the Register for a Meeting page as well.

To display a list of meetings for a specific date:

1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).

   On the Today, Upcoming, Daily, or Weekly tab on the calendar page, click the Calendar icon.

The Calendar window appears, showing the calendar for the current month.

2. Optional. Do any of the following:

   ▪ To view the calendar for the previous month, click the forward arrow.

   ▪ To view the calendar for the next month, click the backward arrow.

   ▪ To view the calendar for a specific month, in the drop-down list, select a month.

   ▪ To view the calendar for a specific year, in the drop-down list, select a year.
3 Click the date for which you want to view a list of meetings.
   The Daily view for the date that you selected appears.
   For details about the options on the view tabs, see the following:
   >>>
   - About the Today view (on page 30)
   - About the Daily view (on page 31)
   - About the Weekly view (on page 33)

   **Note:** You can use this procedure on the Register for a Meeting page as well.

To display a list of meetings for a specific date using the Monthly view:
1 If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).
2 Click the Monthly tab.
3 Click the forward or backward arrow to navigate to the list of meetings for the next or previous month.

December 2010

4 Click a date for which you want to view a list of scheduled meetings.
   The Daily view appears for the date that you selected.

   **Note:** Only dates on which an icon appears have at least one scheduled meeting.

For details about the options on the Monthly view, see About the Monthly view (on page 35).

### Searching for a meeting on the meeting calendar

On the meeting calendar, you can locate a meeting by searching for text in the name of the host or presenter, meeting topic, or meeting agenda. You cannot search for a meeting number.
To search for a meeting:

1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).
2. Type the text for which you want to search in the Search for box.
3. Click Search.

   The Search Results page appears, listing all meetings that contain the search text.

### Sorting the meeting calendar

By default, meeting lists on the meeting calendar are sorted by hours, in ascending order. However, you can sort the meeting lists by any column:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Sorts the meeting list by hours, in ascending or descending order.</td>
</tr>
<tr>
<td>Topic</td>
<td>Sorts the meeting list alphabetically by topic, in ascending or descending order.</td>
</tr>
<tr>
<td>Host or Presenter</td>
<td>Sorts the meeting list alphabetically by host or presenter name, in ascending or descending order.</td>
</tr>
<tr>
<td>Duration</td>
<td>Sorts the meeting list by duration, in ascending or descending order.</td>
</tr>
</tbody>
</table>

To sort the public meeting calendar:

1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar.
2. In a list of meetings on the Today, Upcoming, Daily, or Weekly tab on the calendar page, click the column heading by which you want to sort the meetings.

   An ascending or descending sort indicator appears and the meetings are sorted accordingly.

**Note:** You can use this procedure on the Register for a Meeting page as well.
Chapter 3: Using the Calendar

Refreshing the meeting calendar

Information about meetings on the public Meeting Center calendar can change at any time. Thus, to ensure that you are viewing the most current Meeting Center information, you can refresh the Meeting Center calendar at any time.

To refresh the public Meeting Center calendar:
1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).
2. Click the Refresh button.

Selecting a language and time zone on the meeting calendar

On the meeting calendar, you can access your Preferences page to select the language and time zone in which you want to view meeting times. Your site administrator specifies the default language and time zone that appears on the meeting calendar. You may need to change the time zone, for example, if you are travelling and temporarily in another time zone.

To select a language on the public meeting calendar:
1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).
2. Click the language link on the right side of the page.
   The Preferences page appears.
3. In the Language drop-down list, select another language.
4. Click OK.

To select a time zone on the public meeting calendar:
1. If you have not already done so, open the meeting calendar. For details, see Viewing the meeting calendar (on page 24).
2. Click the time zone link on the right side of the page.
   The Preferences page appears.
3  In the **Time zone** drop-down list, select another time zone.

4  Click **OK**.

**Note:**
- Your time zone selection affects only your view of your Meeting Center Web site, not other users' views.
- If you have a user account, all meeting invitations that you send automatically specify the meeting starting time in the time zone that you selected.
- If you select a time zone for which daylight saving time (DST) is in effect, your Meeting Center Web site automatically adjusts its clock for daylight saving time.

---

**Registering for a meeting from the meeting calendar**

If you did not receive an invitation email message for a meeting that requires registration, you can register for it from the meeting calendar on your Meeting Center Web site.

**About the Register for a Meeting page**

The Register for a Meeting page lists each meeting that requires registration. Each page of the meeting calendar displays each meeting occurring on a given day that requires registration, unless it is unlisted.

To select a scheduled meeting, click the option button to the left of its topic. Once you have selected a meeting, you can click one of the following buttons on the button bar:

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Register</strong></td>
<td>Register for the meeting.</td>
</tr>
<tr>
<td><strong>Join Now</strong></td>
<td>Join the meeting, if the meeting is currently in progress.</td>
</tr>
<tr>
<td><strong>Get Info</strong></td>
<td>View detailed information about the meeting.</td>
</tr>
<tr>
<td><strong>Agenda</strong></td>
<td>View the agenda for the meeting.</td>
</tr>
</tbody>
</table>
Registering for a meeting

If you find the meeting you want to register for, you can easily complete the registration form and send it to the meeting host.

To register for a meeting:

1. Select a meeting for which the status is Registration.
2. Click Register.
3. Enter your information and click Register Now.

Once the host approves your registration, you receive a registration confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all registration requests automatically, you join the meeting immediately.

About the Today view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > Today tab.

What you can do here

The Today view lists the live meetings that are scheduled for the present day, including those in process, those concluded, and those that have not yet begun.

The meeting information displayed in the list can be sorted by clicking the column headings. For details, see Sorting the meeting calendar (on page 27).

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh]</td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your Meeting Center Web site.</td>
</tr>
</tbody>
</table>
### Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time zone link</strong></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td><strong>Show past meetings</strong></td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td><strong>Show only meetings that require registration check box</strong></td>
<td>Select to display only those meetings that require registration in the list of meetings.</td>
</tr>
<tr>
<td><a href="#">Ascending Sort</a></td>
<td>The Ascending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><a href="#">Descending Sort</a></td>
<td>The Descending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Lists the starting time for each scheduled meeting.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>Lists the scheduled meetings by name. Click the topic name to get meeting information.</td>
</tr>
<tr>
<td><strong>Host or Presenter</strong></td>
<td>Lists the host or presenter for the meeting.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Lists the scheduled length of the meeting.</td>
</tr>
<tr>
<td><img src="#" alt="join" /></td>
<td>Indicates that the live meeting is in process.</td>
</tr>
<tr>
<td><strong>Join link</strong></td>
<td><img src="#" alt="join" /> Click the link to join the Meeting Center from the Meeting Information page.</td>
</tr>
<tr>
<td><strong>Register link</strong></td>
<td><img src="#" alt="register" /> Click to open the Register for page, where you can enter the required information to register for the meeting.</td>
</tr>
<tr>
<td><img src="#" alt="icon" /></td>
<td>Indicates that this is a Personal Conference meeting.</td>
</tr>
<tr>
<td><strong>Start link</strong></td>
<td><img src="#" alt="start" /> (Host only) Click to start your meeting.</td>
</tr>
<tr>
<td><strong>End link</strong></td>
<td><img src="#" alt="end" /> (Host only) Click to end your meeting.</td>
</tr>
</tbody>
</table>

### About the Daily view

**How to access this page**

On your Meeting Center Web site, click **Attend a Meeting > Browse Meetings > Daily tab.**
Chapter 3: Using the Calendar

What you can do here

The Daily view lists the live meetings that are scheduled for the present day. From the Daily view you can navigate to the previous or next day, or use the calendar to view the schedule for another day.

The meeting information displayed in the list can be sorted by clicking the column headings. For details, see Sorting the meeting calendar (on page 27).

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh icon" /></td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td><img src="image" alt="Previous Day icon" /></td>
<td>Click the Previous Day icon to display a list of meetings for the previous day.</td>
</tr>
<tr>
<td><img src="image" alt="Next Day icon" /></td>
<td>Click the Next Day icon to display a list of meetings for the next day.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar icon" /></td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td>Show only meetings that require registration check box</td>
<td>Select to display only those meetings that require registration in the list of meetings.</td>
</tr>
<tr>
<td><img src="image" alt="Ascending Sort indicator" /></td>
<td>The Ascending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><img src="image" alt="Descending Sort indicator" /></td>
<td>The Descending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td>Time</td>
<td>Lists the starting time for each scheduled meeting.</td>
</tr>
<tr>
<td>Topic</td>
<td>Lists the scheduled meetings by name. Click the topic name to get meeting information.</td>
</tr>
<tr>
<td>Host or Presenter</td>
<td>Lists the host or presenter for the meeting.</td>
</tr>
</tbody>
</table>
### About the Weekly view

**How to access this page**

On your Meeting Center Web site, click **Attend a Meeting > Browse Meetings > Weekly tab.**

**What you can do here**

The Weekly view lists the live meetings that are scheduled, but not ended for the selected week.

The meeting information displayed in the list can be sorted by clicking the column headings. For details, see *Sorting the meeting calendar* (on page 27).

**Options on this page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh icon]</td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of meetings.</td>
</tr>
</tbody>
</table>
### Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Language link</strong></td>
<td>Click to open the Preferences page, where you can select the language setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td><strong>Time zone link</strong></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td><img src="link" alt="Previous Week" /></td>
<td>Click the <strong>Previous Week</strong> icon to display a list of meetings for the previous week.</td>
</tr>
<tr>
<td><img src="link" alt="Next Week" /></td>
<td>Click the <strong>Next Week</strong> icon to display a list of meetings for the next week.</td>
</tr>
<tr>
<td><img src="link" alt="Calendar" /></td>
<td>Click the <strong>Calendar</strong> icon to open the Calendar window for the current month. Click on any date to open its schedule.</td>
</tr>
<tr>
<td><strong>Show only meetings that require registration</strong></td>
<td>Select to display only those meetings that require registration in the list of meetings.</td>
</tr>
<tr>
<td><img src="link" alt="Day link" /></td>
<td>Click the <strong>Day link</strong> to open the Daily view, which shows the scheduled meetings for the selected day.</td>
</tr>
<tr>
<td><strong>Friday</strong></td>
<td>The <strong>Ascending Sort</strong> indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><img src="link" alt="Ascending Sort" /></td>
<td>The <strong>Ascending Sort</strong> indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Lists the starting time for each scheduled meeting.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>Lists the scheduled meetings by name. Click the topic name to get meeting information.</td>
</tr>
<tr>
<td><strong>Host or Presenter</strong></td>
<td>Lists the host or presenter for the meeting.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Lists the scheduled length of the meeting.</td>
</tr>
<tr>
<td><img src="link" alt="Live Meeting" /></td>
<td>Indicates that the live meeting is in process.</td>
</tr>
<tr>
<td><strong>Join link</strong></td>
<td>Click the <strong>Join link</strong> to join the Meeting Center from the Meeting Information page.</td>
</tr>
<tr>
<td><strong>Register link</strong></td>
<td>Click to open the Register for page, where you can enter the required information to register for the meeting.</td>
</tr>
<tr>
<td><img src="link" alt="Register" /></td>
<td>Indicates that this is a Personal Conference meeting.</td>
</tr>
<tr>
<td><strong>Start link</strong></td>
<td>(Host only) Click to start your meeting.</td>
</tr>
</tbody>
</table>
Chapter 3: Using the Calendar

About the Monthly view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > Monthly tab.

What you can do here

The Monthly view shows when the live meetings are scheduled in a monthly calendar view. You can navigate to a specific day or week within the current month, or navigate to the previous or next month.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End link</td>
<td>(Host only) Click to end your meeting.</td>
</tr>
<tr>
<td>Previous Month</td>
<td>Click the Previous Month icon to display a list of meetings for the previous month.</td>
</tr>
<tr>
<td>Next Month</td>
<td>Click the Next Month icon to display a list of meetings for the next month.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language</td>
<td>Click to open the Preferences page, where you can select the language setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your Meeting Center Web site.</td>
</tr>
<tr>
<td>Week link</td>
<td>Opens the Weekly view, which shows the scheduled meetings for each day of the selected week.</td>
</tr>
<tr>
<td>Day link</td>
<td>Opens the Daily view, which shows the scheduled meetings for the selected day.</td>
</tr>
</tbody>
</table>
### About the Search Results page

**What you can do here**

- Find a meeting on your Meeting Center Web site.
- Display past meetings.
- Sort the search results.
- Select a language for your Meeting Center Web site.
- Select a time zone for your Meeting Center Web site.
- Display meetings that require registration.

The meeting information displayed in the list can be sorted by clicking the column headings. For details, see *Sorting the meeting calendar* (on page 27).

### Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Search for...**       | Enter a host name, meeting topic, or any text that may appear in the agenda, and click **Search**.
| text box                | **Note**: You cannot search for a meeting number.                            |
| **Refresh**             | Click the **Refresh** icon at any time to display the most current list of meetings. |
| **Language**            | Click to open the Preferences page, where you can select the language setting for your Meeting Center Web site. |
| **Time zone**           | Click to open the Preferences page, where you can select the time zone setting for your Meeting Center Web site. |
| **Show past meetings**  | Select to include concluded meetings in the list of meetings.               |
| **Show only meetings that require registration** | Select to display only those meetings that require registration in the list of meetings. |
| **Navigation links**    | Click the page numbers or **next** to navigate through the search            |
## Chapter 3: Using the Calendar

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ascending Sort</strong></td>
<td>The <em>Ascending Sort</em> indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><strong>Descending Sort</strong></td>
<td>The <em>Descending Sort</em> indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Date &amp; Time</strong></td>
<td>Lists the date and starting time of the meeting.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>Lists the scheduled meetings by name. Click the topic name to get meeting information.</td>
</tr>
<tr>
<td><strong>Host or Presenter</strong></td>
<td>Lists the host or presenter for the meeting.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Lists the scheduled length of the meeting.</td>
</tr>
<tr>
<td>⏳</td>
<td>Indicates that the live meeting is in process.</td>
</tr>
<tr>
<td><strong>Join</strong></td>
<td>Click the link to join the Meeting Center from the Meeting Information page.</td>
</tr>
<tr>
<td><strong>Register</strong></td>
<td>Click to open the Register for page, where you can enter the required information to register for the meeting.</td>
</tr>
<tr>
<td>🔔</td>
<td>Indicates that this is a Personal Conference meeting.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>(Host only) Click to start your meeting.</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>(Host only) Click to end your meeting.</td>
</tr>
</tbody>
</table>
Scheduling a Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of scheduling a meeting</td>
<td>Choosing the scheduler that works for you (on page 39)</td>
</tr>
<tr>
<td>allow another user to schedule a meeting for you</td>
<td>Allowing another user to schedule meetings for you (on page 96)</td>
</tr>
<tr>
<td>use the Quick Scheduler to start a meeting quickly</td>
<td>Using the Quick Scheduler (on page 48)</td>
</tr>
<tr>
<td>use the Advanced Scheduler to include an agenda and other options in your meeting</td>
<td>About the Advanced Scheduler (on page 49)</td>
</tr>
<tr>
<td>set up a meeting that recurs on a regular basis</td>
<td>Setting up a recurring meeting (on page 95)</td>
</tr>
<tr>
<td>start a scheduled meeting</td>
<td>Starting a scheduled meeting (on page 88)</td>
</tr>
<tr>
<td>edit details for a scheduled meeting</td>
<td>Editing a scheduled meeting (on page 87)</td>
</tr>
<tr>
<td>cancel a scheduled meeting</td>
<td>Canceling a scheduled meeting (on page 90)</td>
</tr>
</tbody>
</table>

Choosing the scheduler that works for you

Meeting Center provides several ways to set up meetings. Review the details about the different means of scheduling a meeting and then pick the one that meets your needs.

Short on time?

Use the one-page Quick Scheduler. Simply enter a few details and you are ready to host your meeting. For details, see Using the Quick Scheduler (on page 48).
Looking for more meeting options, such as adding additional security?

Use the Advanced Scheduler. Enter the level of detail you need. You can schedule or start the meeting from any page in the wizard. For details, see Using the Advanced Scheduler.

Want to reuse the information you saved in the scheduler?

You do not have to type in the same information every time you set up a meeting. If the meeting recurs on a regular basis, with the same attendees, you can set up a whole series of meetings. If the meeting details (such as attendees, meeting options) are constant, you can save those details in a template, which you can apply to any meeting you schedule. For details, see:

- Setting up a recurring meeting (on page 95)
- Using meeting templates (on page 91)

**Note:** If you decide to switch from the Advanced Scheduler to the Quick Scheduler (or from the Quick Scheduler to the Advanced Scheduler) any information you have typed is saved and available in the other scheduler.

### About the Quick Scheduler

Use this one-page scheduler to set up a meeting with just a few mouse clicks.

Your site administrator decides whether your site displays the Quick Scheduler or the Advanced Scheduler, a wizard that helps you step through the process of selecting meeting options.

If your site displays the Advanced Scheduler automatically, you can easily switch to the Quick Scheduler. Simply click the Return to Quick Scheduler link at the top of the Required Information page.

### About the Quick Scheduler page

**How to access this page**

On the navigation bar, click **Host a Meeting > Schedule a Meeting**

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.
What you can do on this page
Set up a meeting quickly, using this one-page scheduler.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set options using template</td>
<td>Select a template and use the settings saved in that template for this meeting. You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in a previous meetings and saved as a template. For more details about creating and editing templates, see Using meeting templates (on page 91).</td>
</tr>
<tr>
<td>Meeting Topic</td>
<td>Enter the topic or a name for the meeting.</td>
</tr>
</tbody>
</table>
### Tracking codes

Identify your department, project, or other information that your organization wants to associate with your meetings. Tracking codes can be optional or required, depending on how your site administrator set them up.

If your site administrator requires you to select a code from a predefined list, a list of codes appears. Select a code from the list on the left. Then do one of the following in the box on the right:

- If a list of codes appears, select a code from the list.
- Type a code in the box.

### Password

**Confirm password**

Require participants to enter the password you set to join your meeting.

Your site may require that all passwords comply with security criteria, such as a minimum length and a minimum number of letters, numbers or special characters. A password:

- Can contain a maximum of 16 characters.
- Cannot contain spaces or any of the following characters: ` ` " / & < > == [

Each participant that you invite to your meeting receives an invitation email message that includes the password, unless you request that passwords do not appear in email invitations.

### Date

Set the date you want the meeting to occur. Select the month, day, and year in the drop-down lists. Or, you can click the **Calendar** icon, and then select a date.

### Time

Set the meeting’s starting time and the time zone. To select another time zone, click the time zone link.

**Important** The time zone you select does not affect the time zone setting for the meeting calendar on the Browse Meetings page. You and each attendee can select the time zone for your view of the calendar independently, using the **Your time zone** option on the Preferences page.

To access this page, on the navigation bar, click **Set Up > Preferences**.

### Duration

Enter the length of time you estimate that the meeting will continue. The meeting does not end automatically after the duration that you set.
## Attendees

Enter the email addresses of the attendees you want to invite to your meeting.

You can type the addresses, separating them with a comma or semicolon or you can click Select Attendees to choose attendees from your address book.

## Allow external attendees

Allow attendees located on the public internet to join your meeting. If unchecked, only attendees within the same internal network can join.

**Note:** This option is available for Cisco Unified MeetingPlace users only.

## Send a copy of the invitation email to me

Receive a copy of the invitation you are sending to attendees. Later, if you decide to invite additional attendees, you can simply forward this email message to them.

## Audio options

The default settings appear. To select a different options, click Change audio option.

## CUVC Meeting ID

Enter a custom URL to create a virtual meeting room in which you can use Cisco Unified Video (CUVC) in your meeting.

If you leave this box empty, the WebEx Meeting ID is used by default.

When you start your WebEx meeting, the CUVC Video panel displays automatically.

This is an optional feature that must be enabled by your site administrator.

---

### About the Change Tracking Code page

**How to access this page**

On the navigation bar, click Host a Meeting > Schedule a Meeting

If you see the Advanced Scheduler, click the link to display the Quick Scheduler. Then click Select tracking code.

**What you can do on this page**

Add or remove tracking codes assigned to this meeting.
Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracking Code</td>
<td>Assign a tracking code to this meeting. Your site administrator provides the group name, such as &quot;Division,&quot; or &quot;Department&quot; or other identifier. Depending on how your site is set up, you have one of these options:</td>
</tr>
<tr>
<td></td>
<td>• Select the tracking codes from a list</td>
</tr>
<tr>
<td></td>
<td>• Enter the tracking codes in the boxes provided,</td>
</tr>
<tr>
<td></td>
<td>• Both options (either select codes from a list or type it)</td>
</tr>
</tbody>
</table>

About the Time Zone page

How to access this page

On the navigation bar, click **Host a Meeting > Schedule a Meeting**

If you see the Advanced Scheduler, click the link to display the Quick Scheduler. Then click the current time zone link (for example, **Pacific ST**).

What you can do on this page

Select a different time zone for the meeting you are scheduling.

**Important:** The time zone you select does not affect the time zone setting for the meeting calendar on the Browse Meetings page. You and each attendee can select the time zone for your view of the calendar independently, using the Your time zone option on the Preferences page. To access this page, on the navigation bar, click **Set Up > Preferences**.

About the Select Attendees page

How to access this page

On the navigation bar, click **Host a Meeting > Schedule a Meeting**

You can select attendees from the Quick Scheduler or the Advanced Scheduler>Invite Attendees page.
Then click the **Use Address book** link.

**What you can do on this page**

- Select contacts in your personal address book and invite them to the meeting.
- Add new contacts to your personal address book and invite them to the meeting.
- Designate one or more invited attendees as alternate hosts

**Options on this page**

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address book</strong></td>
<td>Select the address book from which you want to select attendees. The contacts in the address book that you select appear in the box. These address books are available:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Personal contacts</strong>: Includes any individual contacts that you have added to your personal address book. If you use Microsoft Outlook, you can import the personal contacts that you keep in an Outlook address book or folder to this list of contacts.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Company address book</strong>: Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.</td>
</tr>
<tr>
<td></td>
<td>- <strong>List</strong>: Includes any distribution lists that you have created for your personal address book.</td>
</tr>
<tr>
<td><strong>New Contact</strong></td>
<td>Add a new contact. Enter the requested information about the new contact you want to invite to the meeting. You can also add the new contact to your personal address book.</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td>Search for text in the selected address book. For example, you can search for all or part of a contact name or email address</td>
</tr>
</tbody>
</table>
### Invite as

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add the selected contacts to the list of attendees.</td>
<td></td>
</tr>
<tr>
<td>Attendee: Adds the selected contacts to the list of attendees.</td>
<td></td>
</tr>
<tr>
<td>Alternate Host: Adds the selected contacts as alternate hosts to the list of attendees. An alternate host receives an invitation email message that provides information about acting as the alternate host. An alternate host can start the meeting and act as the host. If you join the meeting after an alternate host has started or joined it, you do not automatically assume the host role.</td>
<td></td>
</tr>
<tr>
<td>An alternate host must have a user account on your meeting service Web site.</td>
<td></td>
</tr>
</tbody>
</table>

### Remove

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove the selected contacts from the list of attendees.</td>
<td></td>
</tr>
</tbody>
</table>

---

### About the Audio Conference Settings page

#### How to access this page

On the navigation bar, click **Host a Meeting > Schedule a Meeting**

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.

Then click **Change audio conference.**

#### What you can do on this page

Change the preset audio options, such as the teleconferencing service you plan to use.

#### Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select conference type</strong></td>
<td>Select the type of audio conference you would like to use:</td>
</tr>
<tr>
<td><strong>WebEx Audio</strong></td>
<td>Specifies that the meeting includes an integrated audio conference. If you select this option, choose one of the following types of teleconferences:</td>
</tr>
<tr>
<td><strong>Display toll-free number</strong></td>
<td>If attendees call in to the conference, they can call a toll-free number.</td>
</tr>
<tr>
<td><strong>Toll number is always displayed</strong></td>
<td>Attendees have the option of using the toll number that appears.</td>
</tr>
<tr>
<td><strong>Display global call-in numbers</strong></td>
<td>This option provides a</td>
</tr>
<tr>
<td>Use this option...</td>
<td>To...</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>list of numbers—such as toll-free or local numbers—that attendees in other</td>
<td>list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the audio conference.</td>
</tr>
<tr>
<td>countries can call to join the audio conference.</td>
<td></td>
</tr>
<tr>
<td>▪ Enable teleconference CLI authentication when participants call in</td>
<td>▪ Enable teleconference CLI authentication when participants call in</td>
</tr>
<tr>
<td>CLI (caller line identification) is a form of caller ID, a telephony intelligent</td>
<td>CLI (caller line identification) is a form of caller ID, a telephony intelligent service that transmits a caller’s telephone number before the call is answered. If you use WebEx audio conferencing, you can help participants join the meeting more quickly, if participants have:</td>
</tr>
<tr>
<td>service that transmits a caller’s telephone number before the call is answered.</td>
<td>□ a WebEx host account</td>
</tr>
<tr>
<td>If you use WebEx audio conferencing, you can help participants join the meeting</td>
<td>□ saved their phone numbers in their WebEx profiles</td>
</tr>
<tr>
<td>more quickly, if participants have:</td>
<td>This option is not available for Cisco Unified MeetingPlace users.</td>
</tr>
<tr>
<td>□ a WebEx host account</td>
<td></td>
</tr>
<tr>
<td>□ saved their phone numbers in their WebEx profiles</td>
<td></td>
</tr>
<tr>
<td>This option is not available for Cisco Unified MeetingPlace users.</td>
<td></td>
</tr>
<tr>
<td>Personal Conference number: Displays the personal audio conference accounts you</td>
<td>Personal Conference number: Displays the personal audio conference accounts you have set up in the Personal Conferencing area of My WebEx. Select the account you want to use for your meeting. You can create up to three accounts.</td>
</tr>
<tr>
<td>have set up in the Personal Conferencing area of My WebEx. Select the account</td>
<td>Click Edit to make changes, such as updating the subscriber or attendee access code.</td>
</tr>
<tr>
<td>you want to use for your meeting. You can create up to three accounts.</td>
<td>If you have not yet set up any accounts, select Create Personal Conference account to get started. This option is not available for Cisco Unified MeetingPlace users.</td>
</tr>
<tr>
<td>Other teleconference service: Specifies that the meeting includes a teleconference</td>
<td>Other teleconference service: Specifies that the meeting includes a teleconference that another service provides.</td>
</tr>
<tr>
<td>that another service provides.</td>
<td>Instructions: Provides space for you to type instructions for joining the teleconference.</td>
</tr>
<tr>
<td>Instructions for any teleconference option that you select automatically appear:</td>
<td>Instructions: Provides space for you to type instructions for joining the teleconference.</td>
</tr>
<tr>
<td>▪ On the Meeting Information page on your site, which participants can view</td>
<td>Instructions for any teleconference option that you select automatically appear:</td>
</tr>
<tr>
<td>before you start the meeting</td>
<td>▪ On the Meeting Information page on your site, which participants can view before you start the meeting</td>
</tr>
<tr>
<td>▪ In invitation email messages, if you invite participants using the Schedule a</td>
<td>▪ In invitation email messages, if you invite participants using the Schedule a Meeting page options</td>
</tr>
<tr>
<td>Meeting page options</td>
<td>▪ On the Info tab, which appears in the content viewer in the Meeting window</td>
</tr>
<tr>
<td>▪ In the Join Teleconference dialog box, which appears in participants’ Meeting</td>
<td>▪ In the Join Teleconference dialog box, which appears in participants’ Meeting windows once they join the meeting</td>
</tr>
<tr>
<td>windows once they join the meeting</td>
<td>▪ In the Join Teleconference dialog box, which appears in participants’ Meeting windows once they join the meeting</td>
</tr>
</tbody>
</table>
### Using the Quick Scheduler

1. Log in to your Meeting Center Web site.
2. On the navigation bar, expand **Host a meeting** to view a list of links.
3. Click **Schedule a meeting**.

   The Required Information page appears.
Chapter 4: Scheduling a Meeting

4 Check whether you are viewing the Advanced Scheduler. Click the Return to Quick Scheduler link to display the Quick Scheduler.

The Advanced Scheduler consists of several pages, with the links to them on the right side of the page. The Quick Scheduler is one page.

5 Enter the details about your meeting. For information about the fields on this page, see About the Quick Scheduler page (on page 40).

6 Start or schedule the meeting:
   - If the meeting's starting time is the current time, click Start to start the meeting.
   - If the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled. You also receive a confirmation email message that includes information about the scheduled meeting.

About the Advanced Scheduler

When scheduling a meeting, use the Schedule a meeting wizard to set several options for your meeting. These options allow you to customize your meeting for your specific needs, such as additional security. Once you schedule a meeting, you can change its options at any time, or cancel the meeting.

If another user has granted scheduling permission to you in his or her user profile, you can schedule a meeting on behalf of that user. For details about granting scheduling permission to another user, see Allowing another user to schedule meetings for you (on page 96).

Note: If you use Microsoft Outlook 2000 or a later version, you can schedule, start, and join an online meeting using Outlook. For instructions on using Integration to Outlook, refer the Integration to Outlook User's Guide, which is available on your Meeting Center Web site.

Choosing a level of security for a scheduled meeting

When scheduling a meeting, you can provide security for the meeting using these means:

- **Require a password:** Attendees must provide the password you set before joining the meeting. For more information, see About the Required Information page.
Chapter 4: Scheduling a Meeting

- **Decline to list this meeting on the meeting calendar:** An unlisted meeting does not appear in the meeting calendar on the Browse Meetings page or on your Personal Meetings page. To join an unlisted meeting, attendees must provide a unique meeting number. For more information, see About the Required Information page.

- **Exclude the meeting password from email invitations:** If you invite attendees to a meeting, you can prevent the password from appearing in the email invitations that your Meeting Center Web site sends automatically to attendees. For details, see

- **Require attendees to log in:** You can require attendees to have a user account on your Meeting Center Web site to join the meeting. Thus, attendees must log in to your site before they can attend the meeting. For more information, see About the Invite Attendees page.

- **Require attendees to register for the meeting:** If you require each attendee to send a registration request to you before joining a meeting, you can accept or reject each registration request. For more information, see About the Registration page (on page 71).

**Tip:** Choose a level of security based on the meeting's purpose. For example, if you schedule a meeting to discuss your company picnic, you probably need to set only a password for the meeting. On the other hand, if you schedule a meeting in which you will discuss sensitive financial data, you may not want to list the meeting on the meeting calendar. You may also choose to restrict access to the meeting once all attendees have joined it.

### Using the Advanced Scheduler

When scheduling a meeting, you must provide a meeting topic and a starting time. You can also set options to customize your meeting and enhance its security.

Using the Advanced Scheduler, you can schedule a meeting quickly. You can click the Start button at any time to start your meeting. If you have questions about the information requested on a page, click the Help button, which is located in the upper right corner of each wizard page.

**To start the Advanced Scheduler:**

1. Log in to your Meeting Center Web site.
2. On the navigation bar, expand **Host a meeting** to view a list of links.
3. Click **Schedule a meeting**.
   
   The Advanced Scheduler appears, showing the Required Information page.
To schedule a meeting:

1. Click **Required Information**.
   
Enter the requested information, such as the meeting topic, meeting password, tracking codes, and whether you want to display this meeting on your meeting list.
   
   For details, see About the Required Information page.

2. Click **Date & Time**.
   
   Set the date and time for the meeting. You also set the meeting duration, how many minutes in advance you will allow participants to join the meeting, whether the meeting recurs and how often and other information related to meeting times.
   
   For details, see *About the Date & Time page* (on page 57).

3. Click **Teleconference**.
   
   Set up a voice conference for the meeting. Select the type of voice conference (call back or call in). Also, you can include VoIP as well as the traditional teleconference.
   
   For details, see *About the Audio Conference page* (on page 61).

4. Click **Invite Attendees**.
   
   Enter the email addresses of the attendees you want to invite or you can select them from your contact list. You can also make your meeting more secure by:
   
   - Selecting the option not to send the meeting password in the meeting invitation
   - Requiring attendees to have an account on your Web site before they can join a meeting.
   
   For details, see About the Invite Attendees page.

5. Click **Registration**.
   
   If you want to have participants register for the meeting, select information to be requested on registration page.
   
   For details, see *About the Registration page* (on page 71).

6. Click **Agenda & Welcome**.
   
   Type an agenda for the meeting or a welcome message for attendees, which they can view before the meeting starts. Select a file that you want to open automatically in each attendee's Meeting window once he or she joins the meeting.
   
   For details, see *About the Agenda & Welcome page* (on page 74)

7. Click **Meeting Options**.
Select the meeting options you want to be available to all participants during the meeting. You can also choose an alert to play once a participant either joins or leaves the teleconference.

For details, see *About the Meeting Options page* (on page 79)

8 Click **Review**.

You view all the information you've entered on each page of the Advanced Scheduler. If you need to make a change, return to that page in the wizard and edit the information.

For details, see *About the Review page* (on page 85).

9 Optional. Save your meeting settings in a template.

If you may need to use these same meeting settings (for example, with the same attendees, telephony options, and other meeting details), you can save the settings in a meeting template.

For more details about using meeting templates, see *Using meeting templates* (on page 91).

10 Start or schedule the meeting:

- If the meeting's starting time is the current time, click **Start** to start the meeting.
- If the meeting's starting time is after the current time, click **Schedule**.

The Meeting Scheduled page appears, confirming that the meeting is scheduled. You also receive a confirmation email message that includes information about the scheduled meeting.

---

**Page-by-page guide to the Advanced Scheduler**

Scheduling a meeting can be done in one click, or you can take a bit of time and set up audio conferencing options, invite attendees, assign privileges, and select other options in advance of the meeting. If you have questions about any options or how to complete the information requested on any page in the Advanced Scheduler, refer to these topics:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about meeting types, listed and unlisted meetings, meeting passwords</td>
<td><em>About the Required Information page</em></td>
</tr>
<tr>
<td>set the day and time for a meeting or set up a recurring meeting</td>
<td><em>About the Date &amp; Time page</em> (on page 57)</td>
</tr>
</tbody>
</table>
Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>set up audio conference with VoIP or voice audio conferencing or both</td>
<td>About the Audio Conference page (on page 61)</td>
</tr>
<tr>
<td>invite attendees to a meeting</td>
<td>About the Invite Attendees page (on page 66)</td>
</tr>
<tr>
<td>select contacts to invite to a meeting</td>
<td>About the Select Attendees page (on page 69)</td>
</tr>
<tr>
<td>require attendees to register for a meeting</td>
<td>About the Registration page (on page 71)</td>
</tr>
<tr>
<td>create an agenda and select a presentation to share while attendees wait for the meeting to start</td>
<td>About the Agenda &amp; Welcome page (on page 74)</td>
</tr>
<tr>
<td>set options for participants, such as allowing them to chat, transfer files, and take notes</td>
<td>About the Meeting Options page (on page 79)</td>
</tr>
<tr>
<td>set privileges for attendees, such as allowing them to view a list of meeting participants, control another computer or a Web browser remotely</td>
<td>About the Attendee Privileges Page (on page 82)</td>
</tr>
<tr>
<td>review all meeting details</td>
<td>About the Review page (on page 85)</td>
</tr>
</tbody>
</table>

About the Required Information page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Required Information
Chapter 4: Scheduling a Meeting

What you can do on this page

- Set up a meeting on behalf of someone else
  
  You can select the hosts you want to include in the Schedule for drop-down list from the list of hosts available in the Profiles area of My WebEx.

- Select the type of meeting you are setting up.

- Define a topic for the meeting.

- Indicate whether the meeting is listed on the meeting calendar. For information about a listed or unlisted meeting, see About joining a meeting.

- Decide whether the meeting is deleted from My Meetings on My WebEx after it is over.

- Set the meeting password, if required.

- Select tracking codes, if your administrator has set them up.
### Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Set options using template** | Select a template and use the settings saved in that template for this meeting.  
You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in a previous meetings and saved as a template.  
For more details about creating and editing templates, see *Using meeting templates* (on page 91). |
| **Meeting type**            | Select the type of meeting you want to schedule.  
The list includes the meeting types that are available for your service website.  
The list may also include **Personal Conference**, which allows you to schedule a meeting that begins with an audio portion and automatically includes an online portion you can join later. You must have at least one Personal Conference number account specified in the My WebEx > Personal Conferencing page in order to use this meeting type.  
The **Other Teleconference** option allows you to schedule your meeting with another teleconference service. |
| **Meeting topic**           | Enter the topic or a name for the meeting.                                                                                             |
| **Listed on calendar**      | List this meeting on the meeting calendar.  
To enhance meeting security, you can opt not to list the meeting on the meeting calendar. Just remove the check mark from this option to:  
- Hide information about the meeting, such as its host, topic, and starting time.  
- Help prevent unauthorized access to the meeting. |
| **Delete from My Meetings when completed** | Remove this meeting from your list of meetings in the My Meetings area of My WebEx after the meeting ends.  
If you do not select this option, you must delete this meeting from My Meetings to remove it from the list. |
### Use this option... | To...
---|---
Meeting password | Require participants to enter the password you set to join your meeting.
Confirm password | Your site may require that all passwords comply with security criteria, such as a minimum length and a minimum number of letters, numbers or special characters. A password:
- Can contain a maximum of 16 characters.
- Cannot contain spaces or any of the following characters: ` ` ` ` ` ` ` ` ` ` ` `
Each participant that you invite to your meeting receives an invitation email message that includes the password, unless you request that passwords do not appear in email invitations.
If you have selected **Personal Conference** as the meeting type, the default password is the attendee access code in your Personal Conference number account that is specified for the meeting.

### Tracking codes
Identify your department, project, or other information that your organization wants to associate with your meetings. Tracking codes can be optional or required, depending on how your site administrator set them up.

If your site administrator requires you to select a code from a predefined list, a list of codes appears. Select a code from the list on the left. Then do one of the following in the box on the right:

- If a list of codes appears, select a code from the list.
- Type a code in the box.

### CUVC Meeting ID
Enter a custom URL to create a virtual meeting room in which you can use Cisco Unified Video (CUVC) in your meeting.

If you leave this box empty, the WebEx Meeting ID is used by default.

When you start your WebEx meeting, the CUVC Video panel displays automatically.

This is an optional feature that must be enabled by your site administrator.
Questions about required information for setting up a meeting

Why set up an unlisted meeting?

You can prevent a scheduled meeting from appearing on the meeting calendar and any other publicly accessible pages on your Meeting Center Web site, by setting up an unlisted meeting. If a meeting is unlisted, the meeting details, such as its host, topic, and starting time are not available on the calendar and other places. This additional security may help prevent unauthorized access to the meeting.

To join an unlisted meeting, a participant must provide a unique meeting number.

If you invite a participant to an unlisted meeting, the participant receives an invitation email message that includes complete instructions for joining the meeting-including the meeting number-and a URL that links directly to a Web page on which the participant can join the meeting.

What are tracking codes?

Your site administrator can include tracking codes in the Advanced Scheduler. Tracking codes may identify your department, project, or other information that your organization wants to associate with your meeting. Tracking codes can be optional or required, depending on how your site administrator sets them up.

How can I learn more about the fields on the Required Information page?

Click the Help link in the top right corner of the Required Information page, or review About the Required Information page.

About the Date & Time page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Date & Time.
Chapter 4: Scheduling a Meeting

What you can do on this page

- Set the date and time for the meeting
- Set the duration for the meeting
- Select the number of minutes before the meeting's starting time during which attendees can join the meeting
- Select the number of minutes before the meeting you want to receive a reminder email message
- Set a recurrence pattern for the meeting

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set options using template</td>
<td>Select a template and use the settings saved in that template for this meeting. You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in a previous meetings and saved as a template. For more details about creating and editing templates, see Using meeting templates (on page 91).</td>
</tr>
<tr>
<td>Meeting date</td>
<td>Set the date you want the meeting to occur. Select the month, day, and year in the drop-down lists. Or, you can click the Calendar icon, and then select a date.</td>
</tr>
</tbody>
</table>
### Chapter 4: Scheduling a Meeting

#### Use this option... | To...
--- | ---
**Meeting time** | Set the meeting’s starting time and the time zone. To select another time zone, click the time zone link.

*Important* The time zone you select does not affect the time zone setting for the meeting calendar on the Browse Meetings page. You and each attendee can select the time zone for your view of the calendar independently, using the *Your time zone* option on the Preferences page. To access this page, on the navigation bar, click **Set Up > Preferences**

**Attendees can join [x] minutes before the starting time** | Allow attendees to join the meeting within a set number of minutes before the meeting's starting time.

*Note:* If you clear this check box or set this option to 0 minutes, you must start the meeting before attendees can join it

For more information about starting a meeting, see *Starting a scheduled meeting* (on page 88).

**Attendees can also connect to WebEx audio** | If you allow attendees to join the meeting before the scheduled starting time, you can also allow attendees to join the WebEx Audio conference before the meeting starts.

You set up the WebEx Audio conference on the next page.

**Estimated duration** | Enter the length of time you estimate that the meeting will continue. The meeting does not end automatically after the duration that you set.

**Email reminder** | Set the number of minutes before the meeting’s scheduled starting time at which you want to receive a reminder email message. If you do not want to receive a reminder, in the drop-down list, select *None*.

**Recurrence** | Set the recurrence pattern for this meeting.

*None:* Specifies that the meeting does not recur.

*Daily:* Repeats the meeting every day until the ending date that you select.

- *Every [x] Days:* Repeats the meeting after the specified number of days pass.
- *Every weekday:* Repeats the meeting each day, from Monday to Friday.
### Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weekly:</strong> Repeats the meeting after a specified number of weeks until the ending date that you select.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>Every [x] week(s) on:</strong> Specifies the day of the week on which to repeat the meeting and the number of weeks that must pass before the meeting repeats.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>Sunday - Saturday:</strong> Specifies the day on which the meeting repeats. You can select one or more days.</td>
<td></td>
</tr>
<tr>
<td><strong>Monthly:</strong> Repeats the meeting every month until the ending date that you select.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>Day [x] of every [x] month(s):</strong> Specifies the specific day of the month on which to repeat the meeting, and the number of months that pass before the meeting repeats.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>[x] [x] of every [x] month(s):</strong> Specifies the specific week and day of the week on which to repeat the meeting, and the number of months that pass before the meeting repeats.</td>
<td></td>
</tr>
<tr>
<td><strong>Yearly:</strong> Repeats the meeting every year until the ending date that you select.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>Every [month] [date]:</strong> Specifies the specific month and date on which to repeat the meeting each year.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>[x] [day] of [month]:</strong> Specifies the specific week, day of the week, and month on which to repeat the meeting each year.</td>
<td></td>
</tr>
<tr>
<td><strong>Ending</strong></td>
<td></td>
</tr>
<tr>
<td>▪ <strong>No end date:</strong> Repeats the meeting indefinitely. That is, the meeting recurs until you cancel it.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>Ending:</strong> Specifies the last day on which the meeting recurs. You can select the month, day, and year in the drop-down lists. Or, you can click Calendar icon, and then select a date.</td>
<td></td>
</tr>
<tr>
<td>▪ <strong>After [x] meetings:</strong> Specifies the number of meetings after which the meeting stops recurring.</td>
<td></td>
</tr>
</tbody>
</table>
Questions about setting the date and time for a meeting

Does the meeting end automatically at the time I set?

You can set the time a scheduled meeting starts and the meeting's estimated duration. This information allows attendees to reserve the appropriate length of time in their schedules. The meeting does not end automatically after the duration you set.

What happens if I allow participants to join the meeting before the start time?

Participants can see the agenda and other details about the meeting. You can also set up a presentation to inform or entertain the participants while they wait for the meeting to start. You set up this option on the Agenda & Welcome page.

The option to let participants join the meeting before the host is available only if the administrator for your meeting service has turned the option on for your site and you schedule the meeting for a time in the future.

How can I learn about the fields on the Date & Time page?

Click the Help link in the top right corner of the Date & Time page, or review About the Date & Time page (on page 57).

About the Audio Conference page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Audio Conference.
Chapter 4: Scheduling a Meeting

What you can do on this page

- Include a VoIP (voice over Internet Protocol) session
- Choose the telephony service you want to use in the meeting you are scheduling
  If you choose WebEx teleconferencing, you can set other options, such as whether meeting participants call in to the meeting or receive a call back and if the participants use a toll or toll-free number.
- Choose the sound that plays when participants enter or leave the meeting.
  For instance, you can hear a “beep” or have the name of the participant announced.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set options using template</strong></td>
<td>Select a template and use the settings saved in that template for this meeting. You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in previous meetings and saved as a template. For more details about creating and editing templates, see Using meeting templates (on page 91).</td>
</tr>
</tbody>
</table>
| **Select conference type** | Select the type of audio conference you would like to use: **WebEx Audio**: Specifies that the meeting includes an integrated audio conference. If you select this option, choose one of the following types of teleconferences:
  - **Display toll-free number**: If attendees call in to the conference, they can call a toll-free number.
    - **Toll number is always displayed**: Attendees have the option of using the toll number that appears.
  - **Display global call-in numbers**: This option provides a list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the audio conference.
  - **Enable teleconference CLI authentication when participants call in**: CLI (caller line identification) is a form of caller ID, a telephony intelligent service that transmits a caller’s telephone number before the call is answered. If you use WebEx audio conferencing, you can help participants join the meeting more quickly, if participants have:
    - a WebEx host account
    - saved their phone numbers in their WebEx profiles |
## Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>This option is not available for Cisco Unified MeetingPlace users.</td>
<td></td>
</tr>
</tbody>
</table>

**Personal Conference number:** Displays the personal audio conference accounts you have set up in the Personal Conferencing area of My WebEx. Select the account you want to use for your meeting. You can create up to three accounts.

Click **Edit** to make changes, such as updating the subscriber or attendee access code.

If you have not yet set up any accounts, select **Create Personal Conference account** to get started. This option is not available for Cisco Unified MeetingPlace users.

**Other teleconference service:** Specifies that the meeting includes a teleconference that another service provides.

Instructions: Provides space for you to type instructions for joining the teleconference.

Instructions for any teleconference option that you select automatically appear:

- On the Meeting Information page on your site, which participants can view before you start the meeting
- In invitation email messages, if you invite participants using the Schedule a Meeting page options
- On the Info tab, which appears in the content viewer in the Meeting window
- In the Join Teleconference dialog box, which appears in participants’ Meeting windows once they join the meeting

**Cisco Unified MeetingPlace Audio Conferencing:** Specifies that the meeting include an integrated audio conference. If you select this option, choose the type of conference:

- **Attendees call in:** Select if you want customers to dial a number to join
- **Attendees receive call back:** Select if you want customers to type in a phone number and receive a call back from the conferencing service.

A participant must have a direct phone line to receive a call from the conferencing service. However, a participant without a direct phone line can join an audio conference by dialing a call-in number, which is always available in the meeting window.

**Use VoIP only:** Specifies that you want to set up an Integrated VoIP conference for the meeting. If selected, you can still set up a traditional teleconference for the meeting.

- You must start VoIP after you start the meeting.
- Only participants whose computers meet the system requirements for integrated VoIP session can participate
Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>None:</td>
<td>Specifies that the meeting does not include a teleconference, or the meeting includes a teleconference for which you will provide information for participants using a method other than your meeting service.</td>
</tr>
</tbody>
</table>

**Entry & exit tone**

Select the sound you would like all participants to hear when an attendee joins or leaves the meeting:

- **Beep**: A simple tone plays
- **Announce name**: Upon joining the teleconference, a participant records his or her name, which is then played in the teleconference.
- **No Tone**: No alert plays

Questions about setting up an audio conference

What kinds of audio conferences are available?

To provide audio during a meeting, you can use one of the following voice conferencing services:

- **Integrated call-in teleconference**: A teleconference that a participant can join by calling a phone number. The number to call automatically appears in a message box when a participant joins a meeting. If your meeting service provides toll-free call-in teleconferencing, both a toll-free number and a toll number are available. The global call-in option provides a list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the teleconference.

- **Integrated call-back teleconference**: A teleconference that a participant can join by providing his or her phone number when joining a meeting. The participant enters his or her number in a dialog box that appears when he or she joins the meeting. The teleconferencing service calls the participant at the number he or she provided.

- If your site includes the international call-back option, participants in other countries can receive a call back. For more information about this option, ask your meeting service site administrator.

- **Third-party or internal teleconference**: Any teleconferencing service other than the integrated teleconferencing service. You can use any third-party teleconferencing service or internal teleconferencing system, and provide instructions for joining teleconference when setting up a meeting. Your instructions automatically appear in a message box when a participant joins the meeting.
What are the system requirements for VoIP?

To use VoIP, ensure that your computer meets the following system requirements:

- A supported sound card
  
  For a current list of supported sound cards, refer to the Frequently Asked Questions page on your Meeting Center Web site. You can access this page from your site's Support page.

- Speakers or headphones

- Microphone, if you want to speak during the conference

**Tip:** For better audio quality and greater convenience, use a computer headset with a high-quality microphone.

When should I include VoIP?

- Your meeting includes remote attendees who do not want to be charged for long-distance phone calls.

- Your meeting will not involve much interaction—for example, attendees will listen to a presentation instead of engage in a discussion.

- You want to minimize the voice conferencing costs for the meeting.

Check that your computer has the minimum system requirements for VoIP. For details, see *About the Audio Conference Settings page* (on page 61).

What is a dual-mode voice conference and when should I use it?

You can set up a dual-mode voice conference for a scheduled or instant meeting—that is, a voice conference that includes both a teleconference and VoIP. In a dual-mode voice conference, participants can use either type of service.

In a dual-mode voice conference, a participant can listen to audio using either a phone or speakers attached to his or her computer. To speak, a participant can use either a phone or microphone attached to his or her computer.

**Note:**

- Participants in a teleconference can speak to and hear only other participants in the teleconference. Similarly, participants using VoIP can speak to and hear only other participants using VoIP. Thus, the dual-mode conference option is usually appropriate for a meeting in which participants will listen to a presentation only and not interact in the voice conference.

- All participants can listen to a presentation if the presenter speaks into both a phone and a microphone.
How can I learn about the fields on the Audio Conference Settings page?

Click the Help link in the top right corner of the Audio Conference Settings page, or review *About the Audio Conference Settings page* (on page 61).

## About the Invite Attendees page

### How to access this page

On the navigation bar, click **Host a meeting** > **Schedule a meeting** > **Invite Attendees**.

![Invite Attendees page](image)

### What you can do on this page

Invite attendees to your meeting, by entering their email addresses or selecting them from your address book.

### Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| Set options using template | Select a template and use the settings saved in that template for this meeting.  
You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in a previous meetings and saved as a template.  
For more details about creating and editing templates, see *Using meeting templates* (on page 91). |
| Attendees | Enter the email addresses of the attendees you want to invite to your meeting.  
You can type the addresses, separating them with a comma or semicolon or you can click **Select Attendees** to choose... |
## Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>attendees from your address book.</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **Allow external attendees** | Allow attendees located on the public internet to join your meeting. If unchecked, only attendees within the same internal network can join.  
**Note:** This option is available for Cisco Unified MeetingPlace users only. |
| **Request that attendees verify rich media players before joining meeting** | Add a request to invitation email messages for attendees to verify that these components are installed on their computers for playing a UCF media file:  
- Flash Player, for playing a Flash movie or interactive Flash files  
- Windows Media Player for playing audio or video files  
This option is useful if you or another presenter plans to share a UCF multimedia presentation or standalone UCF media files during the meeting. |
| **Send a copy of the invitation email to me** | Receive a copy of the invitation you are sending to attendees. Later, if you decide to invite additional attendees, you can simply forward this email message to them. |
| **Select Attendees/Edit Attendees button** | Opens the Select Attendees page. You can select contacts in your personal address book to invite to the meeting.  
You can also add a new contact to your address book and then invite that contact to your meeting. |
| **Security** | **Exclude password from email invitations:** If you invite attendees to a meeting, the meeting password does not appear in the email invitations that attendees receive. You must provide the password to attendees by another means, such as by phone.  
**Require attendees to have an account on this Web site to join this meeting:** All attendees must have a user account on your site to attend the meeting.  
For information about how attendees can obtain a user account, ask your site administrator. |
**Questions about inviting attendees**

**What is an alternate host?**

When inviting attendees to a scheduled meeting, you can designate one or more attendees as alternate hosts for the meeting. An alternate host can start the meeting and act as the host. Thus, an alternate host must have a user account on your Meeting Center Web site.

Once you invite an attendee to a meeting as an alternate host, the attendee receives an invitation email message that provides information about acting as the alternate host. Your scheduled meeting appears on the alternate host's My WebEx Meetings page.

**Can I invite people using my online address book?**

You do not have to type the email address of each person you want to invite to your meeting. You can select attendees and sales team members (for Sales Center meetings) from your address book.

You can access your address book from the Invite Attendees page (for Meeting Center meetings) or the Invite Participants page (for WebEx Sales Center meetings) in the Advanced Scheduler.

**Which information is included in the email invitation to my meeting?**

Each attendee that you invited receives an invitation email message, which includes:

- A link that the attendee can click to join the meeting or obtain more information about it
- The meeting password, if you specified one
- Teleconferencing information, if your meeting includes an integrated teleconference
- The meeting number, which the attendee must provide if your meeting is unlisted

After you start a scheduled meeting, you can invite additional attendees. For details, see .Inviting attendees to a meeting in progress.

**Why should I request that attendees check their systems for UCF compatibility?**

When scheduling a meeting, you can add a request to invitation email messages for attendees to verify that the following components are installed on their computers for playing Universal Communications Format (UCF) media files:

- Flash Player, for playing a Flash movie or interactive Flash files
- Windows Media Player for playing audio or video files
This option is useful if you or another presenter plans to share a UCF multimedia presentation or standalone UCF media files during the meeting.

Your request automatically appears in any invitation email messages that you send to attendees using the Advanced Scheduler invitation options. Your request also includes a link that attendees can click to access the Verify Rich Media Players page on your Meeting Center Web site. This page allows attendees to automatically verify that the required players are installed on their computers.

**Note:** If you intend to allow attendees to share UCF multimedia presentations or standalone UCF media files, ensure that the Enable UCF rich media for attendees check box is selected on the Meeting Options page in the Advanced Scheduler.

### How can I learn about the fields on the Invite Attendees page?

Click the Help link in the top right corner of the Invite Attendees page, or review About the Invite Attendees page.

### Can I use my online address book to invite attendees?

You do not have to type the email address of each person you want to invite to your meeting. You can select attendees from your address book.

You can access your address book from the Invite Attendees page in the Advanced Scheduler.

### How can I enhance meeting security?

When scheduling a meeting, you can require all attendees to have a user account on your site. If you include this requirement (an option on the Invite Attendees page), attendees must log in to your Meeting Center Web site to attend the meeting, which enhances meeting security.

Each invited attendee automatically receives an invitation email message. To help increase the security for your meeting, you can prevent the meeting password from appearing in these invitations by selecting the **Exclude password from email invitation** option on the Invite Attendees page. If you exclude the password in email invitations, however, you must provide the password to attendees using another method—for example, by phone.

### About the Select Attendees page

**How to access this page**

On the navigation bar, click **Host a Meeting > Schedule a Meeting > Invite Attendees > Select Attendees.**
Chapter 4: Scheduling a Meeting

What you can do on this page:

- Select contacts in your personal address book and invite them to the meeting.
- Add new contacts to your personal address book and invite them to the meeting.
- Designate one or more invited attendees as alternate hosts.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address book</td>
<td>Lets you select the address book from which you want to select attendees. The contacts in the address book that you select appear in the box. The following address books are available:</td>
</tr>
<tr>
<td></td>
<td><strong>Personal contacts</strong>: Includes any individual contacts that you have added to your personal address book. If you use Microsoft Outlook, you can import the personal contacts that you keep in an Outlook address book or folder to this list of contacts.</td>
</tr>
<tr>
<td></td>
<td><strong>Company address book</strong>: Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.</td>
</tr>
<tr>
<td>New Contact</td>
<td>Opens the New Contact page. Enter the requested information about the new contact you want to invite to the meeting. You can also add the new contact to your personal address book</td>
</tr>
<tr>
<td>Search</td>
<td>Lets you search for text in the selected address book. For example, you can search for all or part of a contact name or email address</td>
</tr>
<tr>
<td>Invite as</td>
<td><strong>Attendee</strong>: Adds the selected contacts to the list of attendees. Alternate Host: Adds the selected contacts as alternate hosts to the list of attendees. An alternate host receives an invitation email message that provides information about acting as the alternate host. An alternate host can start the meeting and act as the host. If you join the meeting after an alternate host has started or joined it, you do not automatically assume the host role. An alternate host must have a user account on your meeting service Web site.</td>
</tr>
</tbody>
</table>
Chapter 4: Scheduling a Meeting

About the Registration page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Registration

What you can do on this page

- Determine whether attendees must register to attend a meeting.
- If attendees must register, select which information attendees must provide on the registration form.
- Accept registration requests automatically.
## Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Set options using template**     | Select a template and use the settings saved in that template for this meeting.  
You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in previous meetings and saved as a template.  
For more details about creating and editing templates, see Using meeting templates (on page 91). |
| **Registration**                   | ▪ **None:** Specifies that attendees need not register to attend the meeting.  
▪ **Require attendee registration:** All attendees must register to attend the meeting. An attendee cannot attend the meeting until his or her registration you accept his or her registration request.  
You can accept registration requests in either of two ways:  
▪ Automatically, by selecting the Automatically accept all registration requests option on this page.  
▪ Manually, by using the options on the Registered Attendees page. For details, see Accepting or Rejecting Registration Requests. |
| **Obtain detailed attendee information** | Select which information attendees must provide to register for the meeting. Information that you do not select still appears on the form, but attendees need not provide it to register for the meeting. |
| **Automatically accept all registration requests** | Accept all registration requests automatically, and lets all registrants attend the meeting. You do not receive registration requests. If this option is not selected, you must accept or reject each registration request individually, using the options on your meeting service Web site. |

## Questions about registration

**What are the benefits of requiring attendees to register for a meeting?**

You can require meeting attendees to register for a meeting before they can join it. Requiring registration allows you to:

▪ View a list of attendees to determine whether they have registered for the meeting  
▪ Obtain attendees' names, email addresses, and optionally additional personal information before they can join the meeting
Accept or reject individual registration requests

Increase the security of your meeting

If you invite an attendee to a meeting that requires registration, the attendee receives an invitation email message that includes information about the meeting and a link that the attendee can click to register for the meeting.

**Important:** If you accept registration requests automatically for a meeting that requires a password—and an attendee registers after the meeting has already started—the attendee can join the meeting immediately, without providing the password. Therefore, to secure a meeting from unauthorized access, you must clear the Automatically accept all registration requests check box, and manually accept or reject all registration requests.

If you do not accept registration requests automatically for a meeting that requires a password—and an attendee registers after the meeting has already started—the attendee cannot join the meeting until he or she receives a registration confirmation email message and can provide the meeting password. During the meeting, you can check for registration requests in your email program and accept them to allow attendees to join the meeting.

### How do I accept or reject registration requests?

If you scheduled a meeting for which attendees must register, you can accept or reject attendees' registration requests. If you accept a registration request, a registration confirmation email message which provides the meeting password, if any is sent the attendee. If you reject a registration request, a registration rejection email message is sent to the attendee.

**Note:** If you select the *Automatically accept all registration requests* check box on the Registration page, all registration requests are accepted automatically and a registration confirmation email message is sent to each attendee who registers.

### To accept or reject registration requests:

1. Log in to your meeting service Web site. For details, see Logging In to Your Meeting Service Web Site.

2. On the navigation bar, click **My WebEx**.
   
   The My Meetings page appears, showing a list of any meetings that you have scheduled.

3. In the list of meetings, click the meeting topic link for the meeting for which you want accept or reject registration requests.
   
   The Meeting Information page appears.

4. Click **Attendees**.
The Registered Attendees page appears, showing a list of attendees who have registered for the meeting.

5 Select the check box for each attendee for whom you want to accept or reject a registration request.
   - To select all attendees currently appearing in the list, click **Select All**.
   - To clear all selections in the current list, click **Clear All**.

6 Opt to approve or reject selected registration requests.
   - Click **Accept** to approve the registration requests for all attendees that you selected
   - Click **Reject** to reject the registration requests for all attendees that you selected.

**Tip:** You can sort the registered attendees list by clicking the column headings.
You can also open the Registered Attendees page by selecting the meeting on the public Browse Meetings page. Then click **Get Info** > **Attendees**.

**How can I learn about the fields on the Registration page?**
Click the Help link in the top right corner of the Registration page, or review *About the Registration page* (on page 71).

**About the Agenda & Welcome page**

**How to access this page**
On the navigation bar, click **Host a meeting** > **Schedule a meeting** > **Agenda & Welcome**.
What you can do on this page

- Enter an agenda for your meeting.
- Choose a template for the Info tab in the Meeting window.
- Automatically show a document or presentation to participants once they join the meeting.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set options using template</td>
<td>Select a template and use the settings saved in that template for this meeting.</td>
</tr>
<tr>
<td></td>
<td>You can save time by using a template that includes the list of attendees you want to invite,</td>
</tr>
<tr>
<td></td>
<td>a presentation you want to show before the meeting starts, and other options you have used</td>
</tr>
<tr>
<td></td>
<td>in a previous meetings and saved as a template.</td>
</tr>
<tr>
<td></td>
<td>For more details about creating and editing templates, see Using meeting templates (on page 91).</td>
</tr>
<tr>
<td>Agenda</td>
<td>Set the agenda for the meeting. You can type up to 2500 characters, including spaces and</td>
</tr>
<tr>
<td></td>
<td>punctuation. The agenda appears on the Meeting Information page for the meeting on your</td>
</tr>
<tr>
<td></td>
<td>meeting service Web site.</td>
</tr>
<tr>
<td>Info tab templates</td>
<td>Lets you choose a template for the Info tab, which appears in the content viewer during the</td>
</tr>
<tr>
<td></td>
<td>meeting. The Info tab contains information about the meeting, such as the:</td>
</tr>
<tr>
<td></td>
<td>- Meeting host</td>
</tr>
<tr>
<td></td>
<td>- Teleconference phone numbers</td>
</tr>
<tr>
<td></td>
<td>- Host key (if you are the host)</td>
</tr>
<tr>
<td>If you are using WebEx Sales Center</td>
<td>You can choose another template only if your site administrator has provided one or more</td>
</tr>
<tr>
<td></td>
<td>customized Info tab templates for your meeting service.</td>
</tr>
</tbody>
</table>
## Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Automatically share presentation or document once a participant joins the meeting** | Select a presentation or document to share automatically after a participant joins the meeting. This option is useful if you allow attendees to join the meeting before the host.  

The file that you select **must:**  

- Be in the Universal Communications Format (UCF). For information about creating UCF files, refer to the guide, *Getting Started with WebEx Universal Communications Toolkit*, which is available on your meeting service Web site.  
- Reside in your personal folders on your meeting service Web site. You can select a UCF file that already resides in your folders, or upload a new file to your folders while scheduling a meeting. |

- **Browse** | Opens the Add/Select Presentation page. You can select a UCF presentation or document that resides in your personal folders, or upload a new file to your folders. |

- **Delete** | Delete the selected presentation or document from the box. |

- **Start automatically** | Have presentation slides or document pages advance automatically in the content viewer at the time interval you choose.  

  - Select this option **only** if the presentation or document contains multiple slides or pages.  
  - Do not select this option if the presentation or document contains UCF media files.  

  **Continuous play:** Available only if you select **Start automatically.** Specifies that shared presentation or document restarts once it is finished, and continues advancing page automatically.  

  **Advance page every [x] seconds:** Available only if you select **Start automatically.** Lets you select the frequency at which slides or pages advance automatically. |

- **Allow participants to control file:** Let participants navigate the presentation or document independently in their content viewers. The slides or pages do not advance automatically.  

Select this option if the presentation or document contains only one slide or page, or if it contains any UCF rich media objects, such as audio or video objects. |

- **Quick Start** | Select this option to display the Quick Start page to host and presenter at the start of the meeting. If not selected, the Info page displays at the start of the
Chapter 4: Scheduling a Meeting

About the Add/Select Presentation page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting > Agenda & Welcome > Browse

What you can do on this page

- Upload a new Universal Communications Format (UCF) file to your personal folders, and then select it
- Select an UCF presentation or document that already resides in your personal folders

The file that you select plays automatically for a participant once the participant joins the meeting.

**Tip:** The file that you select must be in the WebEx Universal Communications Format (UCF).

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Upload a file to My Folders</strong></td>
<td>Select a UCF presentation or document that resides on your computer, and upload it to your personal folders. To upload a file, under Select, select the folder in which you want to upload the file. Click Browse, select the file on your computer, and then click Open. Click Upload.</td>
</tr>
<tr>
<td><strong>Select a presentation to share automatically</strong></td>
<td>Select a UCF presentation or document that already resides in your personal folders.</td>
</tr>
<tr>
<td><strong>Done</strong></td>
<td>Save your file selection, and then return to the Agenda &amp; Customizable Welcome page</td>
</tr>
</tbody>
</table>
Questions about setting the agenda and welcome message

Can I change how the information on the Info tab displays?

You can choose a template for the Info tab, which appears in the content viewer during the meeting. The Info tab contains information about the meeting, including the meeting host, teleconference phone numbers, and host key (for the host only).

Note: You can choose another template only if one or more customized Info tab templates are available for your meeting service. Your site administrator can add templates for your service.

What is the Quick Start page?

The Quick Start page allows a presenter to quickly display a document, application or other item they want to share during a meeting. If the Quick Start option is selected by the host on the Meeting Agenda & Welcome page, Quick Start is available to participants throughout the meeting by clicking the Quick Start tab in the content viewer.

For more details about any of the actions available from Quick Start, click the Learn More link.

Can I change the meeting agenda or add one after I have set up my meeting?

You can easily edit a scheduled meeting. You can edit it from the link in the confirmation email message you received or from your Meeting Center Web site. For detailed instructions, see Editing a scheduled meeting (on page 87).

Why share a document before the meeting starts?

When scheduling a meeting, you can select a presentation or document to share automatically in the content viewer once a participant joins the meeting. If the presentation or document contains multiple pages, you can also automatically advance its pages at a specified interval.

You can use this opportunity to share a presentation that informs or entertains participants while they wait for you to start the meeting.

The presentation or document that you select must:

- Be in the Universal Communications Format (UCF). For information about creating UCF files, review the Getting Started with WebEx Universal Communication Toolkit, available on your Meeting Center Web site; click Support > User Guides from the Welcome page.

- Reside in your personal folders in the My WebEx area on your Meeting Center Web site. You can select a UCF file that already resides in your folders, or upload a new file to your folders while scheduling a meeting.
Important: If you share a UCF multimedia presentation that includes rich media files—such as audio or video files—follow these guidelines:

- Ensure that each media file is embedded in the presentation file or resides on a publicly accessible Web server. If the presentation contains a link to a media file that resides on your computer, participants cannot view that media file. For more information about creating UCF multimedia presentations, refer to the guide *Getting Started with WebEx Universal Communications Toolkit*, which is available on your Meeting Center Web site.

- Select Allow participants to control file on the Agenda and Welcome page. If you do not select this option, the pages or slides in the document or presentation will advance automatically, which may prevent participants from viewing the media files.

- Ensure that each media file is set to play automatically for participants. For more information about setting this option for a UCF media file, refer to the guide *Getting Started with WebEx Universal Communications Toolkit*, which is available on your Meeting Center Web site.

How can I learn about the fields on the Agenda & Welcome page?

Click the Help link in the top right corner of the Agenda & Welcome page, or review *About the Agenda & Welcome page* (on page 74).

About the Meeting Options page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting > Meeting Options.
Chapter 4: Scheduling a Meeting

What you can do on this page

- Select which options, such as chat, notes, and video are available during the meeting.
- Allow presenters to transfer files and meeting participants to download these files of the meeting.
- Specify whether attendees can share UCF rich media files.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set options using template</strong></td>
<td>Select a template and use the settings saved in that template for this meeting.</td>
</tr>
<tr>
<td></td>
<td>You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in a previous meetings and saved as a template.</td>
</tr>
<tr>
<td></td>
<td>For more details about creating and editing templates, see <em>Using meeting templates</em> (on page 91).</td>
</tr>
</tbody>
</table>

**Meeting Options**

- **Chat**: Specifies that chat options are available in the Meeting window during the meeting.

**Video**: Specifies that video options are available in the Meeting window during the meeting.

- **Single-point**: Lets only the presenter send live video during the meeting.
- **Multipoint**: Lets the presenter and up to three other participants send live video during the meeting.
- **Single-point** and **Multipoint options** appear only if your meeting service Web site has the multipoint video option. To turn on the multipoint video option for your site, please contact WebEx Communications.
<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notes</strong></td>
<td>Specifies that note-taking options are available in the Meeting window during the meeting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Allow participants to take notes</strong>: Lets all participants take their own notes during the meeting, and save them to their computers.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Single note taker</strong>: Lets only one participant take notes during the meeting. By default, the host is the note-taker, but can designate another participant as the note-taker during the meeting. A note-taker can publish notes in all participants’ Meeting windows at any time during the meeting. The host can send a transcript of the notes to participants at any time.</td>
</tr>
<tr>
<td><strong>Enable closed captioning</strong></td>
<td>Lets one participant—the closed captionist—transcribe notes during the meeting. Closed captioning is useful if hearing-impaired participants are attending the meeting. By default, the host is the closed captionist, but can designate another participant as the closed captionist during the meeting. Meeting Manager publishes closed captions in all participants’ Meeting windows once the closed captionist presses the <strong>Enter</strong> key on his or her keyboard. Thus, notes are usually published one line at a time. The host can send a transcript of the closed captions to participants at any time.</td>
</tr>
<tr>
<td><strong>File transfer</strong></td>
<td>Specifies that the presenter can publish files and attendees can download them during a meeting.</td>
</tr>
<tr>
<td><strong>Enable UCF rich media for attendees</strong></td>
<td>Allows attendees to share Universal Communications Format (UCF) media files during the meeting, either in a UCF multimedia presentation or as standalone UCF media files. A meeting host who is also the presenter can always share UCF media files, whether or not you select this check box.</td>
</tr>
</tbody>
</table>

**Note**: A presenter can change the default privileges for all attendees or individual attendees at any time during a meeting.
Questions about setting meeting options

What are some rules of thumb for sharing UCF media files?

When scheduling a meeting, you can allow attendees to share Universal Communications Format (UCF) media files during the meeting, either in a UCF multimedia presentation or as standalone UCF media files.

You can also prevent attendees from sharing UCF media files during a meeting. If you do so, only the meeting host can share UCF media files when also acting as the presenter.

You may want to prevent attendees from sharing UCF media files, for example, if you intend to allow attendees to share presentations or documents but want to prevent an attendee from inadvertently sharing a very large media file.

Note: The alerts options are applicable only if you select an integrated teleconference on the Teleconference page in the Advanced Scheduler. For more information about setting up an integrated teleconference, see About the Teleconference Settings page (on page 61).

How can I learn about the fields on the Meetings Options page?

Click the Help link in the top right corner of the Meeting Options page, or review About the Meeting Options page (on page 79).

About the Attendee Privileges page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Attendee Privileges
Chapter 4: Scheduling a Meeting

What you can do on this page

- Select the meeting privileges that attendees have once the meeting starts.

**Note:** A presenter can grant any privileges to or remove them from attendees during a meeting.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| Set options using template | Select a template and use the settings saved in that template for this meeting.  
You can save time by using a template that includes the list of attendees you want to invite, a presentation you want to show before the meeting starts, and other options you have used in a previous meetings and saved as a template.  
For more details about creating and editing templates, see *Using meeting templates* (on page 91). |
<p>| Privileges              | Select privileges that you want attendees to have when meeting begins. |</p>
<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save</strong></td>
<td>Save any shared documents, presentations, or whiteboards that appear in their content viewers.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Print any shared documents, presentations, or whiteboards that appear in their content viewers.</td>
</tr>
<tr>
<td><strong>Annotate</strong></td>
<td>Annotate any shared documents or presentations, or write and draw on shared whiteboards that appear in their content viewers, using the toolbar that appears above the viewer. An attendee's annotations are visible to all participants.</td>
</tr>
<tr>
<td><strong>View participant list</strong></td>
<td>View the participant list on the Participants panel.</td>
</tr>
<tr>
<td><strong>View thumbnails</strong></td>
<td>Display miniatures of any pages, slides, or whiteboards in any document, presentation, or whiteboard that appear in their content viewers. However, attendees with this privilege cannot display a miniature at full size unless they also have the View any page privilege.</td>
</tr>
<tr>
<td><strong>Control applications, Web browser, or desktop remotely</strong></td>
<td>Request that the presenter grant them remote control of a shared application, Web browser, or desktop.</td>
</tr>
<tr>
<td><strong>View any document</strong></td>
<td>View any document, presentation, or whiteboard that appears in the content viewer, and navigate to any pages or slides in documents or presentations.</td>
</tr>
<tr>
<td><strong>View any page</strong></td>
<td>View any pages, slides, or whiteboards that appear in their content viewers. This privilege allows attendees to navigate independently through pages, slides, or whiteboards.</td>
</tr>
<tr>
<td><strong>Contact operator privately</strong></td>
<td>Dial 00 at any time during a teleconference to contact the operator for your teleconferencing service. Available only if your site includes the private operator option.</td>
</tr>
<tr>
<td><strong>Participate in private chat with:</strong></td>
<td>Send private chat messages to another participant. Private chat messages appear only in the recipient's Chat viewer. <strong>Host:</strong> Chat privately with the meeting host. <strong>Presenter:</strong> Chat privately with only the presenter. <strong>All attendees:</strong> Chat privately with any other attendee.</td>
</tr>
</tbody>
</table>
Questions about attendee privileges

Besides the host, who can grant and remove attendee privileges?
A presenter can grant any privileges to or remove them from attendees during a meeting.

Can I change attendee privileges during a meeting?
Yes, you can. On the Meeting menu, choose Attendees Privileges. Make any changes to the privileges you set when you scheduled the meeting.

How can I learn about the fields on the Attendee Privileges page?
Click the Help link in the top right corner of the Attendee Privileges page, or review About the Attendee Privileges Page (on page 82).

About the Review page

How to access this page
On the navigation bar, click Host a Meeting > Schedule a Meeting > Review

What you can do on this page
- Review all the information you've entered on each page of the Advanced Scheduler.
- If you want to make any changes, return to the page where you entered the information and enter new information.
- Rather than using the settings and options you have just selected in the scheduler, replace these setting with those in one of the meeting templates.
  For more details about creating and editing templates, see Using meeting templates (on page 91)
  When you have finished making changes, click Schedule or Start.

Managing and maintaining your scheduled meetings

You can easily invite more participants to a scheduled meeting, change the day or time, or even add the meeting to your calendar program.
Chapter 4: Scheduling a Meeting

Add a scheduled meeting to your calendar program

Once you schedule a meeting, you can add the meeting to your calendar program, such as Microsoft Outlook. This option is applicable only if your calendar program supports the iCalendar standard, a common format for exchanging calendaring and scheduling information across the Internet.

To add a scheduled meeting to your calendar:

1. Do one of these tasks, as appropriate:
   - On the Meeting Scheduled page, click Add to My Calendar.
   - On the Meeting Updated page, click Update My Calendar.
   - On the Meeting Information page for the meeting, click Add to My Calendar.
   - In the confirmation email message that you receive once you schedule or edit a meeting, click the link to add the meeting to your calendar.

   A meeting item opens in your calendar program.

2. Select the option to accept the meeting request. For example, in Outlook, click Accept to add the meeting item to your calendar.

Note:
- If you cancel a meeting, the Meeting Deleted confirmation page and the confirmation email message that you receive contains an option that lets you remove the meeting from your calendar program.
- If you invite attendees to a meeting, the invitation email message that they receive contains an option to add the meeting to their calendar programs.
Editing a scheduled meeting

Once you schedule a meeting, you can make changes to it at any time before you start it—including its starting time, topic, password, agenda, attendee list, and so on.

If you update any information about a meeting, including adding or removing attendees, you can choose to send attendees a new invitation email message that informs them that you have modified information about the meeting. Attendees whom you removed from the attendee list receive an email message informing them that you have retracted their invitations.

You can modify a meeting from the confirmation email message that you received after you scheduled the meeting or from your meeting list in My WebEx.

To edit a meeting from the confirmation email message:

1. Open your confirmation email message, and then click the link.
   
   If you are not already logged in to your Meeting Center Web site, the Log In page appears.

2. If the Log In page appears, provide your account user name and password, and then click Log In.
   
   The Meeting Information page appears.

3. Click Edit.

4. Modify the meeting. For more information about the options that you can modify, see Using the Advanced Scheduler.

5. To save your changes to the meeting, click Save.
   
   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

6. If a message box appears, click the appropriate update option, and then click OK.
   
   The Meeting Updated page appears.
   
   You receive a confirmation email message that includes information about the changes that you made to the meeting.

7. Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, on the Meeting Updated page, click Update My Calendar.

To edit a scheduled meeting from your meeting list on your Meeting Center Web site:

1. Log in to your Meeting Center Web site.

2. On the navigation bar, click My WebEx.
Chapter 4: Scheduling a Meeting

The My Meetings page appears, displays each meeting that you have scheduled.

3 In the meeting list, under **Topic**, click the topic for the meeting.

4 Click **Edit**.

5 Modify the meeting. For more information about the options that you can modify, see Using the Advanced Scheduler.

6 Click **Save**.

   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click **OK**.

   If you click **Cancel** in the message box, the meeting is not updated.

   The Meeting Updated page appears. You receive a confirmation email message that includes information about the changes that you made to the meeting.

8 Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, in the confirmation email message, click **Update My Calendar**.

Starting a scheduled meeting

A meeting does not start automatically at the scheduled time. If, when scheduling the meeting, you did not select the option that allows participants to join the meeting before the host, you must start the meeting before participants can join it.

After you schedule a meeting, you receive a confirmation email message that includes a link that you can click to start the meeting. Or, you can start the meeting from your meeting list in My WebEx.

**To start a meeting from the confirmation email message:**

1 Open your confirmation email message, and then click the link.

   If you are not already logged in to your Meeting Center Web site, the Log In page appears.

2 If the Log In page appears, provide your account username and password, and then click **Log In**.

   The Meeting Information page appears.

3 Click one of the following:

   - **Start Now**. Appears if the meeting is not in progress.
   - **Join Now**. Appears if you allowed participants to join the meeting before its starting time and participants have already joined the meeting.
The Meeting window appears.

To start a scheduled meeting from your meeting list on your Meeting Center Web site:

1. Log in to your Meeting Center Web site.
2. On the navigation bar, click **My WebEx**.
   
   The My Meetings page appears, displaying a list of each meeting that you have scheduled.
3. In the meeting list, under **Status**, click one of the following:
   
   - **Start**. Appears if the meeting is not in progress.
   - **Join Now**. Appears if you allowed participants to join the meeting before its starting time and participants have already joined the meeting.

   The Meeting window appears.

### Starting a meeting from your iPhone

A meeting does not start automatically at the scheduled time. If, when scheduling the meeting, you did not select the option that allows participants to join the meeting before the host, you must start the meeting before participants can join it.

**Note:** To start a WebEx meeting from your iPhone, you must have set up your WebEx account from the Profile page in your iPhone application.

To start a meeting from an email invitation link:

In your email invitation, tap the meeting link.

The WebEx Meeting Center application launches.

To start a meeting from your My Meetings page:

1. Tap the meeting you want to start
2. On the next page, tap on the **Join/Start** button.

   The WebEx Meeting Center application launches.

For detailed information about all aspects of using your iPhone to start or attend meetings, visit our website [http://www.webex.com/apple/](http://www.webex.com/apple/).
Chapter 4: Scheduling a Meeting

Canceling a scheduled meeting

You can cancel any meeting that you have scheduled. Once you cancel a meeting, you can choose to send a cancellation email message to all attendees whom you invited to the meeting. Canceling a meeting deletes it from your personal meeting list.

You can cancel a meeting from the confirmation email message that you received after you scheduled the meeting or from your meeting list in My WebEx.

To cancel a meeting from a confirmation email message:

1. Open your email confirmation message, and then click the link.
   - If you are not already logged in to your Meeting Center Web site, the Log In page appears.
2. If the Log In page appears, provide your account user name and password, and then click Log In.
   - The Meeting Information page appears.
3. Click Delete.
   - If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the meeting.
4. In the message box, click Yes or No, as appropriate.
   - If you click Cancel in the message box, the meeting is not canceled.
   - The Meeting Deleted page appears.
5. Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, on the Meeting Deleted page, click Remove From My Calendar to remove the meeting from your calendar.

To cancel a scheduled meeting from your meeting list on your Meeting Center Web site:

1. Log in to your Meeting Center Web site.
2. On the navigation bar, click My WebEx.
   - The My Meetings page appears, showing your scheduled meeting list.
3. In the meeting list, under Topic, click the topic for the meeting.
4. Click Delete.
   - If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the meeting.
5. In the message box, click Yes or No, as appropriate.
If you click **Cancel** in the message box, the meeting is not canceled.

You receive a cancellation confirmation email message.

**6 Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, in the confirmation email message, click the link to remove the meeting from your calendar.**

### Saving time when scheduling a meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>use a template with preset options when scheduling your meeting</td>
<td><strong>Using an existing meeting template for scheduling a meeting</strong> (on page 92)</td>
</tr>
<tr>
<td>use a template with preset options and save your changes to the template</td>
<td><strong>Using an existing meeting template and overwriting the template settings</strong> (on page 93)</td>
</tr>
<tr>
<td>use a template with preset options and save the changes in a new template</td>
<td><strong>Using an existing meeting template and saving the changes in a new template</strong> (on page 94)</td>
</tr>
<tr>
<td>set up a recurring meeting</td>
<td><strong>Setting up a recurring meeting</strong> (on page 95)</td>
</tr>
</tbody>
</table>

### Using meeting templates

If you meet with the same group of people and often schedule a meeting with the same tracking codes, audio settings and other meeting options, you can save these settings in a template. When you set up the first meeting, you can save your settings in a template. Later, when it is time to schedule another meeting, you can select that template from any page on the Quick Scheduler or Advanced Scheduler.

You have three ways to use an existing meeting template:

- **Use the template, without saving any changes to it**
  
  You can use the template as is or make changes to the settings without saving these changes to the template itself. For details, see **Using an existing meeting template for scheduling a meeting** (on page 92).

- **Make changes to the template settings and save the changes in the template**
  
  You can save these changes in the template, if you want to make permanent changes to the template. For details, see **Using an existing meeting template and overwriting the template settings** (on page 93).
Chapter 4: Scheduling a Meeting

- Make changes to the template settings and save them in a new template

  You can make changes to the template as you schedule your meeting. Then save your changes in the template, if you want to make a permanent change to the template.

  For details, see *Using an existing meeting template and saving the changes in a new template* (on page 94).

**Using an existing template for scheduling**

You can use the template without making changes to any details, or you can make changes on any page in the scheduler.

1. Log in to your Meeting Center Web site.
2. On the navigation bar, expand **Host a meeting** to view a list of links.
3. Click **Schedule a meeting**.
   
   The meeting scheduler appears.
4. Select the template you want to use in the **Set options using template** drop-down list.

   Look for the list on any title bar in the Quick Scheduler or Advanced Scheduler.

   ![Template List](image)

   These templates are available. You can select one from this list and use it to quickly schedule your meeting.

   The template in brackets is the default template provided by your site administrator.

5. Optional. Make changes to the settings on any page.

   For instance, you can add or remove attendees or show a new presentation as attendees join the meeting. Just go to the page in the scheduler that you want to change.

6. Start or schedule the meeting:

   - If the meeting's starting time is the current time, click **Start** to start the meeting.
   
   - If the meeting's starting time is after the current time, click **Schedule**.

   The Meeting Scheduled page appears, confirming that the meeting is scheduled. You also receive a confirmation email message that includes information about the scheduled meeting.
Chapter 4: Scheduling a Meeting

Using an existing meeting template and overwriting the template settings

You can open an existing meeting template and change the settings. You can save your changes to the template.

1. Log in to your Meeting Center Web site.
2. On the navigation bar, expand Host a meeting to view a list of links.
3. Click Schedule a meeting.
   The meeting scheduler page appears.
4. Select the template you want to use in the Set options using template drop-down list.
   These templates are available. You can select one from this list and use it to quickly schedule your meeting.
   The template in brackets is the default template provided by your site administrator.
5. Make changes to the details on any page.
   For example, you can add or remove attendees, change the meeting time, add a multimedia document to display before the meeting starts. For details about fields on each page, see Page-by-page guide to the Advanced Scheduler (on page 52).
6. Click Save as Template.
   You see a list of templates you can assign these new settings to.
7. To update an existing meeting template with your changes, select the template you want to change and click Save.
   A message box appears, asking if you want to replace the template you have selected with the edited template.
8. To save your changes in the template, click OK.
Chapter 4: Scheduling a Meeting

Using an existing meeting template and saving the changes in a new template

You may host a meeting series with the same agenda, but different attendees. To save time, you can reuse the settings in a template, make changes (such as adding or removing attendees) and then save the updates in a new template.

Find the existing meeting template with similar settings. You can save the changes in a new template.

1. Log in to your Meeting Center Web site.
2. On the navigation bar, expand Host a meeting to view a list of links.
3. Click Schedule a meeting.
   The meeting scheduler appears.
4. Select the template you want to use in the Set options using template drop-down list.
5. Make changes to the details on any page.
   For example, you can add or remove attendees, change the meeting time, add a multimedia document to display before the meeting starts. For details about fields on each page, see Page-by-page guide to the Advanced Scheduler (on page 52).
6. Click Save as Template.
7. In the Template Name box, type a name for this new template.
Setting up a recurring meeting

For a meeting that occurs on a regular basis, such as a monthly company meeting or weekly status meeting, you can set up a recurring meeting. You set up the meeting one time and include the email addresses of attendees, the teleconferencing details, the time and interval (for instance, daily, weekly, or monthly). You send out one invitation for the entire series.

To set up a recurring meeting:
1. Log in to your Meeting Center Web site.
2. On the navigation bar, expand Host a meeting to view a list of links.
3. Click Schedule a meeting.
   The Schedule a meeting Wizard appears, showing the Required Information page.
4. Click Date & Time.
   Set the date and time for the meeting. Review the information below about the options for a recurring meeting.
5. Add other details about your recurring meeting. For details information about the other pages in the Advanced Scheduler, see Page-by-page guide to the Advanced Scheduler (on page 52).
6. When you have finished scheduling your meeting, click Schedule or Start.

Click Save.
Chapter 4: Scheduling a Meeting

Options for setting up a recurring meeting

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Daily</strong></td>
<td>Repeats the meeting every day until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Every [x] days</strong>: Repeats the meeting after the specified number of days pass.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Every weekday</strong>: Repeats the meeting each day, from Monday to Friday.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Weekly</strong>: Repeats the meeting every week until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Sunday - Saturday</strong>: Specifies the day on which the meeting repeats every week. You can select one or more days.</td>
</tr>
<tr>
<td><strong>Monthly</strong></td>
<td>Repeats the meeting every month until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Day [x] of every [x] months</strong>: Specifies the specific day of the month on which to repeat the meeting, and the number of months that pass before the meeting repeats.</td>
</tr>
<tr>
<td></td>
<td>- <strong>[x] [x] of every [x] months</strong>: Specifies the specific week and day of the week on which to repeat the meeting, and the number of months that pass before the meeting repeats.</td>
</tr>
<tr>
<td><strong>Yearly</strong></td>
<td>Repeats the meeting every year until the ending date that you select.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Every [month] [date]</strong>: Specifies the specific month and date on which to repeat the meeting each year.</td>
</tr>
<tr>
<td></td>
<td>- <strong>[x] [day] of [month]</strong>: Specifies the specific week, day of the week, and month on which to repeat the meeting each year.</td>
</tr>
<tr>
<td><strong>Ending</strong></td>
<td>No end date: Repeats the meeting indefinitely. That is, the meeting recurs until you cancel it.</td>
</tr>
<tr>
<td></td>
<td>- Ending: Specifies the last day on which the meeting recurs. You can select the month, day, and year in the drop-down lists. Or, you can click Calendar icon, and then select a date.</td>
</tr>
<tr>
<td></td>
<td>After [x] meetings: Specifies the number in the meeting series after which the meeting stops recurring.</td>
</tr>
</tbody>
</table>

Allowing another user to schedule meetings for you

You can grant permission to one or more Meeting Center users to schedule meetings on your behalf. A user to whom you grant permission to schedule meetings must have an account on your Meeting Center Web site.
Once a user schedules a meeting for you, the meeting appears in your list of meetings on your My Meetings page. You can then start the meeting and host it as you normally do when you schedule meetings yourself.

To allow another user to schedule meetings for you:

1. Log in to your Meeting Center Web site.
2. On the navigation bar, click My WebEx.
3. Click My Profile.
   
   The My Profile page appears.
4. Under Session Options, do either or both of the following:
   
   - In the Scheduling permission box, type the email addresses of the users to whom you want to grant scheduling permission. Separate multiple addresses with either a comma or semicolon.
   - Click Select From Host List to select users from a list of all users who have accounts on your Meeting Center Web site.
5. Click Update.

About the Meeting Scheduled page (for meeting hosts)

This confirmation page appears after you have scheduled a meeting successfully.

What you can do on this page

- Add this meeting to your meeting calendar (MS Outlook or Lotus Notes)
- Edit the details about the meeting you have just scheduled

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to My Calendar</td>
<td>Add this meeting to your calendar program (MS Outlook or Lotus Notes only).</td>
</tr>
<tr>
<td>Edit</td>
<td>Make changes to the meeting you have just scheduled. For example, you can change the day and time or invite additional attendees</td>
</tr>
</tbody>
</table>
About the Meeting Information page (for meeting hosts)

This page provides the details about a meeting you have scheduled.

What you can do on this page

- Review the date, time, duration, and other helpful information about the meeting
- Edit the details about the meeting you have just scheduled
- Start the meeting
- Add the meeting to your calendar, if you haven’t already done so

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Now</td>
<td>Start this meeting immediately. Appears only if the meeting is not yet in progress.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the details about this meeting. For example, you can add attendees, change the agenda, change the date, time, and duration.</td>
</tr>
<tr>
<td>Delete</td>
<td>Cancel this meeting</td>
</tr>
<tr>
<td>Attendees</td>
<td>View the list of registered attendees. Appears only if the meeting requires attendees to register.</td>
</tr>
<tr>
<td>Agenda</td>
<td>Review the meeting agenda. To edit or add an agenda, click Edit and then go to the Edit and Customizable Welcome page.</td>
</tr>
<tr>
<td>Add to My Calendar</td>
<td>Add this meeting to the calendar program, such as Microsoft Outlook. To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
<tr>
<td>Go Back</td>
<td>Return to the meeting calendar</td>
</tr>
</tbody>
</table>
About the Meeting Information page (for attendees)

This page provides the details about a meeting you have scheduled.

What you can do on this page

- Review the date, time, duration, and other helpful information about the meeting
- Add the meeting to your calendar, if you haven’t already done so

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Join Now**         | Join this meeting.  
If this meeting requires you to register, the registration form for this meeting appears.  
Appears only if the host has started this meeting. |
| **Agenda**           | Review the meeting agenda |
| **Add to My Calendar** | Add this meeting to the calendar program, such as Microsoft Outlook.  
To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information. |
| **Go Back**          | Return to the meeting calendar |

About the Meeting Updated page

This confirmation page displays after you have updated a meeting successfully.

What you can do on this page

- Add this meeting to your meeting calendar (MS Outlook or Lotus Notes)
- Make additional changes to the meeting you have just updated
## Chapter 4: Scheduling a Meeting

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update My Calendar</td>
<td>Add this updated meeting to your calendar program (MS Outlook or Lotus Notes only).</td>
</tr>
<tr>
<td>Edit</td>
<td>Make changes to the meeting you have just updated. For example, you can change the day and time or invite additional attendees</td>
</tr>
</tbody>
</table>
Chapter 5

Scheduling a Personal Conference Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule a Personal Conference meeting</td>
<td>Setting up a Personal Conference meeting (on page 102)</td>
</tr>
<tr>
<td>Make changes to the Personal Conference meeting you have scheduled</td>
<td>Editing a Personal Conference meeting (on page 105)</td>
</tr>
<tr>
<td>Start your Personal Conference meeting</td>
<td>Starting a Personal Conference meeting (on page 102)</td>
</tr>
<tr>
<td>Cancel your Personal meeting</td>
<td>Canceling a Personal Conference meeting (on page 106)</td>
</tr>
</tbody>
</table>

About Personal Conference meetings

A Personal Conference meeting includes an audio portion and an online portion. You start the audio portion first, and as soon as it starts, the online portion is automatically created on your WebEx service site. If you need to share a presentation, document, or application with meeting participants, you can start the online portion of the Personal Conference meeting and the participants can join it while still participating in the audio portion of the Personal Conference meeting.
Chapter 5: Scheduling a Personal Conference Meeting

Setting up a Personal Conference meeting

To set up a Personal Conference meeting:

1. Log in to your Meeting Center website.
2. On the left navigation bar, select Schedule a Meeting.
3. Select Advanced Scheduler.
   The Advanced Scheduler displays.
4. On the Required Information page, for Meeting type, select Personal Conference.
5. Enter the requested information.

   **Note:** You do not need to specify a password for the Personal Conference meeting. By default, the password is the attendee access code in your Personal Conference number account that is specified for this meeting.

   For an overview of this page and the information requested, select the Help button in the upper-right corner of the page.

6. Schedule your meeting now, or add more details.
   - To schedule your meeting with these details, select Schedule Meeting
   - To add more options, select Next or select another page in the scheduler. After you have added the details you need, select Schedule Meeting.

Starting a Personal Conference meeting

Personal Conference meetings do not start automatically at scheduled times. You must start the audio portion of the Personal Conference first, and then you can start the online portion of the Personal Conference.
To start the audio portion of a Personal Conference meeting:

Call the number listed in the confirmation email or on the Personal Conference Meeting Information page.

To start the online portion of a Personal Conference meeting:

1. Click the link in the confirmation email to view the Personal Conference Meeting Information page, or navigate to that page through your Meeting Center service site.

2. In the Personal Conference Meeting Information page, select Start in the upper right-hand corner. This button is only available if the audio portion of the Personal Conference meeting has already started.

To access the Personal Conference Meeting Information page:

1. Log in to your Meeting Center service site.

2. On the navigation bar, select My WebEx.

   The My Meetings page appears, showing a list of any meetings that you have scheduled. Personal Conference meetings are listed as "Personal Conference" in the Type column.

3. In the list of meetings, select the Topic or Display Info link for your Personal Conference meeting.

   The Personal Conference Meeting Information page displays.

4. If necessary, select the More Info link to display all the information about the meeting.

Under Audio conference, look for the valid phone number or numbers for the audio portion of the Personal Conference meeting. You'll also find the meeting number, password, and host key.

### Managing and maintaining your scheduled Personal Conference meetings

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add a scheduled Personal Conference meeting to your calendar</td>
<td>Adding a scheduled Personal Conference meeting to your calendar program (on page 104)</td>
</tr>
<tr>
<td>make changes to a scheduled Personal Conference meeting</td>
<td>Editing a Personal Conference meeting (on page 105)</td>
</tr>
</tbody>
</table>
Chapter 5: Scheduling a Personal Conference Meeting

### Adding a scheduled Personal Conference meeting to your calendar program

Once you schedule a Personal Conference meeting, you can add the Personal Conference meeting to your calendar program, such as Microsoft Outlook. This option is applicable only if your calendar program supports the iCalendar standard, a common format for exchanging calendaring and scheduling information across the Internet.

**To add a scheduled Personal Conference meeting to your calendar**

1. Choose either method:
   - On the Personal Conference Meeting Scheduled page or the Personal Conference Meeting Information page, select **Add to My Calendar**.
   - In the confirmation email message that you receive once you schedule or edit a Personal Conference meeting, click the link to add the Personal Conference meeting to your calendar.

   A Personal Conference meeting item opens in your calendar program.

2. Select the option to accept the Personal Conference meeting request. For example, in Outlook, select **Accept** to add the Personal Conference meeting item to your calendar.

**Note:**

- If you cancel a Personal Conference meeting, the Personal Conference Meeting Deleted confirmation page and the confirmation email message that you receive contains an option that lets you remove the Personal Conference meeting from your calendar program.
- If you invite participants to a Personal Conference meeting, the invitation email message that they receive contains an option to add the Personal Conference meeting to their calendar programs.
Editing a Personal Conference meeting

Once you schedule a Personal Conference meeting, you can make changes to it at any time before you start it—including its starting time, topic, agenda, attendee list, and so on.

If you update any information about the Personal Conference meeting, including adding or removing attendees, you can choose to send attendees a new invitation email message containing the new details about the Personal Conference meeting. Attendees removed from the attendee list receive an email message letting them know that they are no longer asked to attend.

If you are logged in, you can edit the Personal Conference meeting details by clicking the link in the confirmation email message that you received after you scheduled the Personal Conference meeting or from your list of meetings in My WebEx.

To edit Personal Conference a meeting from the confirmation email message:

1. Open your confirmation email message, and then click the link to view your Personal Conference meeting information.
   The Personal Conference Meeting Information page appears.
2. Select Edit.
3. Make changes to the Personal Conference meeting details.
   For details about the information requested on any page, click the Help button in the upper-right corner of the page.
4. To save your changes to the meeting, select Save.
   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.
5. If a message box appears, click the appropriate update option, and then select OK.
   The Personal Conference Meeting Information page appears.
   You receive a confirmation email message that includes information about the changes that you made to the meeting.
6. Optional. If you added the Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Meeting Updated page, select Add to My Calendar.

To edit a Personal Conference scheduled meeting from your list of meetings on your Meeting Center Web site:

1. Log in to your Meeting Center website.
2 On the navigation bar, select My WebEx.

The My Meetings page appears, showing a list of any meetings that you have scheduled. Personal Conference meetings have "Personal Conference" in the Type column.

3 In the list of meetings, under Topic, click the topic for the meeting, or click the Display Info link.

4 Select Edit.

5 Make changes to the Personal Conference meeting details.

For details about the options on each page, click the Help button in the upper-right corner of the page.

6 Select Save.

If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click OK.

If you select Cancel in the message box, the Personal Conference meeting is not updated.

8 Optional. If you added the Personal Conference meeting to your calendar program, such as Microsoft Outlook, in the confirmation email message, click the Update My Calendar link.

### Canceling a Personal Conference meeting

You can cancel any Personal Conference meeting you have scheduled. Once you cancel a Personal Conference meeting, you can choose to send a cancellation email message to all attendees whom you invited to the meeting. The Personal Conference meeting is removed automatically from your list of meetings in My WebEx.

If you are logged in, you can cancel a Personal Conference meeting from the confirmation email message that you received after you scheduled the meeting or from your list of meetings in My WebEx.

**To cancel a Personal Conference meeting from a confirmation email message:**

1 Open your confirmation email message, and then click the link to view your Personal Conference meeting information.

The Personal Conference Meeting Information page appears.

2 Select Delete.
If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the meeting.

3 In the message box, click Yes or No, as appropriate.

If you click Cancel in the message box, the meeting is not canceled.

The Personal Conference Meeting Deleted page appears.

4 Optional. If you added the Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Meeting Deleted page, click Remove From My Calendar to remove the Personal Conference meeting from your calendar.

To cancel a scheduled Personal Conference meeting from your list of meeting on your Meeting Center website:

1 Log in to your Meeting Center website.

2 On the navigation bar, select My WebEx.

The My Meetings page appears, showing a list of any meetings that you have scheduled. Personal Conference meetings are indicated by the words "Personal Conference" in the Type column.

3 In the list of meetings, under Topic, click the topic for your Personal Conference meeting.

4 Select Delete.

If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the Personal Conference meeting.

5 In the message box, click Yes or No, as appropriate.

If you click Cancel in the message box, the Personal Conference meeting is not canceled.

You receive a cancellation confirmation email message.

6 Optional. If you added the Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Meeting Deleted page, select Remove From My Calendar to remove the meeting from your calendar.

About the Personal Conference Meeting Information page (host)

This page provides the details about the Personal Conference meeting you have scheduled.
What you can do on this page

- Review the date, time, duration, and other helpful information about the Personal Conference meeting.
- Click the **More Info** link to view the meeting number, audio conference information, and meeting password. This information can help you start the audio portion of the Personal Conference meeting.
- Edit the details about the Personal Conference meeting.
- Cancel the Personal Conference meeting.
- Add the Personal Conference meeting to your calendar, if you haven’t already done so.
- Start the online portion of the Personal Conference after the audio portion has started.

<table>
<thead>
<tr>
<th>Select this button…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Edit the details about the Personal Conference meeting. For example, you can add attendees, change the Personal Conference number account for this meeting, or change the date, time, and duration.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Cancel the meeting.</td>
</tr>
<tr>
<td><strong>Add to My Calendar</strong></td>
<td>Add this Personal Conference meeting to a calendar program, such as Microsoft Outlook. To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
<tr>
<td><strong>Go Back</strong></td>
<td>Return to the meeting calendar.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>Start the online portion of the Personal Conference meeting. This button is only available after you have started the audio portion of the Personal Conference meeting.</td>
</tr>
</tbody>
</table>

**About the Personal Conference Meeting Information page (for attendees)**

This page provides the details about this teleconference.
What you can do on this page

- Review the date, time, duration, and other helpful information about the Personal Conference meeting
- Click the More Info link to see the meeting number, audio conference information, and meeting password. This information can help you join the audio portion of the Personal Conference meeting.
- Add the meeting to your calendar, if you haven’t already done so
- Join the online portion of the Personal Conference after the audio portion has started.

Options on this page

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Agenda</td>
<td>View the meeting agenda, if the host has provided it.</td>
</tr>
<tr>
<td>Add to My Calendar</td>
<td>Add this teleconference to a calendar program, such as Microsoft Outlook. To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
<tr>
<td>Go Back</td>
<td>Return to the meeting calendar.</td>
</tr>
<tr>
<td>Join</td>
<td>Once the audio portion of the Personal Conference meeting has started, you can select Join to join the online portion of the Personal Conference meeting.</td>
</tr>
</tbody>
</table>
Assigning Sounds to Participant Actions

Host only

During a meeting, you can assign sounds to play when a participant:

- Joins the meeting
- Leaves the meeting
- Clicks Raise Hand on the Participants panel

To assign sounds to participant actions:

1. Open the Preferences dialog box by performing these steps:
   - Windows: On the Edit menu, choose Preferences.
   - Mac: On the Meeting Center menu, choose Preferences.

2. Depending on your operating system, follow one of these steps:
   - Windows: Click the Participants tab.
   - Mac: Select the Alerts button.

3. Select the check box for each action for which you want to play a sound.

4. Select a sound from the appropriate drop-down list.
   
   By default, the drop-down list contains the names of all sound files that reside at the default location on your computer.

5. To select a sound that does not appear in the drop-down list, follow one of these steps:
   - Windows: Click Browse, and then select a sound file that resides in another folder.
Chapter 6: Assigning Sounds to Participant Actions

- Mac: Select Other in the drop-down list.

6 Windows only. To play the currently selected sound, click the button 🎵.

7 Click OK.

**Note:**
- Meeting Center saves your sound preferences on your computer. However, if you start or join a meeting on another computer, you need to set your preferences again on that computer.
- If you are using Windows, sound files must have a .wav extension.
- In most cases, the default location for sound files is C:\WINDOWS\Media. You can copy other sound files to the default folder or any other directory to make them available in the Preferences dialog box.
Once a meeting starts, all participants are automatically granted meeting privileges either by host specification or by default:

- If the host scheduled the meeting and specified privileges, participants receive those privileges.
- If the host scheduled the meeting but did not specify privileges, participants receive default privileges.
- If the host started an instant meeting, participants receive default privileges.

The following table describes the privileges a host can grant and those that are granted by default. For detailed information on a particular set of privileges, click More by the privilege description.
A host can grant the following privileges to one or more participants:

- **Chat** - who a participant can chat with and whether that chat can be private. *More…* (on page 115)
- **Document** - whether a participant can draw on a document or save or print it. *More…* (on page 116)
- **View** - what a participant can view in the meeting: participant list, document, thumbnails, or pages. *More…* (on page 117)
- **Meeting** - whether a participant can record the meeting, share documents, or control sharing. *More…* (on page 118)

### Selecting participants

During a meeting, you can grant privileges to or remove them from all participants at once or to an individual participant.

To choose

- **all participants** - select All Participants.
- **an individual participant** - expand All Participants, and select the participant name.

For instructions on granting privileges to participants, see *Granting privileges* (on page 115).
Chapter 7: Granting Privileges During a Meeting

About Default privileges
If the host does not specify privileges when scheduling a meeting, or starts an instant meeting, a set of default privileges are automatically assigned to a participant:

- all chat privileges More... (on page 115)
- viewing the participant list More... (on page 117)
- controlling shared applications, web browser, or desktop remotely More... (on page 118)

Granting or removing privileges
To grant participant privileges during a meeting:

1. In the Meeting window, on the Participant menu, choose Assign Privileges.
   The Participants Privileges dialog box appears.
2. Grant or remove a privileges, as follows:
   - To grant a specific privilege, check its box.
   - To grant all privileges, check the Assign all privileges check box.
   - To remove a privilege, clear its check box.
   - To reset to the preset meeting privileges, select Reset to Meeting Defaults.
3. Select Assign.

Granting or removing Chat privileges
As host, you can grant or remove chat privileges for one or more participants.
To grant or remove a chat privilege:

You can chat with participants privately or publicly.
Select or clear the checkbox for each privilege you want to grant.

Chat privileges:

- **Host** - chat privately with the meeting host. Your chat message appears in only the host's Chat viewer.
- **Presenter** - chat privately with the presenter. Your chat message appears in only the presenter's Chat viewer.
- **Other participants** - chat privately with another participant. Your chat message appears in only that participant's Chat viewer.
- **Everyone** - Chat publicly with all participants. Your chat message appears in everyone's Chat viewer.
- **Contact operator privately** - Available only if your site includes the private operator option. Participants dial 00 at any time during a teleconference to contact the operator of the teleconferencing service.

**Granting or removing document privileges**

As host, you can assign privileges for saving, printing, and annotating documents, whiteboards, and presentations that are shared in the content viewer.
Chapter 7: Granting Privileges During a Meeting

To grant or remove a document privilege:

A participant uses the Annotation toolbar that appears whenever a document is being shared to
- draw on shared elements
- point to items on shared elements.

Granting or removing viewing privileges

To grant or remove a viewing privilege:

Viewing privileges you can grant to participants:
- **Participant list**-view the names of all other participants on the Participants panel. If this option is not selected, participants can view the names of only the meeting host and the presenter on the Participants panel.
- **Thumbnails**-display miniatures, or thumbnails, of any pages, slides, or whiteboards in the center viewer. This privilege allows participants to view miniatures at any time, regardless of the content that appears in the presenter's
content viewer. If participants have this privilege, they can display any page at full size in the content viewer, regardless of whether they also have the Any page privilege.

- **Any page** - view any pages, slides, or whiteboards that appear in the content viewer. This privilege allows participants to navigate independently through pages, slides, or whiteboards.
- **Any document** - view any document, presentation, or whiteboard that appears in the content viewer, and navigate to any pages or slides in documents or presentations.

### Granting or removing meeting privileges

**To grant or remove a viewing privilege:**

![Select or clear the checkbox for each privilege you want to grant](image)

**Document privileges you can grant:**

- **Share documents** - share documents, presentations, and whiteboards, and copy and paste any pages, slides, and whiteboards in the content viewer. Participants can share UCF rich media presentations or files only if the host selected the option to enable UCF rich media for participants when scheduling the meeting.
- **Control shared applications, Web browser, or desktop remotely** - request remote control of a shared application, Web browser, or desktop. If this privilege is cleared, the command to request remote control is unavailable to participants.
- **Record a meeting** - record all interactions during a meeting and play them back at any time.
Using WebEx Audio

In a WebEx audio conference, you can use either your telephone or your computer as your audio connection in a meeting:

If you are a host, you can invite up to 500 people to participate in the audio conference. Participants can choose how they want to connect to the audio conference.

- **Telephone**—you can use your telephone to receive a call to the audio conference or to dial in.
- **Computer**—you can use a headset connected to your computer if the computer has a supported sound card and a connection to the Internet.

After joining the conference, participants can switch between audio modes with little or no listening interruption. In a mixed-mode conference, where some participants are using the telephone and others are using the computer, up to 125 people can speak.

Your role in an audio conference determines your level of participation. Whichever role you take, the following table describes the basic tasks you can accomplish in that role. For detailed instructions on a particular task, click "More" by the task description.
### Joining or leaving an audio conference

Once you start or join a meeting that uses WebEx Audio, the Audio Conference dialog box appears automatically on your screen.

What device do you want to use for speaking and listening in the meeting?

- **your phone**: typically provides good voice transmission, but may have a cost attached.

---

<table>
<thead>
<tr>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Call using phone</strong></td>
</tr>
<tr>
<td><img src="image" alt="Audio Conference dialog box using phone" /></td>
</tr>
<tr>
<td>You are participating in this audio conference using your phone.</td>
</tr>
<tr>
<td><img src="image" alt="Use Computer for Audio button" /></td>
</tr>
<tr>
<td><strong>Call using computer</strong></td>
</tr>
<tr>
<td><img src="image" alt="Audio Conference dialog box using computer" /></td>
</tr>
<tr>
<td>You are participating in this audio conference using your computer.</td>
</tr>
<tr>
<td><img src="image" alt="Use Computer for Audio button" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Host an audio conference:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>- join or leave the audio conference [More](on page 120)</td>
</tr>
<tr>
<td>- invite additional people to join [More](on page 123)</td>
</tr>
<tr>
<td>- switch audio connection modes [More](on page 122)</td>
</tr>
<tr>
<td>- mute or unmute one or more microphones [More](on page 124)</td>
</tr>
<tr>
<td>- use caller authentication to join the conference [More](on page 127)</td>
</tr>
<tr>
<td>- Edit or update phone numbers in your user profile [More](on page 129)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Participate in an audio conference:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>- join or leave the audio conference [More](on page 120)</td>
</tr>
<tr>
<td>- switch audio connection modes [More](on page 122)</td>
</tr>
<tr>
<td>- ask to speak [More](on page 126)</td>
</tr>
<tr>
<td>- mute or unmute your microphone [More](on page 124)</td>
</tr>
<tr>
<td>- use caller authentication to join the conference [More](on page 127)</td>
</tr>
<tr>
<td>- edit or update phone numbers in your user profile [More](on page 129)</td>
</tr>
</tbody>
</table>

**Note:** If you set up another type of audio conference—such as that of a third-party service—you must manage the conference using the options that service provides.
- your computer (with a headset, and an Internet connection): Sometimes causes noisy transmission, or an irregular voice stream, but has no cost attached.

You can select your preferred device from the Audio Conference dialog box that appears automatically after you start or join a meeting:

1. Use Phone: Follow the directions to call in to the meeting.
2. Use Computer for Audio: Select the arrow, then choose Call using Computer. More (on page 121)

At any time during the meeting, you can switch your audio device (on page 122).

About Using your computer for audio

After you join a meeting, the Audio Conference dialog box appears automatically. When you use your computer to speak and listen in a meeting, your computer sends and receives sound across the Internet. To do this, your computer must have a supported sound card and be connected to the Internet.

Note: For purposes of audio quality and convenience, use a computer headset with a high-quality microphone rather than speakers and a microphone.

To use your computer for audio:

1. Select the arrow.
2. Select Call Using Computer.

Note: If this is your first time connecting to a meeting with your computer, a wizard appears to fine tune your sound settings (on page 122).
Chapter 8: Using WebEx Audio

After you are connected to your meeting, you can

1) mute or unmute your speaker or microphone
2) change the volume on your speaker or microphone

At any time during the meeting, you can *switch your audio device* (on page 122).

**Fine tuning your microphone and speaker settings**

The audio wizard walks you through selecting your sound device, and setting your speaker volume and microphone level.

When you first start or join a meeting, you can manually open the wizard to test and adjust your sound device *before* you actually start using your computer for audio.

**To open the wizard and adjust your sound settings:**

1. From the meeting window menu, select **Audio > Computer Setup for Audio**.
2. Follow the wizard instructions.

**Switching audio devices during a meeting**

You can easily switch from one audio device to another during a meeting with little disruption.
To switch from your computer connection to a phone connection:

1) Open the Audio Conference dialog box from the Quick Start page, your Participants panel, or the Audio menu.
2) Call the number in the Use Phone area and enter the access code and attendee ID, as directed by the automated operator.

After you are connected by phone, your computer connection is dropped automatically.

To switch from your phone connection to a computer connection:

1) Open the Audio Conference dialog box from the Quick Start page, your Participants panel, or the Audio menu.
2) Select the down arrow beside Use Computer for Audio.
3) Select Switch to Using Computer.

Your telephone connection is dropped after your computer connection is established.
(Remember to switch to your computer headset.)

For more information

Fine tuning your microphone and speaker settings............................. 122

Inviting a contact to join by phone

Host only

You can invite a contact to join the audio conference by phone. If the invitee accepts the invitation, he or she is placed into the audio conference.
To invite a contact by phone to the meeting audio conference:

Do either of the following:

- On the Participant menu, choose Invite > By Phone.
- At the bottom of the Participants panel, click the Invite drop-down list and choose Invite By Phone.

The Invite By Phone dialog box appears.

Enter the invitee name and phone number, including country and area code, and click Call:

- The audio conferencing service calls the invitee. When the connection is made, the Status display changes from Ready to Connected.
- The Conference button appears and becomes available on the Invite By Phone dialog box, allowing you to invite another participant.

Muting and unmuting microphones in an audio conference

The following table illustrates how to quickly mute and unmute microphones in your meeting depending on your user role.
# Chapter 8: Using WebEx Audio

## Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td><strong>Windows:</strong> Right click in the Participants panel&lt;br&gt; <strong>Mute on Entry</strong> to mute all microphones automatically when participants join a meeting&lt;br&gt; <strong>Mute or Unmute</strong> to mute or unmute your own or a specific participant’s microphone&lt;br&gt; <strong>Mute All</strong> to mute or unmute all participant microphones simultaneously at any time during a meeting More (on page 126)</td>
</tr>
<tr>
<td>Participant</td>
<td><strong>Mac:</strong> Ctrl + click in the Participants panel&lt;br&gt;Select the <strong>Mute or Unmute</strong> icon to mute or unmute your own microphone.</td>
</tr>
</tbody>
</table>
Chapter 8: Using WebEx Audio

The microphone icon to the right changes state.

**Muting and unmuting all participant microphones simultaneously**

*Host and presenter only*

You can mute or unmute all participant microphones simultaneously. This option does not affect the host's and presenter's microphones.

To mute or unmute all participants:

- **Windows**: Right click on the participants panel
- **Mac**: Ctrl + click on the participants panel

Select **Mute All** or **Unmute All**.

The microphone icon to the right of each participant's name changes state.

**Asking to speak in an audio conference**

*Participant*

If the host has muted your microphone during an audio conference, you can ask the host to unmute your microphone so that you can speak. You can cancel a request to speak at any time.

<table>
<thead>
<tr>
<th>To ask to speak</th>
<th>Windows</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Raise Hand</strong> on the Participants panel</td>
<td><img src="image" alt="Raise Hand" /></td>
<td>The <strong>Raised Hand</strong> indicator appears on the Participants panel for the host and presenter.</td>
</tr>
</tbody>
</table>
To cancel a request to speak

<table>
<thead>
<tr>
<th>Windows</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Lower Hand</strong> on the Participants panel</td>
<td>The <strong>Raised Hand</strong> indicator is removed from the Participants panel for the host and presenter.</td>
</tr>
</tbody>
</table>

To ask to speak

<table>
<thead>
<tr>
<th>Mac</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the <strong>Raise Hand</strong> icon at the bottom of the Participants panel</td>
<td>The <strong>Raised Hand</strong> indicator appears on the Participants panel for the host and presenter.</td>
</tr>
</tbody>
</table>

To cancel a request to speak

<table>
<thead>
<tr>
<th>Mac</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the <strong>Lower Hand</strong> icon at the bottom of the Participants panel</td>
<td>The <strong>Raised Hand</strong> indicator is removed from the Participants panel for the host and presenter.</td>
</tr>
</tbody>
</table>

Using caller authentication to start or join an audio conference

*Host accounts only*

CLI (caller line identification), or ANI (automatic number identification), is a form of caller ID, a telephony intelligent service that transmits a caller's telephone number before the call is answered. Any dial-in caller with a host site account can be authenticated and placed into the correct audio conference without needing to enter a meeting number.

If you have a host account, and your site is enabled for ANI/CLI, you can:

- schedule a meeting with dial-in ANI/CLI teleconferencing authentication.
- be authenticated whenever you dial into any ANI/CLI enabled audio conference to which you have been invited by email. Call-in authentication is established by mapping your email address to a phone number in your user profile.
- specify a call-in authentication PIN to prevent "spoofers" from using your number to dial into an audio conference

**To schedule an audio conference with ANI/CLI authentication:**

1. Log in to your Meeting Center Web site.
2 On the navigation bar, under **Host a Meeting**, click **Schedule a Meeting**. The Schedule a Meeting page appears.

3 Click **Change audio options**. The Audio Options dialog box appears.

4 Select the **Enable audio conference CLI authentication when participants call in** checkbox if it is not already selected.

**Note:** Caller authentication will only be available to participants if they are invited to a CLI/ANI enabled audio conference by email during the meeting scheduling process. Any participant invited to the audio conference once it has begun cannot use caller authentication.

**Specifying call-in authentication for your host account**

If you have a host account, and your site is enabled for call-in authentication, you can set authentication for any phone number listed in your user profile. Your call will be authenticated by mapping your email address against specified phone numbers in your profile whenever you dial into a CLI (caller line identification), or ANI (automatic number identification) enabled audio conference to which you have been invited by email.

**Note:** Caller authentication will only be available if you have been invited to a CLI/ANI (automatic number identification) enabled audio conference by email during the meeting scheduling process. Caller authentication will not be available if you are dialing in to a CLI/ANI enabled audio conference:

- from an invitation other than email.
- from an email invitation originated during the meeting.

To specify call-in authentication for your host account:

1 Log in to your Meeting Center Web site.

2 On the navigation bar, click **My WebEx**.

3 Click **My Profile**. The My WebEx Profile page appears.

4 Under **Personal Information**, select the **Call-in authentication** checkbox beside any phone number for which you want dial-in authentication.

5 Click **Update**.
Using an authentication PIN

If you have a host account, and your site is enabled for CLI (caller line identification), or ANI (automatic number identification) audio conferences, you can use an authentication PIN to prevent "spoofers" from using your number to dial into an audio conference.

If your site administrator sets the authentication PIN as mandatory for all accounts using call-in authentication on your site, then you must specify a PIN number or caller authentication will be disabled for your account.

To specify an authentication PIN:
1. Log in to your Meeting Center Web site.
2. On the navigation bar, click My WebEx.
3. Click My Profile.
   The My WebEx Profile page appears.
4. Under Personal Information, in the PIN: text box, enter a 4-digit PIN number of your choosing.
5. Click Update.

Editing or updating your stored phone numbers

You can edit or update the phone numbers listed in your profile if you have not yet joined the audio conference or if you joined the audio conference from your computer. In addition, you can view any phone number cookies stored on your computer.

Any updates you make do not take effect until the next time you join a meeting.

To edit or update your profile:
1. Do either of the following:
   - On the Audio menu, choose Join Audio Conference.
   - At the bottom of the Participants panel, click Audio.
2 Select **Manage phone numbers** from the dropdown box in the lower pane. The Manage phone numbers dialog box appears.

3 Click **Edit** to update the phone numbers in your My WebEx profile, or **Clear** to delete phone numbers that are stored in cookies on your computer.

**Note:** You cannot be participating in an audio conference by phone if you want to edit or update your phone numbers.
Chapter 9

Using Integrated Voice Conferences

An Integrated Voice Conference allows participants to speak to each other using voice over Internet Protocol (VoIP)-an Internet-based way of connecting through the computer. Integrated voice conferences are useful if:

- Participants are located a great distance away and do not want to incur long distance phone charges
- The meeting is a presentation rather than a discussion and does not involve interaction among participants

Your user role in an Integrated Voice conference determines your level of participation. Whichever role you take, the following table describes the basic tasks associated with that role. For detailed instructions on a particular task, click “More” by a task description.

### Task description:

**Host**

Start and manage a voice conference:

- fine tune your microphone and speaker settings [More](on page 136)
- Allow a participant to speak [More](on page 133)
- mute or unmute participant microphones [More](on page 124)

**To start a voice conference:**

- Select Voice Conference on the Quick Start page
- or, select Integrated Voice Conference > Start Conference from the Audio menu.

**To end a voice conference:**

Select Integrated Voice Conference > End Conference from the Audio menu.
Chapter 9: Using Integrated Voice Conferences

**Task description:**

<table>
<thead>
<tr>
<th>Participant</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Participate in a voice conference:</td>
</tr>
<tr>
<td></td>
<td>▪ Join or leave a conference More…</td>
</tr>
<tr>
<td></td>
<td>▪ Mute or unmute your microphone More…</td>
</tr>
<tr>
<td></td>
<td>▪ Ask to speak More…</td>
</tr>
</tbody>
</table>

**To join a voice conference:**

- Select Yes in the dialog box that automatically appears when the host starts the conference.
- or, select Integrated Voice Conference > Join Conference from the Audio menu.

**To leave a voice conference:**

Select Integrated Voice Conference > Leave Conference from the Audio menu.

**Note:** For better audio quality and greater convenience, use a computer headset with a high-quality microphone, rather than speakers and a microphone.

---

**Asking to speak**

**Participant only**

During a voice conference, you can indicate that you want to speak. If you do request to speak, you can cancel the request at any time. Speaking in an Integrated VoIP conference

**To request to speak, or to cancel a request to speak:**

On the Participants panel, click **Raise Hand** or **Lower Hand**, respectively.

- If you ask to speak, the raised-hand indicator appears on the Participant panel for the host and presenter.
- If you cancel a request to speak, the raised-hand indicator is removed from the Participant panel for the host and presenter.
Chapter 9: Using Integrated Voice Conferences

Allowing a participant to speak

*Host only*

Once you start a voice conference, participants can join the conference and listen to the meeting audio. Up to seven participants can speak at a time.

You can specify which participants can speak, by passing the microphone.

To allow a participant to speak in a voice conference:

1. On the Participants panel, select the name of the participant whom you want to allow to speak.
2. At the bottom of the panel, select Pass Mic.

An indicator appears near the participant's name on the panel.

The participant can now speak until you either pass the microphone to another participant or mute the participant's microphone.

**Note:** A request to speak can be made at any time during a meeting, by clicking *Raise Hand* on the Participants panel.

---

Speaking in a voice conference

If you are a current speaker, the method by which you speak depends on the speaker setup option that is currently selected for your meeting:

- **Desktop speakers (default):** If this option is selected, the following appears in the bottom-right corner of your Meeting window:

  ![Press Ctrl to speak](image)

  Press the Ctrl key on your keyboard while speaking. Pressing this key mutes your speakers, thereby preventing your voice from echoing in the conference.

- **Headset:** If this option is selected, the following appears in the bottom-right corner of your Meeting window:
Simply speak into your microphone.

**Tip:** Before you join a voice conference, you can use the audio setup wizard to select your audio device and adjust its settings. *More* (on page 136)

## Muting and unmuting microphones in an audio conference

The following table illustrates how to quickly mute and unmute microphones in your meeting depending on your user role.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td><strong>Windows:</strong> Right click in the Participants panel</td>
</tr>
<tr>
<td></td>
<td>- <strong>Mute on Entry</strong> to mute all microphones automatically when participants join a meeting</td>
</tr>
<tr>
<td></td>
<td>- <strong>Mute</strong> or <strong>Unmute</strong> to mute or unmute your own or a specific participant's microphone</td>
</tr>
<tr>
<td></td>
<td>- <strong>Mute All</strong> to mute or unmute all participant microphones simultaneously at any time during a meeting <em>More</em> (on page 126)</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Host Mute/Unmute screenshot" /></td>
</tr>
<tr>
<td>Participant</td>
<td><strong>Mac:</strong> Ctrl + click in the Participants panel</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Mute</strong> or <strong>Unmute</strong> icon to mute or unmute your own microphone.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Participant Mute/Unmute screenshot" /></td>
</tr>
</tbody>
</table>

The microphone icon to the right changes state.
Chapter 9: Using Integrated Voice Conferences

Muting and unmuting all participant microphones simultaneously

*Host and presenter only*

You can mute or unmute all participant microphones simultaneously. This option does not affect the host's and presenter's microphones.

![Image of microphone settings]

**To mute or unmute all participants:**
- *Windows:* Right click on the participants panel
- *Mac:* Ctrl + click on the participants panel

Select *Mute All* or *Unmute All*.

The microphone icon to the right of each participant's name changes state.

Understanding the speaker queue for a voice conference

During an Integrated Voice conference, a participant can request to speak.

After a participant requests to speak, the participant's place in the speaker queue is indicated by a number to the right of the Integrated Voice indicator.

The speaker queue lets you keep track of the order in which participants have requested to speak. To let a participant speak, you can pass the microphone to the participant. *More* (on page 133)

Once you pass the microphone to a participant, the speaker queue renumbers the remaining participants. For example, speaker 2 in the queue becomes speaker 1.
Fine tuning your microphone and speaker settings

The first time you use an integrated voice conference, the audio wizard walks you through selecting your sound device, and setting your speaker volume and microphone level.

Any time before you start or join a meeting, you can manually open the wizard to test your device again, or make further adjustments, as necessary.

To open the wizard and adjust your sound settings:

1. From the meeting window menu, select Audio > Computer Setup for Audio.
2. Follow the wizard instructions.
Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of starting a One-Click Meeting from your WebEx service Web site</td>
<td>About setting up a One-Click Meeting (on page 137)</td>
</tr>
<tr>
<td>specify settings for your One-Click Meeting</td>
<td>Setting up your One-Click Meeting on the Web (on page 138)</td>
</tr>
<tr>
<td>install WebEx One-Click, which includes the One-Click panel and One-Click shortcuts</td>
<td>Installing WebEx Productivity Tools (on page 142)</td>
</tr>
<tr>
<td>start a One-Click Meeting from your WebEx service Web site</td>
<td>Starting a One-Click Meeting (on page 143)</td>
</tr>
<tr>
<td>remove WebEx One-Click, including all One-Click shortcuts, from your computer</td>
<td>Removing WebEx Productivity Tools (on page 147)</td>
</tr>
</tbody>
</table>

About setting up a One-Click Meeting

WebEx One-Click allows you to start a meeting instantly from your desktop (desktop version) and from your WebEx service Web site (Web version). You can set up one or both versions, depending on your needs:

- **Web version**: allows you to start a One-Click Meeting from your WebEx service Web site. Doing so does not require you to download any application. For more information about the web version, refer to the *WebEx One-Click User’s Guide*, which is available on the Support page of your WebEx Service web site.
Chapter 10: Setting Up a One-Click Meeting

- **Desktop version:** if this feature and the Productivity Tools feature are enabled by your site administrator, allows you to start and join meetings and send meeting invitations without logging in to your WebEx service site or navigating Web pages. For more information about the desktop version, refer to the *WebEx One-Click User's Guide*.

Setting up your One-Click Meeting on the Web

The One-Click Meeting Setup page allows you to specify options a One-Click Meeting. You can return to the One-Click Meeting Setup page at any time to modify your meeting.

The settings you specify apply to both the One-Click Web version and the desktop version.

**To set up your One-Click Meeting:**

1. Log in to your WebEx Service Web site.
2. Click **My WebEx > Productivity Tools Setup** (on the left navigation bar).
   
   The Productivity Tools Setup page appears.
   
   On this screen, you can also download WebEx Productivity Tools, which include the desktop version of One-Click and its shortcuts. For details, see *Installing WebEx Productivity Tools* (on page 142).
3. Click **Set Up Now**.
   
   The One-Click Setup page appears.
4. Specify the meeting information and settings on the page.
   
   For details about the options on the One-Click Settings page, see *About the One-Click Settings page* (on page 138).
5. Click **Save**.

**Tip:** Whenever you want to edit options for your One-Click Meeting, return to the One-Click Settings page by clicking **My WebEx > Productivity Tools Setup > Edit Settings**.

About the One-Click Settings page

**How to access this page:**

On your WebEx service Web site, do one of the following:
Chapter 10: Setting Up a One-Click Meeting

- If you are setting up your One-Click Meeting for the first time, on your WebEx service Web site, click My WebEx > Productivity Tools Setup (on the left navigation bar) > Set Up Now.

- If you already set up your One-Click Meeting, on your WebEx service Web site, click My WebEx > Productivity Tools Setup (on the left navigation bar) > Edit Settings.

What you can do here:
Set options for your One-Click Meeting

Meeting Options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service type</td>
<td>Select the type of WebEx session for which you want to start a One-Click Meeting. This option lists only the session types available for your site and user account.</td>
</tr>
<tr>
<td>Meeting template</td>
<td>Select the meeting template you want to use to set options for your One-Click Meeting. The drop-down list of templates includes: <strong>Standard templates</strong>: Templates that your site administrator set up for your account. <strong>My Templates</strong>: Any personal templates that you created by saving the settings for a meeting you previously scheduled, using the scheduling options on your site.</td>
</tr>
<tr>
<td>Topic</td>
<td>Specify the topic for the meeting</td>
</tr>
<tr>
<td>Meeting password</td>
<td>Specify the password for the meeting.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Type the password again to prevent typing errors.</td>
</tr>
<tr>
<td>Listed on calendar</td>
<td>Specify that the meeting appears on the calendar on your site. Available for meetings and sales meetings only.</td>
</tr>
<tr>
<td>CUVC Meeting ID</td>
<td>(CUVC Integration to Meeting Center only) Enter a custom URL to create a virtual meeting room in which you can use Cisco Unified Video (CUVC) in your meeting. If you leave this box empty, the WebEx Meeting ID is used by default. When you start your WebEx meeting, the CUVC Video panel displays automatically.</td>
</tr>
</tbody>
</table>
### Tracking Codes

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracking code</td>
<td>Identify your department, project, or other information that your organization wants to associate with your meetings. Tracking codes can be optional or required, depending on how your site administrator set them up. If your site administrator requires you to select a code from a predefined list, click the link <strong>Select Code</strong>, and then select a code from the list or enter one in the box above.</td>
</tr>
</tbody>
</table>

#### Audio Conference

*meetings, training sessions, and sales meetings only*

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use</td>
<td>Select the type of teleconference you would like to use:</td>
</tr>
</tbody>
</table>
## Use this option... To...

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WebEx Audio:</strong></td>
<td>Specifies that the meeting includes an integrated audio conference. If you select this option, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Display toll-free number:</strong> Select if your site provides toll-free call-in audio conferencing, in which both a toll-free number and a toll number are available. If your participants dial a toll-free call-in number, your organization assumes the charges for the calls. Otherwise, participants assume the charges for their calls.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Display global call-in numbers to attendees:</strong> Select if you want to provide a list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the audio conference. Note: After you start the meeting, participants have a choice of joining by can choose to use their computer as their audio device, using VoIP, or to use their phone as their audio device.</td>
</tr>
<tr>
<td><strong>Tip:</strong> A participant must have a direct phone line to receive a call from the teleconferencing service. However, a participant without a direct phone line can join an audio conference by calling a call-in telephone number, which is always available in the Meeting window.</td>
<td></td>
</tr>
<tr>
<td><strong>Personal Conference Number Account</strong></td>
<td>Available only if your site has the Personal Conference number (PCN) option.</td>
</tr>
<tr>
<td></td>
<td>Select the PCN account that you want to use for your meeting.</td>
</tr>
<tr>
<td></td>
<td>For more information about PCN, see the My WebEx section in the documentation for your service.</td>
</tr>
<tr>
<td><strong>Other teleconference service:</strong></td>
<td>Specifies that the meeting includes a teleconference that another service provides, such as a third-party teleconferencing service or internal teleconferencing system, such as a PBX (private branch exchange).</td>
</tr>
<tr>
<td></td>
<td>In the text box, type instructions for joining the teleconference.</td>
</tr>
<tr>
<td><strong>Use VoIP Only</strong></td>
<td>Specify that the meeting includes only Integrated VoIP, which allows meeting participants to use computers with audio capability to communicate over the Internet rather</td>
</tr>
</tbody>
</table>
### Use this option... | To...
---|---
| than the telephone system. | None
| Specify that the meeting does not include either an audio conference or Integrated VoIP.

## Installing WebEx Productivity Tools

If your site administrator has enabled you to download WebEx Productivity Tools, you can start you can start or join meetings instantly using One-Click; start meetings instantly from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers; and schedule meetings using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

Before installing WebEx Productivity Tools, ensure that your computer meets the following minimum system requirements:

- Microsoft Windows 2000, XP, 2003, Vista
- Microsoft Internet Explorer 6.0 SP1 or 7.0, or Firefox 3.0 or later
- Intel x86 (Pentium 400MHZ +) or compatible processor
- JavaScript and cookies enabled in the browser

**To install WebEx Productivity Tools:**

1. Log in to your WebEx service Web site.
2. Click **My WebEx > Productivity Tools Setup** (on the left navigation bar).
   
   The Productivity Tools Setup page appears.
3. Click **Install Productivity Tools**.
   
   The File Download dialog box appears.
4. Save the installation program to your computer.
   
   The name of the installation file has an `.msi` extension.
5. Run the installation file and follow the instructions.
6. Once you complete installation, log in using your WebEx account information and then verify your WebEx settings for Productivity Tools, including One-Click, in the WebEx Settings dialog box.
Chapter 10: Setting Up a One-Click Meeting

Note: System administrators can also perform a mass installation for computers at their site. For more information, see the IT Administrator Guide for Mass Deployment of WebEx Productivity Tools at http://support.webex.com/US/PT/wx_pt_ag.pdf.

After you have logged in, the WebEx One-Click panel and shortcuts appear. For instructions about using the One-Click panel and shortcuts, see the WebEx One-Click User's Guide.

The Help in the WebEx One-Click panel also provides detailed information about how to use the One-Click panel and shortcuts.

Starting a One-Click Meeting

Before you start a One-Click Meeting from your WebEx Service Web site, ensure that you set up One-Click settings. For details about setting up One-Click settings, see Setting up your One-Click Meeting on the Web (on page 138). For details

To start a One-Click Meeting from your WebEx service Web site:

1. Log in to your WebEx Service Web site.
2. Click My WebEx > Start One-Click Meeting.
Chapter 10: Setting Up a One-Click Meeting

Your meeting starts.

If your site includes Meeting Center, you can also start a One-Click Meeting from this specific service.

To start a One-Click Meeting from the Meeting Center service:

1. Log in to your WebEx service Web site, and click Meeting Center.
2. On the left navigation bar, click Host a Meeting > One-Click Meeting.

Your meeting starts.

To start a One-Click Meeting using the WebEx One-Click panel:

1. Open your WebEx One-Click panel by doing any of the following:
   - Double-click the WebEx One-Click shortcut on your desktop.
   - Go to Start > Programs > WebEx > Productivity Tools > WebEx One-Click.
   - Right-click the WebEx One-Click icon on the taskbar of your desktop.
If you did not specify automatic login, enter the required WebEx account information in the dialog box, and then click Log In.

2 On the WebEx One-Click panel, click Start Meeting.

Note: For instructions on using the WebEx One-Click panel, refer to the WebEx One-Click User's Guide.

To start a One-Click Meeting using a One-Click shortcut:

Click one of the following shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open One-Click</strong></td>
<td><strong>Right-click menu of taskbar icon shortcut:</strong></td>
</tr>
<tr>
<td></td>
<td>• Right-click the WebEx One-Click taskbar icon and then click Start meeting now to start an instant meeting.</td>
</tr>
<tr>
<td></td>
<td>• Right-click the WebEx One-Click taskbar icon and then click Start a Scheduled Meeting to start a previously scheduled meeting, or click Start Personal Conference meeting to start a previously scheduled Personal Conference meeting.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also right-click the WebEx One-Click taskbar icon and then click Schedule a meeting to schedule a WebEx meeting using Microsoft Outlook or Lotus Notes. For more details, see the Integration to Outlook User's Guide and the Integration to Lotus Notes User's Guide, which are available on the Support page of your WebEx Service.</td>
</tr>
</tbody>
</table>
## Chapter 10: Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>web site.</td>
<td>Email and Scheduling shortcut: Click One-Click Meeting in Microsoft Outlook or Lotus Notes to start a One-Click meeting. <strong>Note:</strong> You can also click Schedule Meeting in Microsoft Outlook or Lotus Notes to schedule a WebEx meeting using Outlook or Lotus Notes. For more details, see the Integration to Outlook User's Guide and the Integration to Lotus Notes User's Guide, which are available on the Support page of your WebEx Service web site.</td>
</tr>
<tr>
<td><img src="image" alt="Microsoft Outlook" /></td>
<td>Instant messenger shortcut: Click WebEx &gt; Start WebEx Meeting to start a One-Click meeting in your instant messenger, such as Skype, AOL Instant Messenger, Lotus SameTime, Windows Messenger, Google Talk, or Yahoo Messenger. For more details, see the Integration to Instant Messengers Guide, which is available on the Support page of your WebEx Service web site. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
<tr>
<td><img src="image" alt="Windows Messenger" /></td>
<td>Web browser shortcut: Click this icon to start your meeting. <strong>Note</strong> If you previously customized your Internet Explorer toolbar, the shortcut button may not automatically appear on the toolbar. Instead, it is added to the list of available toolbar buttons in Internet Explorer. In this case, you must add the button to the toolbar, using the Internet Explorer Customize option. To access this option, on the View menu, point to Toolbars, and then choose Customize. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
<tr>
<td><img src="image" alt="Internet Explorer" /></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 10: Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WebEx</strong></td>
<td><strong>Microsoft Office shortcut:</strong> In Microsoft Word, Microsoft Excel, and Microsoft PowerPoint, select <strong>Share This File or Share t</strong>. This command starts the meeting and automatically shares the application you are using, including all files that are already open in that application. You can still work in the application during the meeting. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
<tr>
<td></td>
<td><strong>Right-Click menu shortcut:</strong> Right-click the icon for an application or document file on your computer, and then point to <strong>Share in WebEx Meeting &gt; As Application</strong>. This command starts the meeting and automatically shares the application, including all files that are already open in that application. You can still work in the application during the meeting. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
</tbody>
</table>

**Tip:**
- Once you start a One-Click Meeting, it appears on your Personal Meeting Room page, unless you specified it to be an unlisted meeting. If you provide others with the URL for this page, they can quickly join your meeting by clicking the link for the meeting on this page.
- You can control which shortcuts are available in the WebEx Settings dialog box.
- For instructions on using the WebEx One-Click shortcuts, refer to the *WebEx One-Click User's Guide*.

Removing WebEx Productivity Tools

You can uninstall WebEx Productivity Tools at any time. Uninstalling Productivity Tools removes all Productivity Tools, including the WebEx One-Click panel and One-Click shortcuts, from your computer.

**To uninstall WebEx Productivity Tools:**
1. Click **Start > Programs > WebEx > Productivity Tools > Uninstall**
2. Click **Yes** to confirm that you want to uninstall WebEx Productivity Tools.

**To uninstall WebEx Productivity Tools from the Control Panel:**
1. Click **Start > Settings > Control Panel**.
2 Double-click Add/Remove Programs.
3 Click WebEx Productivity Tools.
4 Click Remove.
5 Click Yes to confirm that you want to uninstall WebEx Productivity Tools.

**Note:** Uninstalling Productivity Tools removes all Productivity Tools and shortcuts from your computer. If you want to keep using some Productivity Tools but disable others, edit the options in the WebEx Settings dialog box.
A Quick Tour of the Meeting Window

The Meeting window provides a forum for you to share information and interact with attendees via documents, presentations, whiteboards, applications, and more.

You share or view content using the tools in the Meeting window. You can use panels to chat, take notes, and perform other tasks.

When you start or join a meeting, your meeting window opens with the Quick Start area on the left and a panel area on the right. Nearly everything you want to accomplish in a meeting can be done from these areas:

1. Select an audio device
2. Invite or remind people
3. Share your desktop
4. Share content from a file, application, or browser
5. Share a whiteboard
6. Record the meeting
7. Interact with other participants (on page 151)
Working with panels

Your service selects which panels display initially.

**Windows**

1. To display the Panels menu, on the icon tray, select the down arrow.
2. Select an icon from the icon tray to open or close a panel.
3. In this example, the Notes and Polling panels are collapsed. Select the arrow on the title bar to expand or collapse the panel.

**Tip:** To access panel options, right-click in the panel title bar.

**Note:** In sharing mode, you can have one or more panels sit independently on top of the shared document, presentation, Web browser, or other shared item.

**Mac**

1. To display the Panels menu, on the icon tray, select the options icon.
2. Select an icon from the icon tray to open or close a panel.
3. In this example, the Notes panel is collapsed. Select the arrow on the title bar to expand or collapse the panel.

**Tip:** To access panel options, right-click in the panel title bar.
Using panels to interact with other participants

After you start or join a meeting, the meeting window opens and on the right side, you can see all participants who are in the meeting. As other people join, you will see their names appear in the list.

You can interact with other participants in the meeting in different ways, depending on your role:
### Chapter 11: A Quick Tour of the Meeting Window

<table>
<thead>
<tr>
<th>Role</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host</strong></td>
<td>1) View the list of meeting participants&lt;br&gt;2) Use video to see others and have them see you.&lt;br&gt;3) Make someone else the presenter&lt;br&gt;4) Chat with a specific participant or with everyone.&lt;br&gt;5) Invite someone else or remind an invitee to join the meeting.</td>
</tr>
<tr>
<td><strong>Windows</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Participant</strong></td>
<td>1) View who is in the meeting&lt;br&gt;2) Use video to see others and have them see you&lt;br&gt;3) Chat with other participants.</td>
</tr>
<tr>
<td><strong>Mac</strong></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 11: A Quick Tour of the Meeting Window

Managing panels

You can determine which panels are displayed in the meeting window, and in which order they will be displayed:

To manage the display of panels:

1. Click this button.

   ![For Windows](image)

   ![For the Mac](image)

2. Choose **Manage Panels** from the menu.

   - Use the **Add** or **Remove** buttons to specify which panels should display in your meeting window.
   - Use the **Move Up** or **Move Down** buttons to specify the order of the panel display.
   - Click the **Reset** button to restore the panel view to the default layout.
   - Clear the check box beside **Allow participants to change the sequence of panels** if you want to permit attendees to manage their own display of panels.

Restoring the panel layout

If you have closed, expanded or collapsed panels, you can restore the display to the layout:

- you specified in the Manage Panels dialog box.
- that existed when you first joined the meeting (if you did not specify a layout via the Manage Panels dialog box)
To restore the panel layout:

1. Click this button.

   ![button](for Windows)

   ![settings](for the Mac)

2. Choose **Restore Layout**.

### Accessing panel options

Each panel provides a menu of commands related to the panel. For example, Expand Panel and Close Panel are two common commands for all the panels.

Depending on what operating system you are using, access the commands for a panel by following these steps:

- **Windows**—Right-click the panel title bar to see a menu of commands related to the panel.
- **Mac**—Select `cmd` and then click to see a menu of commands related to the panel.

<table>
<thead>
<tr>
<th>Panels with options</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Participants</strong></td>
<td><strong>Sound Alerts</strong>: Lets you choose a sound to play when a participant:</td>
</tr>
<tr>
<td></td>
<td>- Joins a meeting</td>
</tr>
<tr>
<td></td>
<td>- Leaves a meeting</td>
</tr>
<tr>
<td></td>
<td>- Selects the <strong>Raise Hand</strong> icon on the <strong>Participants</strong> panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Assign Privileges</strong>: Displays the Participant Privileges dialog box.</td>
</tr>
<tr>
<td><strong>Chat</strong></td>
<td><strong>Sound Alerts</strong>: Lets you choose the kinds of chat messages for which you want a sound to play. Select a sound from the drop-down list or click <strong>Browse</strong> to find a sound in a different location on your computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Assign Privileges</strong>: Displays the Participant Privileges dialog box.</td>
</tr>
</tbody>
</table>
Panels with options | Options
--- | ---
Notes | Notes: Displays the Meeting Options dialog box, where you can set note-taking options as well as other options

- **Allow all participants to make notes**: Lets all participants take their own notes during the meeting, and save them to their computers.
- **Single note taker**: Lets only one participant take notes during the meeting. By default, the host is the note-taker, but can designate another participant as the note-taker during the meeting. A note-taker can publish notes to all attendees at any time during the meeting. The host can send a transcript of the notes to participants at any time.
- **Enable Closed Captioning**: Lets only one participant—the closed captionist—take notes during the meeting.

---

**Resizing the content viewer and panels area**

When you are sharing a document or presentation, you can control the size of the content viewer by making the panel area narrower or wider.

**Note**: This feature is unavailable when you are sharing your desktop, an application, or a Web browser.

To change the size of the content viewer and panels:

Click the dividing line between the content viewer and the panels.

- Drag the line to the left to make the area devoted to the panels wider.
- Drag the line to the right to make the content viewer larger.

For details about hiding, minimizing, and closing the panels, see Accessing panels in full-screen view.
Accessing panels from the Meeting Controls Panel

While you are sharing a document in full-screen view, or sharing an application, desktop, or Web browser, you can access panels from the Meeting Controls Panel:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Displays icons for working with attendees</td>
</tr>
<tr>
<td>2</td>
<td>Displays a maximum of 4 panel icons. You can open any remaining panels from the menu that appears when you select the down arrow.</td>
</tr>
<tr>
<td></td>
<td>Stops sharing and returns to the Meeting window</td>
</tr>
<tr>
<td></td>
<td>Provides access to meeting controls and panels that are not usually displayed on the Meeting Controls Panel, such as Polling and Notes.</td>
</tr>
<tr>
<td></td>
<td>Displays the Participants panel</td>
</tr>
<tr>
<td></td>
<td>Displays the Chat panel</td>
</tr>
<tr>
<td></td>
<td>Displays the Annotation Tools panel</td>
</tr>
<tr>
<td></td>
<td>Displays the Recorder panel</td>
</tr>
</tbody>
</table>
## Viewing Panel alerts

You will see an orange alert if a panel is collapsed or closed and requires your attention.

Some reasons for seeing alerts:

- A participant arrives or leaves a meeting
- A participant starts or stops sending video
- A Raise Hand indicator appears in the Participants list
- The note taker publishes notes
- An participant sends a chat message
- A poll opens or closes
- Poll answers are received

For example, if a participant joins or leaves your meeting, and you have collapsed or closed the participant panel, the following table shows you different ways you can be alerted.

<table>
<thead>
<tr>
<th>Participants panel alerts</th>
<th>ways to see alerts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows</strong></td>
<td>Meeting window-panel is closed</td>
</tr>
<tr>
<td><img src="image" alt="Windows alert" /></td>
<td></td>
</tr>
<tr>
<td><strong>Mac</strong></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Mac alert" /></td>
<td></td>
</tr>
<tr>
<td><strong>Windows</strong></td>
<td>Meeting window-panel is collapsed</td>
</tr>
<tr>
<td><img src="image" alt="Windows alert" /></td>
<td></td>
</tr>
<tr>
<td><strong>Mac</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 11: A Quick Tour of the Meeting Window

<table>
<thead>
<tr>
<th>Participants panel alerts</th>
<th>ways to see alerts</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Participants panel alerts" /></td>
<td></td>
</tr>
</tbody>
</table>

**Windows**

Meeting Controls Panel (during sharing)- panel is closed

**Mac**

The panel remains in the alert status until you open and view the change.
Chapter 12

Managing a Meeting

All the prep work is done, and you have started your meeting. Here are some of the most common tasks you can perform as you host the meeting:

- Edit your welcome message (on page 170)
- Invite more people (on page 159)
- Remind invitees to join (on page 164)
- Change presenters before sharing (on page 165)
- Change presenters during sharing (on page 167)
- Make someone else the host (on page 167)
- Send a transcript (on page 173)
- End the meeting (on page 174).

Inviting more people to your in-progress meeting

After you start your meeting, you may find that you forgot to invite a stakeholder or someone else who should be in the meeting.
Chapter 12: Managing a Meeting

To invite someone after you start your meeting:

Select **Invite & Remind** on the Quick Start page.

The Invite and Remind dialog box appears.

You can invite someone to the meeting by

- **Email**: invite by WebEx or your own email. More (on page 162)
- **IM**: Invite by WebEx or your own IM. More (on page 160)
- **SMS**: Enter the invitee mobile number and select Send. More (on page 164)
- **Phone**: Enter the invitee name and phone number and select Call. More (on page 163)

**Inviting people by instant message to a meeting in progress**

You can invite more people to your in-progress meeting by WebEx IM or another instant messenger.

To invite more people using WebEx IM:

**Note**: Start your WebEx IM if it is not currently running.
Chapter 12: Managing a Meeting

1) From the Quick Start page, open the Invite and Remind dialog box.

2) On the IM tab, select Invite.

The Invite More dialog box appears.

1) Type a screen or domain name for the attendee.
2) Click the Plus button to add the name to the list of participants.

To quickly find screen names:

1) Click the Address Book button to open your address book.
2) In the Method drop-down list, select IM.
   If the attendee is not currently available, you can send an email invitation instead. Simple select Email in the drop-down list.
3) Click Invite.
   Each attendee receives an IM message, which includes:
   - A link that the attendee can click to join the meeting
- Meeting topic
- Meeting start time

**Tip:** If you invite attendees by instant messenger, and your meeting requires a password, remember to provide the password to attendees.

To invite more people using another IM:

1. Open the Invite and Remind db from the QuickStart page.
2. Select *Copy* at the bottom of the db, then paste the URL into your own IM and send it.

**Inviting people by email to a meeting in progress**

Each person that you invite receives an invitation email message, which provides information about the meeting—including the password, if any—and a link that the participant can click to join the meeting.
To send an email invitation:

1) From the Quick Start page, Open the Invite and Remind dialog box.
2) On the Email tab do one of the following:
   - Enter one or more email addresses and select Send to have WebEx send the invitation emails.
   - Click the link to send invitations using your own email program (MS Outlook or Lotus Notes only).

Inviting participants by phone to a meeting in progress

You can invite participants by phone to a meeting in progress.

To invite participants by phone:

1) From the Quick Start page, open the Invite and Remind dialog box
2) On the Phone tab, enter the invitee name and phone number.
3) Select Call.

You can speak to the invitee privately, then add the invitee to the general meeting.

If you are not yet connected to the audio conference, the participant receives a phone call to join the audio conference.
Inviting participants by text message (SMS) to a meeting in progress

You can invite participants by text message (SMS) to a meeting in progress. This feature must be enabled by your site administrator.

To invite a participant by text message from the meeting:

1) From the Quick Start page, open the Invite and Remind dialog box.
2) On the SMS tab, enter the invitee mobile phone number.
3) Select Send.

Each participant receives a text message, which includes:

- A number the participant can call to join the meeting
- The account code
- Meeting topic
- Meeting start time
- The host name
- A reply code to receive a call from the meeting.

Reminding invitees to join your meeting

After the meeting starts, and you see that some invitees have not yet joined, you can send an email reminder.
To remind someone to join your meeting:

Select **Invite & Remind** on the Quick Start page.

The Invite and Remind dialog box appears.

1) Uncheck the box beside any person you don't want to remind.
2) Select **Send Reminder**.

An email reminder is sent to each person selected.

**Making a participant the presenter when you are in the meeting window**

As the meeting host, you are initially the presenter as well. The WebEx ball appears to the left of your name. However, during a meeting, you can designate any meeting participant as the presenter - also referred to as *passing the ball*. Any presenter can also pass the ball to make another meeting participant the presenter.

There are numerous ways to make someone else the presenter depending on how you are viewing participants.
Here are a couple of quick ways to make another participant the presenter:

If you are viewing a list of participants, do either of the following:

- Drag the ball from the last presenter to the next presenter
- Choose a name and select **Make Presenter** at the bottom of the panel.

If you are viewing participant thumbnails, do either of the following:

- Mouse over a thumbnail and select **Make Presenter**.
- Choose a thumbnail, then select **Make Presenter** at the bottom of the panel.

The participant becomes the presenter with all associated rights and privileges for sharing information.
Making someone else the presenter when you are sharing

When you are sharing your desktop, an application, or files in full screen mode, the docked tray at the top of your screen provides an easy way to change presenters.

To make someone else the presenter using the docked tray:

1. Mouse over the bottom of the docked tray to expose it.
2. Select Assign, then Make Presenter.
3. Select a participant.

The participant becomes the presenter with all associated rights and privileges for sharing information.

Note: You can make someone else the presenter from the participant list (on page 165) when you are in the meeting window.

Making someone else the host

As a meeting host, you can transfer the host role - and thus control of the meeting - to an attendee at any time. This option can be useful if you need to leave a meeting for any reason.

To make another participant the host:

1. Do one of the following:
Chapter 12: Managing a Meeting

- Right-click on a participant name or participant thumbnail.
- Select the Participant menu

2 Select **Host** from the Change Role To menu. The selected participant is now the host.

The word (host) appears to the right of the attendee's name in the participant list.

**Transferring the host role**

As a meeting host, you can transfer the host role - and thus control of the meeting - to an attendee at any time. This option can be useful if you need to leave a meeting for any reason.

To transfer the host role to an attendee:

1 **Optional.** If you plan to reclaim the host role later, write down the host key that appears on the Info tab in the content viewer in the Meeting window.

2 Display the Participants panel.

3 In the participant list, select the name of an attendee to whom you want to transfer the host role.

4 On the Participant menu, choose Change Role To > Host.

   A confirmation message appears, in which you can verify that you want to transfer control of the meeting to the participant whom you selected.

5 Click OK.

The word (host) appears to the right of the participant's name in the participant list.
Reclaiming the host role

To take over the role of meeting host:

If a participant has control of a meeting, you can assume control of the meeting by reclaiming the host role.

**Important:** If you leave a meeting—whether intentionally or inadvertently—and then log back in to your meeting service Web site, you automatically become the meeting host once you rejoin the meeting. You can rejoin a meeting using either the public meeting calendar or your private meeting calendar.

To reclaim the host role:

1. In the Meeting window, open the Participants panel.
2. In the participant list, select your own name.
3. On the Participant menu, choose Reclaim Host Role.
   
The Reclaim Host Role dialog box appears.
4. Type the host key in the Host key box.

5. Click OK.

In the participant list, the word (host) appears to the right of your name.

**Tip:** If you did not write down the host key before transferring the host role to another participant, you can ask the current host to send you the host key in a private chat message. The host key appears on the current host's Info tab in the content viewer.
Obtaining information about a meeting after it starts

To obtain information about a meeting in progress:

In the Meeting window, on the Meeting menu, choose Information.

The Meeting Information dialog box appears, listing general information about the meeting, including the:

- Meeting name or topic
- Location, or URL, of the Web site where the meeting is taking place
- Meeting number
- Teleconferencing information
- Current host
- Current presenter
- Current user—that is, your name
- Current number of participants

Editing a message or greeting during a meeting

When scheduling a meeting, you can create a message or greeting for participants, and optionally specify that the message or greeting automatically appears in participant windows once they join the meeting. During a meeting, you can edit the message or greeting that you created, or edit the default greeting.

In your message or greeting, you can welcome the participant to the meeting, provide important information about the meeting, or provide special instructions.

To edit a message or greeting during a meeting:

1. In the meeting window, on the Meeting menu, choose Welcome Message.
   
   The Create an Attendee Greeting page appears.
Optional. Select the **Display this message when attendees join the meeting** check box.

The message or greeting automatically appears once the participant joins the meeting.

3 Type a message or greeting in the **Message** box.

A message or greeting can contain a maximum of 255 characters.

4 Click **OK**.

**Note:** Participants can view the message or greeting at any time by choosing **Welcome Message** on the **Meeting** menu.

### Restricting access to a meeting

Once a host starts a meeting, the host can restrict access to it at any time. This option prevents anyone from joining the meeting, including participants who have been invited to the meeting but have not yet joined it.

**To restrict access to a meeting:**

1 In the Meeting window, on the **Meeting** menu, choose **Restrict Access**.

   Participants can no longer join the meeting.

2 Optional. To restore access to the meeting, on the Meeting menu, choose **Restore Access**.
Removing a participant from a meeting

The meeting host can remove a participant from a meeting at any time.

**To remove a participant from a meeting:**

1. In the Meeting window, open the Participants panel.
2. Select the name of the participant whom you want to remove from the meeting.
3. On the **Participant** menu, choose **Expel**.
   
   A confirmation message appears, in which you can verify that you want to remove the participant from the meeting.
4. Click **Yes**.
   
   The participant is removed from the meeting.

**Tip:** To prevent an expelled participant from rejoining a meeting, you can restrict access to the meeting. For details, see *Restricting access to a meeting* (on page 171).

Leaving a meeting

You can leave a meeting at any time. If you are participating in an audio conference, Meeting Manager disconnects you from the conference automatically once you leave the meeting.

**To leave a meeting:**

1. In the Meeting window, on the **File** menu, choose **Leave Meeting**.
   
   A confirmation message appears, in which you can verify that you want to leave the meeting.
2. Click **Yes**.
   
   The Meeting window closes.

**Note:** If you are the meeting host, first transfer the host role to another participant before leaving the meeting. For more information, see *Transferring the host role to an attendee* (on page 168).
Sending a meeting transcript to participants

You can send a transcript of a meeting to all participants at any time during the meeting. The transcript is an email message that contains the following general information:

- Meeting topic
- Meeting number
- Meeting starting and ending times
- URL for the Meeting Information page for the meeting on your meeting service Web site
- List of participants who have joined the meeting (audio-only participants are not listed)
- Meeting agenda
- Any public notes that you took during the meeting

You can optionally attach any of the following files to the transcript, if you saved them during the meeting:

- Shared documents
- Chat
- Poll questionnaire
- Poll results
- Public notes or closed captions that you took or that the note taker or closed captionist published during the meeting

To send a meeting transcript to participants:

1. In the Meeting window, on the File menu, choose Send Transcript.

   If you have saved any files during the meeting, the Send Transcript dialog box appears, allowing you to attach the files to the transcript email message.

   If you have not saved any files during the meeting, a transcript email message opens.

2. If the Send Transcript dialog box appears, select the check box for each file that you want to attach to the transcript, and then click OK.

   The transcript email message opens.

3. Review the email message and make any changes that you want.
4 Send the email message.

**Note:** The transcript is sent to all participants who provided their email addresses when joining the meeting, whether or not they are still attending the meeting when you send the transcript. Audio-only participants will not be listed on the transcript.

For security purposes, a participant who receives a transcript email message cannot see the email addresses for the other participants.

The transcript contains notes only if you are the meeting host, the public note taker, or the closed captionist, and you have saved the notes to a file. If all participants can take private notes, the transcript email message does not include your private notes, and the option to attach your notes in a file is not available.

If you saved notes or closed captions to a file, the transcript email message and the attached notes file contain the latest version of notes that you saved.

If you are the meeting host and end the meeting-and you have not sent a transcript-a message appears, asking you if you want to send a transcript.

**Ending a meeting**

Once you end a meeting, the Meeting window closes for all participants. If the meeting includes an integrated voice teleconference, the conference also ends.

**Note:** If your site administrator has enabled the Teleconference Keep-Alive feature for your site, you will be prompted whether you want to continue the teleconference after the web meeting ends.

**To end a meeting:**

1 In the Meeting window, on the **File** menu, choose **End Meeting**.
   
   A confirmation message appears, in which you can verify that you want to end the meeting.

2 Click **Yes**.

The Meeting window closes.

**Note:** If there is any meeting information that you have not yet saved - including shared documents, chat messages, a poll questionnaire, poll results, or notes - Meeting Manager asks you whether you want to save it before ending the meeting. If you choose to save a file, Meeting Manager uses the default file name for the file. Thus, if you have already saved the file using another name, Meeting Manager does not overwrite that file.
Tip: Alternatively, as the meeting host, you can leave a meeting without ending it. Before you leave a meeting, you should first transfer the host role to another participant. For more information, see the following topics: Transferring the host role to an attendee (on page 168) and Leaving a meeting (on page 172).
The My Recorded Meetings page allows you to view and manage your meeting recordings. Meetings that you recorded on the server are automatically listed on your My Recorded Meetings page. You can also upload recordings of meetings that were recorded on your local computer.

### Opening the My Recorded Meetings Page

To open the My Recorded Meetings page:

1. Log in to your WebEx Meeting Center service Web site.
Chapter 13: Managing Recorded Meetings

2 On the left navigation bar, under Host a Meeting, click My Files > My Recordings.

The My Recorded Meetings page appears, showing your recording files.

For details about the My Recorded Meetings page, see About the My Recorded Meetings page (on page 179).

About the Recording Information page

How to access this page

On your Meeting Center Web site, from the left navigation bar, click My Recorded Meetings > [topic of a recording].

What you can do here

- View information about the recording.
- Play back the recording.
- Send an email to share the recording with others.
- Download the recording.
- Enable or disable the recording
- Open the Edit Recorded Meeting page, on which you can edit information about a recording.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The name of the recording. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Create time</td>
<td>The time and date the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>The file size of the recording.</td>
</tr>
<tr>
<td>Create time</td>
<td>The date and time at which the recording was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the recording. The possible options are Enable or Disable.</td>
</tr>
</tbody>
</table>
Chapter 13: Managing Recorded Meetings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Password</strong></td>
<td>Indicates whether a user must provide a password to view the recording.</td>
</tr>
<tr>
<td><strong>Stream recording link</strong></td>
<td>Clicking the link lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).</td>
</tr>
<tr>
<td><strong>Download recording link</strong></td>
<td>Clicking the link lets you download the recording.</td>
</tr>
<tr>
<td><strong>Play Now</strong></td>
<td>If you want to download the recording, you can also click the link for downloading under Play Recorded a meeting Now.</td>
</tr>
<tr>
<td><strong>Send Email</strong></td>
<td>Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording.</td>
</tr>
<tr>
<td><strong>Send Email</strong></td>
<td>If you want to send the email with your local email client instead, click the link for using the email client under Share My Recording.</td>
</tr>
<tr>
<td><strong>Modify</strong></td>
<td>Clicking the button opens the Edit Recording page.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Clicking the button deletes the recording.</td>
</tr>
<tr>
<td><strong>Disable</strong></td>
<td>Clicking the button disables the recording everywhere it is published on your WebEx Service Web site. (Available only for enabled recordings.)</td>
</tr>
<tr>
<td><strong>Enable</strong></td>
<td>Clicking the button enables the recording everywhere it is published on your WebEx Service Web site. (Available only for disabled recordings.)</td>
</tr>
<tr>
<td><strong>Back to List</strong></td>
<td>Clicking the button returns you to the recording list.</td>
</tr>
</tbody>
</table>

About the My Recorded Meetings page

How to access this page
Log in to your WebEx service Web site. From the left navigation bar, click My Files > My Recordings.
Chapter 13: Managing Recorded Meetings

What you can do here
Manage, upload, and maintain recording files of meetings you host.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refreshes the information on the page.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows you type text to search for within recording names. Click Search to</td>
</tr>
<tr>
<td></td>
<td>start the search.</td>
</tr>
<tr>
<td>You are currently using X %</td>
<td>The percentage of available personal storage space on your WebEx Service</td>
</tr>
<tr>
<td>of Y GB</td>
<td>Web site that is being used by your recordings. This field appears only if</td>
</tr>
<tr>
<td></td>
<td>your site administrator has turned on the option to show personal recording</td>
</tr>
<tr>
<td></td>
<td>storage allocation usage. If this field does appear, and you exceed your</td>
</tr>
<tr>
<td></td>
<td>personal storage allocation, you will not be able to record meetings until</td>
</tr>
<tr>
<td></td>
<td>recordings are deleted or the storage allocation is increased by your</td>
</tr>
<tr>
<td></td>
<td>system administrator.</td>
</tr>
<tr>
<td>Site storage X % of Y GB</td>
<td>The percentage of total available storage space on your WebEx Service Web</td>
</tr>
<tr>
<td></td>
<td>site that is being used by all recordings on your site. If your site exceeds</td>
</tr>
<tr>
<td></td>
<td>its storage allocation, users will not be able to record meetings until</td>
</tr>
<tr>
<td></td>
<td>recordings are deleted or the storage allocation is increased by your</td>
</tr>
<tr>
<td></td>
<td>system administrator.</td>
</tr>
<tr>
<td>Topic</td>
<td>The name of the recording. If you record a meeting on the server, the WebEx</td>
</tr>
<tr>
<td></td>
<td>server automatically uploads the recording to this page. In this case, the</td>
</tr>
<tr>
<td></td>
<td>topic of the recording is the topic of the meeting. You can edit the topic</td>
</tr>
<tr>
<td></td>
<td>at any time.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the recording.</td>
</tr>
<tr>
<td>Create Time/Date</td>
<td>The date and time the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Format</td>
<td>The format of the recording file.</td>
</tr>
<tr>
<td></td>
<td>A recording file can be in WebEx Advanced Recording Format (ARF) or</td>
</tr>
<tr>
<td></td>
<td>WebEx Recording Format (WRF). You can also store recording files that are</td>
</tr>
<tr>
<td></td>
<td>in Windows Media Audio/Video (WMV) or Shockwave Flash Object (SWF) format.</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Lets you play the recording (available only for recording files with an</td>
</tr>
<tr>
<td></td>
<td>.arf extension that were recorded by the Network-Based Recorder). If</td>
</tr>
<tr>
<td></td>
<td>playback of the file requires a password, you must provide the password.</td>
</tr>
</tbody>
</table>
### Option 1: Description

#### Option

- Lets you send an email to share this recording with others.

#### Description

Displays a menu with more options for your recording:

- **Download**: Lets you download the recording to your local computer.
  
  If downloading the file requires a password, you must provide the password.

- **Modify**: Lets you edit information of the recording. For details, see *About the Add/Edit Recordings page* (on page 322).

- **Disable**: Lets you disable the recording in all locations.

- **Delete**: Lets you delete the recording from this page.

#### Option 2: Add Recording

- Lets you upload a new recording.

For details, see *Uploading a recording file* (on page 319) and *About the Add/Edit Recordings page* (on page 322).

#### Option 3: 

- Indicates that a recording is password-protected.

---

### Uploading a recorded meeting file

If you recorded meeting using the integrated or standalone WebEx Recorder, you can upload the recording meeting file, with a .wrf extension, from your local computer to the My Recorded Meetings page.

For instructions on editing a recording, see *Editing information about a recording* (on page 320).

**Note**: If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx server automatically uploads the recording file, with an .arf extension, to the appropriate tab on the My Recorded Meetings page once you stop the Recorder. You do not need to upload it yourself.

**To upload a recording file:**

1. Go to the My Recorded Meetings page. For details, see .
2. Click **Add Recording**.
3. On the Add Recorded Meeting page, enter information and specify options.

   For details about what you can do with each option on the Add/Edit Recorded Meetings page, see *About the Add/Edit Recorded Meetings page* (on page 182).
4  Click Save.

Editing information about a recorded meeting

You can edit information about a recorded meeting at any time.

To edit information about a recorded meeting:

1  Go to the My Recordings page or the My Recorded Meetings page. For details, see *Opening the My Recordings page* (on page 319).

2  Click the following icon for the recording that you want to edit.

   ![Edit Icon](image)

   The Edit Recorded Meetings page appears.

3  Make your changes.

   For details about what you can do with each option on the Edit Recorded Meetings page, see *About the Add/Edit Recorded Meetings Page* (on page 182).

4  Click Save.

About the Add/Edit Recorded Meetings page

How to access this page

If you are adding a recording...

1  Log in to your WebEx Meeting Center service Web site.

2  On the left navigation bar, under Host a Meeting, click My Recordings.

3  Click Add Recording.

If you are editing information about a recording...

1  On your WebEx service Web site, under Host a Meeting, click My Recordings.

2  Click the More button in the row of the recording that you want to edit.

3  Click Modify.
Chapter 13: Managing Recorded Meetings

What you can do here

- Edit general information about a recording, including the topic and description.
- Require a password to play or download the recording.
- Specify playback control options, such as panel display options and recording playback range and whether to include Network Recording Play controls.

Options on this page

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Specify the topic of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of this recording.</td>
</tr>
<tr>
<td>Recording file</td>
<td>Click Browse to select the recording file that resides on your local computer.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specify the duration of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>Displays the size of the recording file. (Available only when editing recording information.)</td>
</tr>
<tr>
<td>Set password</td>
<td>Set an optional password that users must provide to view the recording.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Confirm the password that users must provide to view the recording.</td>
</tr>
</tbody>
</table>

Sending an email to share a recorded meeting

You can send an email one or more people to share your recorded meeting with them.
To send an email to share a recorded meeting with others:

1. Go to the My Recorded Meetings page. For details, see *Opening the My Recorded Meetings Page* (on page 177).

2. Open the Share My Recording window:
   - Click the following icon for the recording that you want to share with others.
   - Click the linked name of the recording you want to share. On the Recording Information page, click **Send Email**.

3. Select recipients for your email:
   - Click **Select Recipients** to select contacts from your Contacts list
   - Type email addresses in the **Send to** list, separated by commas.

4. (Optional) Type a message in the **Your message** box.

5. Click **Send**.

Your email message will be sent to the selected recipients, and will include information about the recording and a link to play it.
Chapter 14

Sharing Presentations, Documents, and Whiteboards

Your user role in a meeting determines your level of sharing. Whichever role you take, the following table describes the basic tasks associated with that role. For detailed instructions on a particular task, click “More” by the task description.

<table>
<thead>
<tr>
<th>Task description:</th>
<th>Host</th>
<th>Participant with granted permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open and share a document or whiteboard</td>
<td>- learn about tools for sharing More (on page 186)</td>
<td>- display slides or pages More (on page 206)</td>
</tr>
<tr>
<td></td>
<td>- start sharing More (on page 189)</td>
<td>- use tools to annotate a document More (on page 188)</td>
</tr>
<tr>
<td></td>
<td>- assigning sharing privileges to participants More (on page 186)</td>
<td>- synchronize your view with the host More (on page 207)</td>
</tr>
<tr>
<td></td>
<td>- save a document More (on page 203)</td>
<td></td>
</tr>
</tbody>
</table>
Granting sharing privileges

To grant or remove participant privileges during a meeting:

1. In the Meeting window, on the Participant menu, choose Assign Privileges. The Participant Privileges dialog box appears.
2. Grant or remove a privilege, as follows:
   - To grant a specific privilege, select its check box.
   - To grant all privileges, select the Assign all privileges check box.
   - To remove a privilege, clear its check box.
   - To revert to the preset privileges, click Reset to Meeting Defaults.
3. Click Assign.

Content viewer tools

The tools on the content viewer toolbar allow you to share and perform actions on presentations, documents, and whiteboards.

Select this button at the top right of the content viewer to start a new whiteboard.

annotation toolbar—Select a drawing tool for directing attention onscreen, using pointers, a highlighter, or drawing a shape More (on page 188)
Changing views in a file or whiteboard

You can switch views in the content viewer by clicking the view icons and selecting from the View menu in the bottom left corner of the content viewer:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Thumbnails</td>
<td></td>
<td>To display thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click Show Thumbnails. This tool helps you locate a page or slide quickly.</td>
</tr>
<tr>
<td>Full-Screen View</td>
<td></td>
<td>Displays shared content in a full-screen view. Helps to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation. Click ESC to return to the content viewer.</td>
</tr>
<tr>
<td>Rotate page</td>
<td></td>
<td>For documents in landscape orientation, you can rotate the pages to the left or right so they appear correctly in the content viewer.</td>
</tr>
<tr>
<td>Zoom In/Zoom Out</td>
<td></td>
<td>Lets you display shared content at various magnifications. Click this button, and then click the page, slide, or whiteboard to change its magnification. For more magnification options, click the downward-pointing arrow.</td>
</tr>
</tbody>
</table>
### Chapter 14: Sharing Presentations, Documents, and Whiteboards

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize Displays for All</td>
<td>![Icon]</td>
<td>For presenters, synchronizes all participants' displays with your display. Helps to ensure that all participants are viewing the same page or slide, at the same magnification, as in your display.</td>
</tr>
</tbody>
</table>

#### Using annotation tools on shared content

In an online meeting, you can use annotation tools on shared content to annotate, highlight, explain, or point to information:

![Basic annotation tools]

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>![Icon]</td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td>![Icon]</td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Line</td>
<td>![Icon]</td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>![Icon]</td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td>![Icon]</td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool</td>
</tr>
<tr>
<td>Annotation Color</td>
<td>![Icon]</td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
</tbody>
</table>
Chapter 14: Sharing Presentations, Documents, and Whiteboards

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eraser</td>
<td>![Eraser Icon]</td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

Sharing presentations or documents

File sharing is ideal for presenting information that you do not need to edit during the meeting, such as a slide presentation.

You can share almost any type of file that you can print from your computer. Participants view shared files in their content viewers without the need for the application with which it was created. Participants can also view any animation and transition effects on shared Microsoft PowerPoint slides.

After a meeting starts, you can open a presentation or document to share. You do not need to select it or “load” it before the meeting.

While sharing a file, you can:

- Draw on the screen *More* (on page 188)
- Use a pointer to emphasize text or graphics *More* (on page 188)
- Print it *More* (on page 205)
- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view *More* (on page 187)
- Synchronize all participants' displays with the display in your content viewer *More* (on page 201)
- Save it to a file *More* (on page 204)

At any time during a meeting, you can grant participants privileges that allow them to annotate, save, print, and display different views of shared presentations or documents.

Sharing a document or presentation

You can share a document or presentation that resides on your computer. Participants view the shared document or presentation in their content viewers.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

To share a document or presentation:

1. On the Share menu, choose Presentation or Document.
   The Share Presentation or Document dialog box appears.
2. Select the document or presentation that you want to share.
3. Click Open.

The shared document or presentation appears in the content viewer.

Tip: See Tips for sharing documents and presentations (on page 190) for information that can help you to share documents and presentations more effectively.

Tips for sharing documents and presentations

These tips can help you share documents or presentations more effectively.

- To import slide presentations quickly:
  - Limit the number of animations and slide transitions.
  - Minimize the number of screen shots that you add to slides, especially bitmap graphics. Bitmaps do not compress well.

- To improve the speed at which shared pages or slides appear in participant content viewers, save the document or presentation as a .ucf (Universal Communications Format) file before the meeting starts. Then share the .ucf file instead of the document or presentation itself. More... (on page 204)

- You can annotate shared presentations or documents in the content viewer; however, you cannot edit them. If you want to edit shared information, you can use application sharing instead.

If you are sharing a PowerPoint presentation, you can open the PowerPoint Notes panel and view any notes you have added to the slide in the presentation.

- To save time during a meeting, begin sharing the document or presentation before the meeting's starting time. That way, after participants join the meeting, they can begin viewing your presentation.
Choosing an import mode for document or presentation sharing

For Windows users only

Before you share a document or presentation, you can choose one of the following import modes:

- **Universal Communications Format (UCF)**—The default mode. Lets you display animations and slide transitions in Microsoft PowerPoint presentations. In the UCF mode, Meeting Manager imports documents and presentations more quickly than it does in the printer driver mode. However, pages or slides may not appear consistently in Meeting Manager across platforms.

- **Printer driver**—Displays shared documents and presentations as they appear when you print them, providing a consistent appearance of pages and slides in Meeting Manager across platforms. However, this mode does not support animations or slide transitions. In this mode, the first page or slide may appear quickly, but the total import time for all pages or slides is usually longer than it is in the UCF mode.

**Note:** Changing the import mode does not affect any presentations or documents that you are currently sharing. To apply a new import mode to a shared document or presentation, you must close it first, and then share it again.

To choose an import mode for shared documents and presentations:

1. In the Meeting window, on the **Meeting** menu, choose **Options**.
   
   The Meeting Options dialog box appears, with the **Options** tab selected by default.

2. Click the **Import Mode** tab.

   The Import Mode tab options appear.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

3 Select either Universal Communications Format or Printer driver.

Sharing a whiteboard

Sharing a whiteboard allows you to draw objects and type text that all Participants can see in their content viewers. You can also use a pointer to emphasize text or graphics on a whiteboard.

Other things you can do while sharing a whiteboard:

- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view.
- Copy and paste images into it
- Reorder its position in reference to any other whiteboards
- Print it
- Synchronize Participants' displays with the display in your content viewer More (on page 201)
- Save it

If you allow participants to annotate slides and pages, you and participants can draw and type on a whiteboard simultaneously. You can also allow participants to save, print, and display different views of shared whiteboards. For details, see Granting sharing privileges (on page 186).

Starting whiteboard sharing

You can share a whiteboard on which you can draw and write. Participants can view a shared whiteboard in their content viewers.

To share a whiteboard:

On the Share menu, choose Whiteboard.

Note:

- You can add multiple pages to a shared whiteboard. For details, see Adding new pages or slides (on page 197).
- You can share multiple whiteboards. For each whiteboard that you share, you see a new Whiteboard tab in the content viewer.
Navigating presentations, documents, or whiteboards

When sharing a document, presentation, or whiteboard, you can

- Navigate slides, pages, or whiteboards using the toolbar More (on page 193)
- Advance pages or slides automatically, at an interval of time that you specify More (on page 194)
- Perform animations and slide transitions in a presentation More (on page 195)
- Use keys on your computer's keyboard to navigate a presentation and display animations on the slides More (on page 196)

Navigating slides, pages, or whiteboards using the toolbar

You can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on a tab at the top of the content viewer.

To display pages or slides in the content viewer:

1. In the Meeting window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.

   If there are more tabs than can appear at one time, select the down arrow button to see a list of remaining tabs, or use your keyboard arrows forward and back through all the tabs.

2. On the toolbar, click a button to change the page or slide you are viewing.

   If Microsoft PowerPoint slides are being shared, the drop-down list also displays the title of each slide.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

Note:
- Alternatively, you can navigate to different pages or slides in a shared document, presentation, or whiteboard by opening the thumbnail viewer. For details, see Viewing thumbnails (on page 200).
- You can advance pages or slides automatically at a time interval that you specify. For details, see Advancing pages or slides automatically (on page 194).
- You can also use the keys on your computer’s keyboard to display different pages or slides and perform animations and slide transitions. For details, see Using keyboard shortcuts to control a presentation (on page 196).
- If your presentation includes animations or slide transitions, you can use the toolbar or keyboard shortcuts to perform them. For details, see Animating and adding effects to shared slides (on page 195).

Advancing pages or slides automatically

When sharing a document or presentation in the content viewer, you can automatically advance pages or slides at a specified interval. Once you start automatic page or slide advancement, you can stop it at any time.

To automatically advance pages or slides:

1. In the Meeting window, in the content viewer, select the tab for the document or presentation for which you want to advance pages or slides automatically.
2. On the View menu, choose Automatically Advance Pages.
   The Automatically Advance Pages dialog box appears.
3. To change the time interval for advancing pages, do one of these:
   - click the up or down buttons to increase or decrease the interval
   - type a specific time interval
   Optional: To restart page or slide advancement once all pages or slides are displayed, select the Return to beginning and continue advancing pages check box.
4. Click Start.
5. Optional. Close the Automatically Advance Pages dialog box by clicking the Close button in the upper-right corner of the dialog box.
   The pages or slides continue to advance at the specified interval.
To stop automatic page or slide advancement:

1. If you closed the Automatically Advance Pages dialog box, on the View menu, choose Automatically Advance Pages.
   
The Automatically Advance Pages dialog box appears.
2. Click Stop.

### Animating and adding effects to shared slides

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you can animate text and slide transitions, just as you can when using the Slide Show option in PowerPoint.

**Note:** To show slide animations and transitions, you must share the presentation as a Universal Communications Format (UCF) file (.ucf). The UCF import mode automatically converts a PowerPoint file (.ppt) to a UCF file when you share it. *More (on page 191)*

- For best results when sharing a presentation created using Microsoft PowerPoint 2002 for Windows XP, use a computer with an Intel Celeron or Pentium 500 MHz or faster processor.
- Alternatively, use the keys on your computer keyboard to show animations and slide transitions in a PowerPoint slide presentation. For details, see *Using keyboard shortcuts to control a presentation* (on page 196).
- If at least one meeting participant is using the Java Meeting Manager, animations and slide transitions will not display during the meeting. The meeting host can prevent participants from joining a meeting using the Java Meeting Manager when scheduling the meeting.

To show slide animations and transitions in a shared presentation:

1. Ensure that the content viewer has input focus by clicking in the viewer.
   
The content viewer has input focus if a blue border appears around the outside of the slide in the viewer.
2. On the toolbar, select the appropriate arrows to move through your presentation.

Select the:

- drop-down arrow to select any page or slide
- left arrow to see the previous page or slide
- right arrow to see the next page or slide
Using keyboard shortcuts to control a presentation

When sharing a document or presentation in the content viewer, you can use the keys on your keyboard to display pages or slides. If you are sharing a Microsoft PowerPoint slide presentation, you can also use keyboard keys to show animations on the slides and in slide transitions, just as you can when using the Slide Show option in PowerPoint.

**Note:** Before using keyboard shortcuts, click in the viewer to set the input focus in the content viewer. A blue border around the shared page or slide indicates that the viewer has input focus.

Sharing a Presentation

Use these keystrokes to move quickly through your presentation.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the next slide or perform the next animation or slide transition</td>
<td>Space Bar, Page Down, Right Arrow, or Down Arrow</td>
</tr>
<tr>
<td>Display the previous slide or perform the previous animation or slide transition</td>
<td>Page Up, Left Arrow, or Up Arrow</td>
</tr>
<tr>
<td>Display the first slide</td>
<td>Home</td>
</tr>
<tr>
<td>Display the last slide</td>
<td>End</td>
</tr>
</tbody>
</table>

**Note:** To show animations and slide transitions, you must share the presentation as a Universal Communications Format (UCF) file. The UCF import mode automatically converts a PowerPoint file to a UCF file when you share it. For information about choosing an import mode, see Choosing an import mode for document or presentation sharing (on page 191).

Sharing a Document

Use these keystrokes to move quickly through your document.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the next page</td>
<td>Space Bar, or Page Down, Right Arrow, or Down Arrow</td>
</tr>
</tbody>
</table>
Chapter 14: Sharing Presentations, Documents, and Whiteboards

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the previous page</td>
<td>Page Up, Left Arrow, or Up Arrow</td>
</tr>
<tr>
<td>Display the first page</td>
<td>Home</td>
</tr>
<tr>
<td>Display the last page</td>
<td>End</td>
</tr>
</tbody>
</table>

Working with pages or slides

When sharing a document, presentation, or whiteboard, you can

- Add new, blank pages or slides for annotation *More* (on page 197)
- Paste images that you copy to your computer's clipboard into a new page or slide in a shared document, presentation, or whiteboard *More* (on page 197)

Adding new pages to shared files or whiteboards

When sharing a file or whiteboard in the content viewer, you can add a new, blank page for annotation.

**To add a new page or slide:**

1. In the content viewer, select the tab for the document, presentation, or whiteboard to which you want to add a page or slide.
2. Select **Add Page** from the **Edit** menu.

   A new page appears in the content viewer at the end of the currently selected document, presentation, or whiteboard.

**Tip:** If you have added multiple pages to a shared file or whiteboard tab, you can *view thumbnails* (on page 200) to make it easy to view and navigate around your added pages.

Pasting images in slides, pages, or whiteboards

If you copy any bitmap image to your computer's clipboard, you can paste the image into a new page, slide, or whiteboard in the content viewer.

For example, you can copy an image on a Web page or in an application, then quickly share that image by pasting it in the content viewer.
To paste an image in a page, slide, or whiteboard in the content viewer:

1. In the content viewer, select the tab for the document, presentation, or whiteboard in which you want to paste an image.


The image appears on a new page in the content viewer, at the end of the currently selected document, presentation, or whiteboard.

**Note:** You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF image in the content viewer. However, you cannot paste other types of images—such as EPS or Photoshop (PSD) images—in the content viewer.

**Managing views of presentations, documents, or whiteboards**

All shared presentations, documents, or whiteboards appear in the content viewer in the Meeting window. A tab at the top of the content viewer appears for each document, presentation, or whiteboard that is being shared.

Depending on your role and the privileges that you have, you can do the following when viewing shared content in the content viewer:

- **Magnify** (on page 198) slides, pages, or whiteboards
- **View thumbnails** (on page 200) of slides, pages, or whiteboards.
- **Display a full-screen view** (on page 199) of a page, slide, or whiteboard.
- **Synchronize all participant views** (on page 201) of a page or slide with the view that appears in your content viewer

**Zooming in or out**

Using the tools on the content viewer toolbar, you can:

- Zoom in to or out from on a page, slide, or whiteboard
- Adjust the size of a page, slide, or whiteboard to fit the content viewer
- Adjust the size of a page, slide, or whiteboard to fit it width in the content viewer
- Turn off the Zoom tool at any time

**To zoom in to or out from a page, slide, or whiteboard:**

On the content viewer toolbar:
Chapter 14: Sharing Presentations, Documents, and Whiteboards

- Select the **Zoom In** or **Zoom Out** button, and then drag your mouse to the area. Release your mouse button.

- To zoom in or out to a preset percentage, select the downward-pointing arrow to the left of the **Zoom In/Zoom Out** button, and then choose the percentage.

![Zoom options](image)

To adjust the size of a page, slide, or whiteboard within the content viewer:

On the toolbar, select the downward-pointing arrow to the left of the **Zoom In/Zoom Out** buttons.

![Zoom options](image)

To turn off a zoom tool:

On the toolbar, click the **Zoom In/Zoom Out** button.

### Controlling full-screen view

You can maximize the size of a page, slide, or whiteboard in the content viewer to fit your monitor's entire screen. A full-screen view replaces the normal Meeting window view. You can return to a normal view at any time.

**Note:** If a meeting presenter displays a full-screen view of a page, slide, or whiteboard, participant screens automatically display a full-screen view as well. However, participants can control full-screen view independently in their Meeting windows.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

To display a full-screen view:

On the content viewer toolbar, select the Full Screen icon.

To return to a normal view:

On the Meeting Controls Panel, select the stop icon to return to the main window.

Viewing thumbnails

You can view thumbnails of the shared pages, slides, and whiteboards that appear in the content viewer. Viewing thumbnails can help you to locate quickly a shared page or slide that you want to display in the content viewer.

To view thumbnails of slides, pages, or whiteboards:

1. In the content viewer, select the tab for the document, presentation, or whiteboard for which you want to view thumbnails.

2. On the content viewer toolbar, select Show Thumbnails from the View menu.

Thumbnails of all pages or slides in the selected document, presentation, or whiteboard appear in the thumbnail viewer, in the left column.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

3 Optional. To display any page or slide in the content viewer, double-click its miniature in the thumbnail viewer.

**Note:** Participants must have both the View thumbnails and View any page privileges to display a miniature of a page or slide at full size in the content viewer.

To close the thumbnail viewer:
On the content viewer toolbar, select Hide Thumbnail from the View menu.

**Synchronizing all participant views**

You can synchronize the display of a shared page, slide, or whiteboard in all participant content viewers with the display in your viewer. Once you synchronize displays, the page, slide, or whiteboard in participant content viewers appears at the same magnification as in your content viewer.

**To synchronize participant views of slides, pages, or whiteboards:**
On the View menu at the bottom of the window, select Sync Display for All.
Clearing annotations

You can clear any annotations that you or another attendee makes on a shared page, slide, or whiteboard in the content viewer. You can clear:

- All annotations at once
- Only specific annotations
- If you are the presenter or host, clear all annotations you have made

To clear all annotations on a shared page, slide, or whiteboard:

1. On the annotation toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.

2. Choose Clear All Annotations.

Note: Only annotations on the page or slide that currently appears in your content viewer are cleared. Annotations on other pages or slides are not cleared.

If you are the host or presenter, you can clear all the annotations you've made.

To clear all annotations you have added to a shared page, slide, or whiteboard:

1. On the annotation toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.

2. Choose Clear My Annotations.

To clear specific annotations on a shared page, slide, or whiteboard:

1. On the toolbar, click the Eraser Tool icon.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

Eraser tool

Your mouse pointer changes to an eraser.

2 Click the annotation you want to clear.

To turn off the eraser tool:

On the toolbar, click the Eraser Tool icon.

Clearing pointers

You can clear your own pointers on all shared slides, pages, or whiteboards in the content viewer. If you are a presenter, you can also clear all participant pointers.

To clear your own pointer on all shared slides, pages, or whiteboards:

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.

2 Choose Clear My Pointer.

Saving, opening, and printing presentations, documents, or whiteboards

Meeting participants (hosts, presenters, and participants with privileges) can access and print documents, presentations, and whiteboards shared in a meeting. For example, you can:

 save a shared presentation More (on page 204)
Saving a presentation, document, or whiteboard

You can save any shared document, presentation, or whiteboard that appears in the content viewer. A saved file contains all the pages or slides in the document, presentation, or whiteboard that is currently displayed in the content viewer, including any annotations and pointers that you or other attendees added to them.

Files that you save are in the Universal Communications Format (UCF), which have a .ucf extension. You can open a .ucf file either in another meeting or at any time outside of a meeting.

Once you save a new document, presentation, or whiteboard to a file, you can save it again to overwrite the file or save a copy to another file.

**To save a new document, presentation, or whiteboard that appears in the content viewer:**

1. On the **File** menu, choose **Save > Document**.
   The Save Document As dialog box appears.
2. Choose a location at which to save the file.
3. Type a name for the file in the **File name** box.

**To save changes to a saved document, presentation, or whiteboard that appears in the content viewer:**

On the **File** menu, choose **Save > Document**.
Meeting Manager saves the changes to the existing file.

**To save a copy of a document, presentation, or whiteboard:**

1. On the **File** menu, choose **Save As > Document**.
   The Save Document As dialog box appears.
2. Do **either or both** of the following:
   - Type a new name for the file.
   - Choose a new location at which to save the file.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

Opening a saved document, presentation, or whiteboard

If you saved a document, presentation, or whiteboard that appeared in the content viewer during a meeting, you can do either of the following:

- Open file in the content viewer during another meeting for sharing. Only a presenter or participants who have the Share documents privilege can open a saved file during a meeting.
- Open the file at any time on your computer's desktop. If you open a saved file on your desktop, it appears in the WebEx Document Manager, a standalone, or “offline,” version of the content viewer.

A saved document, presentation, or whiteboard is in the saved Universal Communications Format (UCF) and has a .ucf extension.

To open a saved document, presentation, or whiteboard file in the content viewer:

1. On the File menu, choose Open and Share.
   The Share Document dialog box appears.
2. Select the document, presentation, or whiteboard file that you want to open.
3. Click Open.

To open a saved document, presentation, or whiteboard on your computer's desktop:

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document Viewer.

Printing presentations, documents, or whiteboards

You can print any shared presentations, documents, or whiteboards that appear in your content viewer. A printed copy of shared content includes all annotations and pointers that you or other participants added to it.

To print shared content:

1. In the content viewer, select the tab for the document, presentation, or whiteboard that you want to print.
3. Select the printing options that you want to use, and then print the document.
Note: When printing shared content in the content viewer, Meeting Manager resizes it to fit on the printed page. However, for whiteboards, the Meeting Manager prints only the content that lies within the dashed lines on the whiteboard.

If you are a meeting participant...

If you are participating in a meeting, (and have not taken on another role, such as host or presenter), you can move around independently in shared documents and presentations, if the host has assigned these privileges to you. For shared documents, presentations, and whiteboards, you can:

- display any page More (on page 206)
- synchronize your view with the host's view More (on page 207)
- save shared documents More (on page 204)
- open shared documents More (on page 205)
- print shared documents More (on page 205)

Displaying pages, slides, or whiteboards

For participants

If you have been granted the necessary privileges, you can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on a at the top of the content viewer.

1 In the Meeting window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.

   If there are more tabs than can appear at one time, select the down arrow button to see a list of remaining tabs, or use your keyboard arrows forward and back through all the tabs.

2 On the toolbar, click a button to change the page or slide you are viewing.
Chapter 14: Sharing Presentations, Documents, and Whiteboards

Select the
- drop-down arrow to choose any page or slide
- left arrow to see the previous page or slide
- right arrow to see the next page or slide

If Microsoft PowerPoint slides are being shared, the drop-down list also displays the title of each slide.

**Synchronizing your view of pages, slides, or whiteboards**

During a meeting, you can synchronize the display of shared content in your content viewer with the display in the presenter's viewer. This option is useful, for example, if you are viewing a previous slide in a presentation and want to quickly return to the actual slide that the presenter is discussing. Synchronizing your display also resizes it to that in the presenter's content viewer.

**To synchronize your view of shared content in the presentation viewer:**

On the **View** menu at the bottom of the window, select **Sync Display With Presenter**.
Sharing Web Content

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sharing Web content</td>
<td>About sharing Web content (on page 209)</td>
</tr>
<tr>
<td>share Web content with meeting participants</td>
<td>Sharing Web content (on page 210)</td>
</tr>
<tr>
<td>understand the differences between sharing a browser and sharing Web content</td>
<td>Differences between sharing Web content and sharing a Web browser (on page 210)</td>
</tr>
</tbody>
</table>

About sharing Web content

You can share Web content that resides on:

- The public Internet or Web
- Your company's intranet
- Your computer or another computer on your private network

Web content includes:

- Web pages, including pages that contain embedded media files, such as Flash, audio, or video files
- Standalone media files, such as Flash, audio, or video files

The Web content that you share opens in the content viewer on each participant's screen. If you share a Web page, participants view and interact independently with the content on the page. If the page contains links to other pages, they can also navigate independently to those pages.
If you use Web content sharing, then, participants can experience audio and video effects on a Web page. However, unlike Web browser sharing, this option does not allow you to guide participants to other Web pages. For more information, see *Differences between sharing Web content and sharing a Web browser* (on page 210).

**Important:** If you share content that requires a media player, participants can view and interact with the content only if the appropriate player is installed on their computers.

### Sharing Web content

You can share a Web page that contains multimedia effects. The page opens in the content viewer on each participant's screen.

**To share Web content:**

1. On the *Share* menu, choose *Web Content*.
   The Share Web Content dialog box appears.
2. In the *Address* box, enter the address, or URL, at which the content resides.
   Or, if you have previously shared the content, select it in the drop-down list.
3. In the *Type* box, select the type of Web content that you want to share.
4. Click *OK*.

**Tip:** You can copy a URL from any source, such as another browser window, and then paste it in the *Address* box.

### Differences between sharing Web content and sharing a Web browser

Meeting Center provides two options for sharing Web-based information. You can share Web content or share a Web browser with meeting participants. Choose the feature that better suits your needs.
## Chapter 15: Sharing Web Content

<table>
<thead>
<tr>
<th>Sharing option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser sharing</td>
<td>• Lets you guide participants to various Web pages and sites on the Web.</td>
<td>• Does not display media effects or transmit sounds on Web pages.</td>
</tr>
<tr>
<td></td>
<td>• Lets you grant attendees control of your Web browser.</td>
<td>• Does not let participants interact with Web pages independently.</td>
</tr>
<tr>
<td></td>
<td>• Lets you and other participants annotate Web pages.</td>
<td></td>
</tr>
<tr>
<td>Web content sharing</td>
<td>• Displays Web pages, and lets participants experience media effects on Web pages, including video and sound.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Lets participants interact with Web pages independently in their content viewers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not let you guide participants to other Web pages.</td>
</tr>
</tbody>
</table>
Sharing Software

Sharing a tool, like a software application, works differently from sharing a document or presentation. When you share software during a meeting, a sharing window opens automatically on all participant screens. You can show, in this special sharing window:

- **an application** (for example, you want to edit a document as a group or show your team how a tool works)
- **computer desktop** (for easily sharing several applications at once and for sharing file directories open on your computer)
- **Web browser** (useful for sharing particular Web pages with participants or showing a private intranet)
- **any application or the desktop on a remote computer with Access Anywhere installed on it** (for example, you are on the road, and the computer in your office has the information you need)

Your user role in a meeting determines your level of participation in sharing software. Whichever role you take, this table describes the basic tasks associated with that role. For detailed instructions on a particular task, select "More" by the task description.
### Sharing applications

You can use application sharing to show all meeting participants one or more applications on your computer. Application sharing is useful for demonstrating software or editing documents during a meeting.

Participants can view the shared application, including all mouse movements without having to run the application that you are sharing on their computers.
Here are just a few tasks you can perform:

- Start sharing an application More (on page 215) and open more applications to share More (on page 216)
- Control the appearance and viewing of shared software (pausing, changing to full-screen view, and so on) More (on page 229)
- Annotate and draw on a shared application More (on page 236) and allow participants to draw More (on page 239)
- Learn about sharing application effectively More (on page 248)
- Stop sharing an application More (on page 217)

Starting application sharing

Host or Presenter only

You can share any application on your computer with meeting participants.

To share an application:


   The list of all applications currently running on your computer is displayed.

   ![Application Sharing Menu]

   - My Desktop
   - Document from My Computer...
   - Application
     - Whiteboard
     - Web Content…
     - Web Browser
     - Remote Computer…
   - My Meeting Window

   Running Application:
   - svr-termjc2 - Remote Desktop
   - Microsoft Excel - Merge.xlx
   - WebEx Meeting Center - Google Chrome
   - My Computer
   - Windows Explorer
   - Other Application…

2. Do one of the following:

   - If the application you want to share is currently running, select it in the list to begin sharing it.
Chapter 16: Sharing Software

- If the application you want to share is not currently running, select Other Application. The Other Application dialog box appears, showing a list of all applications on your computer. Select the application, and then select Share.

  Your application appears in a sharing window on participant screens.

  For tips that can help you to share applications more effectively, see Tips for Sharing Software (on page 248).

Sharing several applications at once

Host or Presenter only

If you are already sharing an application, you can share additional applications simultaneously. Each application that you share appears in the same sharing window on participant screens.

To share an additional application:

Select the application you want to share:

- **If that application is currently running**: Select the Share button.

  Each application you have open on your desktop has these buttons in the upper right corner.

  Tip: When you open any application that you have minimized, it opens with the sharing buttons in the upper-right corner.

- **If that application is not currently running**: Select the Share Application button in the Meeting Controls Panel. You can also find it using File Explorer or any other tool you use to locate applications on your computer. When you open it, it appears with the Share button.

  Your application appears in a sharing window on participant screens.

  Meeting Center tracks the number of applications you are currently sharing:

  Tip: Alternatively, you can share multiple applications by sharing your computer's desktop. For details, see Sharing your desktop. (on page 217)
Stopping application sharing for all participants

Host or Presenter only

You can stop sharing an application at any time. Once you stop sharing an application, participants can no longer view it.

If you are sharing multiple applications simultaneously, you can stop sharing either a specific application or all applications at once.

To stop sharing a specific application when sharing multiple applications:

On the title bar of the application that you no longer want to share, select the Stop button.

To stop sharing all applications:

In the Meeting Controls box, select the STOP button.

You can also pause sharing: Select the Pause button (located next to the Stop button).

Sharing your desktop

You can share the entire content of your computer, including any applications, windows, and file directories that reside on it. Participants can view your shared desktop, including all mouse movements.

Tasks related to sharing your desktop:

- Start sharing your desktop More (on page 218)
- Manage how participants view your shared software (pausing, changing to full-screen view, and so on) More (on page 229)
- Annotate and draw on your desktop More (on page 236) and allow participants to annotate More (on page 239)
- Read a few tips for sharing your desktop effectively More (on page 248)
Chapter 16: Sharing Software

- Stop sharing your desktop More (on page 218)
- Allow a participant to control the shared desktop More... (on page 239)

Starting desktop sharing

*Host or Presenter only*

You can share your computer’s desktop with meeting participants.

**To share your desktop:**

   If you have more than one monitor, a submenu shows the available monitors.

2. Select the monitor to share.
   Your desktop appears in a sharing window on participants’ screens.
   For ideas that can help you to share your desktop more effectively, see *Tips for Sharing Software*. (on page 248)

   **Note:** If your desktop has any background images or patterns, or wallpaper, your Meeting Manager software may remove them from participant views to improve the performance of desktop sharing.

Stopping desktop sharing

You can stop desktop sharing at any time.
To stop sharing your desktop:
In the Meeting Controls box, select the **Stop** button.

You can also pause sharing: Select the **Pause** button (located next to the **Stop** button).

If you are a participant, rather than the presenter, select the **Return** button to leave the sharing session.

You do not leave the meeting, just the sharing portion of it.

### Sharing a Web browser

A presenter uses Web browser sharing to show all meeting participants all Web pages that he or she accesses in a browser. Web browser sharing is useful for showing participants Web pages on the Internet, or the presenter's private intranet or computer.

Participants can view the presenter's Web browser, including mouse movements, in a sharing window on their screens.

**Tasks related to sharing a Web browser:**
- Start sharing a web browser *More* (on page 219)
- Manage how participants view the shared Web browser *More*
- Annotate and draw on a shared Web browser *More* and let a participant draw on a shared Web browser *More*
- Learn how to share Web browsers effectively *More* (on page 248)
- Stop sharing a Web browser *More* (on page 220)

### Starting Web browser sharing

*Host or Presenter only*

You can share a Web browser with meeting participants.

**To share a Web browser:**

1. On the **Share** menu, choose **Web Browser**.

Your default Web browser opens.
2 Go to a Web page in your browser.

**Note:** Participants view all new Web browser windows that you open. You can show participants several Web pages simultaneously.

### Stopping Web browser sharing

You can stop sharing a Web browser at any time.

**To stop Web browser sharing:**

On the title bar of the application that you no longer want to share, select the **Stop** button.

![Stop button](image)

**Tip:** You can temporarily pause Web browser sharing, rather than stopping Web browser sharing. For details, see *Pausing and resuming software sharing* (on page 230).

### Sharing a remote computer

A presenter uses remote computer sharing to show all meeting participants a remote computer. Depending on how the remote computer is set up, the presenter can show the entire desktop or just specific applications. Remote computer sharing is useful to show participants an application or file that is available only on a remote computer.

Participants can view the remote computer, including all the presenter's mouse movements, in a sharing window on their screens.

As presenter, you can share a remote computer during a meeting if:

- You have installed the Access Anywhere Agent on the remote computer
- You logged in to your Meeting Center Web site before joining the meeting, if you are not the original meeting host

For information about setting up a computer for remote access, refer to the *Access Anywhere User's Guide*.

Tasks related to sharing a remote computer:

- Start sharing a remote computer *More* (on page 221)
- Manage how and what participants view on the shared remote computer (pausing, changing to full-screen view, and so on) *More* (on page 229)
Chapter 16: Sharing Software

- Change settings on a remote computer while sharing it More (on page 224)
- Stop sharing a remote computer More (on page 223)

Starting remote computer sharing

Host or Presenter only

If you have already set up a computer for Access Anywhere, you can share the computer during a meeting.

To share a remote computer:

2. The Access Anywhere dialog box appears.
3. Under Remote Computers, select the computer you want to share.
4. Under Applications, select an application that you want to share.
   - If you set up the remote computer so you can access its entire desktop, the option Desktop appears under Applications.
5. Select Connect.

Depending on the authentication method you chose when you set up the computer for Access Anywhere, you perform one of these tasks:

- If you chose access code authentication: You enter the access code you typed when you set up the remote computer.
Chapter 16: Sharing Software

- If you chose phone authentication: You receive a phone call at the number that you entered when you set up the remote computer.

6 Complete your authentication.

- If you chose access code authentication: Type your access code in the box, and then select OK.

- If you chose phone authentication: Follow the voice instructions.

Note:

- If you are not the original meeting host, you must log in to your Meeting Center Web site before joining a meeting in which you want to share a remote computer. If you are already in a meeting, but did not log in to your site, you must leave the meeting, log in to your site, and then rejoin the meeting.

- If a password-protected screen saver is running on the remote computer, your meeting service automatically closes it once you provide your access code or pass code.

- If the remote computer is running Windows 2000, and you must log in to the computer, send a Ctrl+Alt+Del command to the computer.

- If you set up the remote computer so you can access multiple applications, you can share additional applications simultaneously.

### Sharing additional applications on a shared remote computer

*Host or Presenter only*

While sharing a remote computer on which you have specified that you can access only specific applications rather than its entire desktop, you can share additional applications on the remote computer. Meeting participants can view all shared applications simultaneously.

**To share an additional application on a shared remote computer:**

1 On the Meeting Controls Panel, select the down arrow button (it is the last button on the Meeting Controls Panel). Then choose Share Remote Application.
2 In the Select Application box, select the application you want to share.

After you choose another application to share, all previously selected applications remain open.

**Example:** You opened the Paint application first. Then you chose Notepad from the Select Application box. Both applications remain open on the shared desktop.

3 Select OK.

**Stopping remote computer sharing**

.Host or Presenter only

You can stop sharing a remote computer during a meeting at any time. Once you stop sharing a remote computer, the Access Anywhere Server disconnects your local computer from the remote computer. The remote computer remains logged into the Access Anywhere Server, so you can access it again at any time.
Before you stop remote computer sharing:

To ensure your privacy and the security of your remote computer, do one of the following:

- Close any applications that you started during the sharing session.
- If the remote computer is running Windows 2000, and you have administrator rights on the computer, log off from or lock the computer. To access these options on the computer, send a Ctrl+Alt+Del key combination to the remote computer
  
  More... (on page 228)
- Specify a screen saver password, and set the screen saver to appear after short period of inactivity—for example, 1 minute.
- Shut down the computer, if you do not plan to access it again remotely.

To stop remote computer sharing:

On the Meeting Controls Panel, select Stop Sharing.

Sharing stops and you return to Meeting Manager.

**Managing a shared remote computer**

*Host or Presenter only*

While sharing a remote computer during a meeting, you can manage the remote computer by setting options and sending commands.

**Options you can set:**

- Disable or enable the keyboard and mouse on the remote computer More (on page 226)
- Reduce the screen resolution on the remote computer to match that of your computer, or restore the resolution on the remote computer More (on page 225)
- Adjust the size of the view of the remote computer that appears in the sharing window, including zooming in to and out from the view and scaling the view to fit the sharing window More (on page 227)
- Hide or display the contents on the remote computer's screen at the remote location More (on page 227)
Chapter 16: Sharing Software

**Note:** Any changes that you make to options affect the remote computer only during the current sharing session. The changes do not affect the default options that you set for the remote computer in the Access Anywhere Agent preferences.

Commands you can send:

- **Ctrl+Alt+Del** key combination, which allows you to access options to log in to, log out from, lock, or unlock a Windows PC *More* (on page 228)
- A command to bring remote applications to the front of your screen, if they are either behind other applications or minimized *More* (on page 228)

**Reducing the screen resolution for a shared remote computer**

While sharing a remote computer, you can reduce the screen resolution on the remote computer. This option helps to prevent the need to scroll while viewing the desktop or applications on the remote computer. The reduced screen resolution also appears in all participant sharing windows. You can return a remote computer's screen resolution to its original setting at any time during a remote access session.

To reduce the screen resolution on a remote computer:

On the Meeting Controls Panel, select the down arrow button (it is the last button on the Meeting Controls Panel). Then choose **Reduce Screen Resolution to Match This Computer**.

**Note:**
- If you reduce the screen resolution a remote computer during a sharing session, the Access
Anywhere Agent restores the resolution to its original setting once you end the session.
- You can specify whether or not the remote computer’s screen resolution is reduced automatically once you connect to the computer remotely. For details, refer to the Access Anywhere User’s Guide.

Disabling and enabling the keyboard when sharing a remote computer

**Host or Presenter only**

While sharing a remote computer, you can disable the keyboard and mouse on the remote computer, thereby preventing anyone from using the computer while you are accessing it remotely. You can re-enable a remote computer’s keyboard and mouse at any time.

**To disable or enable a remote computer’s keyboard and mouse:**

On the Meeting Controls Panel, select the down arrow. Then choose **Disable Keyboard and Mouse**.

A check mark next to the command indicates that the keyboard and mouse are disabled. If no check mark appears, the keyboard and mouse are enabled.

**Note:**
- If you disable a remote computer's keyboard and mouse during a sharing session, the Access Anywhere Agent re-enables them once you end the session.
- You can specify whether or not the remote computer’s keyboard and mouse are disabled automatically once you connect to the computer remotely. For details, refer to the Access Anywhere User’s Guide.
Adjusting the size of the view of a shared remote computer

*Host or Presenter only*

While sharing a remote computer, you can adjust the size of the shared view using one of these methods:

- Select a preset percentage at which to view the remote computer.
- Zoom in to and out from the remote computer in increments.
- Scale the remote computer view to fit the sharing window in which it appears.

To adjust the size of the view of a shared remote computer:

On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose **View**. Choose a display option from the menu.

![Meeting Controls Panel](image)

Hiding the contents on a shared remote computer's screen

*Host or Presenter only*

While sharing a remote computer, you can make a remote computer's screen blank, thereby preventing anyone at the remote computer's location from viewing the contents of the screen. If the contents on a remote computer's screen are hidden, you can display them at any time.
To hide or display the contents on a remote computer's screen:

On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose Make Screen Blank.

A check mark next to the command indicates that the contents on the remote computer's screen are not visible. If no check mark appears, the contents on the remote computer's screen are visible.

**Note:**
- If you make a remote computer's screen blank during a sharing session, the Access Anywhere Agent displays the contents on the screen once you end the session.
- You can preset the remote computer screen to be blank after you connect to it. For details, refer to the Access Anywhere User's Guide.

Sending a Ctrl+Alt+Del command to a shared remote computer

*Host or Presenter only*

While sharing a remote computer that is running Windows, you can send an Ctrl+Alt+Del command to the computer to access options that let you:

- **Log in** to the computer
- **Log out** from the computer
- **Lock** the computer
- **Unlock** the computer

To send a Ctrl+Alt+Del command to a shared remote computer:

On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose Make Screen Blank. Send Ctrl+Alt+Del.

Selecting an application on a shared remote computer

*Host or Presenter only*

If you have set up a remote computer to share only selected applications, rather than the entire desktop, you can only work with one application at a time. You can easily switch and share a different application.
To choose a different application to share:

On the Meeting Controls panel, select the down arrow. Then choose **Share Remote Application**.

Select the application you want to share from the list of available application.

---

Controlling views of shared software

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host or Presenter</strong></td>
<td>- Pause or resume sharing More</td>
</tr>
<tr>
<td></td>
<td>- Control full-screen view of shared software <em>More</em> (on page 229)</td>
</tr>
<tr>
<td></td>
<td>- Synchronize views <em>More</em> (on page 231)</td>
</tr>
</tbody>
</table>
Chapter 16: Sharing Software

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participant</td>
<td>▪ Control your view of shared software \textit{More} (on page 234)</td>
</tr>
<tr>
<td></td>
<td>▪ Close your sharing window \textit{More} (on page 235)</td>
</tr>
</tbody>
</table>

The presenter can control participant views of a \textit{shared desktop}, \textit{remote computer} (if available), \textit{application} or \textit{Web browser}.

Participants can manipulate their individual displays of the shared software

**Pausing and resuming software sharing**

\textit{Host or Presenter only}

While sharing software, you can temporarily pause sharing to freeze attendees' views.

If you want to return attendees to the Meeting window while sharing software, pausing shared software conserves resources on your computer and bandwidth for your Internet connection. This option is also useful if you do not want attendees to see certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

**To pause software sharing:**

Select the \textbf{Pause} button, located to the right of the \textbf{Stop} button.
The word "Paused" now appears in the panel. A short message is displayed indicating that the participant view would be frozen until you resume sharing. Additionally, the Pause button text changes to Resume.

To resume software sharing:
Select the Resume button.

Controlling full-screen view of shared software

Host or Presenter only

You can switch participant views of a shared application, remote computer (if available), or Web browser between a standard window and a full-screen view.

A full-screen view of shared software fits participant entire screens and does not include a title bar or scroll bars.

Participants can override your setting to control full-screen view or to zoom in or out on the shared software on their computers.

To display shared software in a full-screen view:
On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose View. Then choose Full screen for Participants.

Synchronizing views of shared software

Host or Presenter only

While sharing an application, desktop (if desktop sharing is available), or Web browser, you can synchronize all participant views of the software with your view.
Synchronizing views of shared software ensures that the sharing window appears as the active window on participant screens. For example, if a participant has minimized the sharing window, or moved another window on top of it, the sharing window becomes the active window when you synchronize views.

**Note:** Synchronizing views has no effect on the size in which the shared software appears on participant screens. Participants can control the size of their views independently.

**To synchronize your view with participants:**

On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose **View.** Then choose **Synchronize for All.**

**Selecting a monitor to share**

**To select a monitor to share:**

1. Start sharing your desktop:
   - On the Quick Start page, select **Share Desktop.**
     If two or more monitors are detected on your system, a window appears and allows you to select one of the monitors.
   - On the **Share** menu, select **Desktop.**
     A submenu shows the available monitors.
2 Select the monitor you want to share.

The Meeting Controls Panel indicates which monitor you are sharing. If you are sharing the same monitor where the Meeting Controls Panel is, it says, "You are sharing this monitor."

If you are sharing a monitor that is not the same monitor where the Meeting Controls Panel is, it says, "You are sharing monitor <number>." 

In addition, a green border appears around the monitor you are sharing.

To select a different monitor to share:

1 On the Meeting Control Panel, select the Select Content to Share button.

2 In the submenu that appears, select Share Desktop.

A submenu shows you the available monitors.
3 Select the monitor number you want to share.

The Meeting Controls Panel indicates which monitor you are sharing. In addition, a green border appears around the monitor you are sharing.

**Controlling your view as a participant**

*Participant only*

When viewing or remotely controlling shared software, you can set these options, which determine how shared software appears on your screen:

- Display the shared software in a full-screen view or a standard window. A full-screen view of a shared application or desktop fits your entire screen and does not include a title bar or scroll bars.
- Scale, or resize, a shared desktop or application to fit the full-screen view or standard window in which it appears.

**To control your view of shared software:**

On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose **View**. Then choose an option from the menu.
Tip: To switch quickly from the standard window to a full-screen view of shared software, double-click the shared software.

Closing your participant sharing window

Participant only

While viewing or remotely controlling shared software, you can close the sharing window in which the software appears at any time. Closing a sharing window returns you to the Meeting window. If you close a sharing window, you can reopen it at any time.

To close a sharing window:

1. On the Meeting Controls Panel, select the down arrow (the last button on the panel) and then choose Stop <option> from the menu. The following graphic shows the Stop Application Sharing option because an application has been shared. If you have shared your desktop or Web Browser, the menu would show Stop Desktop Sharing.

2. Choose the appropriate option.

The sharing window closes. The Meeting window then automatically opens.

To return to the sharing window at any time:

In the Meeting window, on the Sharing menu, select a sharing option (desktop, remote computer, application or Web browser).

Switching your participant view

Participant only
While a presenter is sharing software, you can return to the Meeting window at any time. The sharing window remains open on your computer, so you can return to viewing the shared software at any time.

**To return to the Meeting window while the presenter is sharing software:**

On the Meeting Controls Panel, select the **Return to Meeting Window** icon.

The Meeting window then appears.

**To return to a sharing window:**

In the Application Share dialog box, which appears in the Meeting window, select **Return to Sharing**.

---

### Annotating shared software

**Task description:**

- Host or Presenter
  - Start or stop annotation mode *More* (on page 237)
  - Use annotation tools *More* (on page 238)
  - Let a participant use annotation *More* (on page 239)
  - Save annotations *More* (on page 242)
Chapter 16: Sharing Software

Task description:

- Ask for permission to use annotation More (on page 240)
- Use annotation tools More (on page 238)
- Save annotations More (on page 242)
- Give up annotations More (on page 241)

You can annotate a shared desktop, application or Web browser during a meeting, using the highlighter or other annotation tool.

Meeting participants can see annotations in their sharing windows.

Starting and stopping annotation

*Host or Presenter only*

When you are sharing a desktop, application or Web browser, you can make annotations on the software.

Participants can see all your annotations.

**To start annotating shared software:**

1. On the Meeting Controls panel, select the **Annotate** button.

   The Annotation button has the image of a pencil on it.

   The Tools panel appears.

2. Select a tool for making annotations.

   For details about annotation tools, see *Using annotation tools* (on page 238).

**Note:**
You can let one or more participants annotate the shared software. For details, see *Copy of Letting a participant annotate shared software* (on page 239).

Once you or a participant makes annotations, you can save an image of the software, including the annotations. For details, see *Taking a screen capture of annotations on shared software* (on page 242).

To stop making annotations on shared software and return your mouse to a normal pointer, you must stop annotation mode.

**To stop annotation mode:**

Select the **Stop Annotating** button in the **Tools** panel.

---

**Using annotation tools**

If, while sharing software, you are the presenter or the presenter allows you to annotate, you can use the Annotation Tools panel that appears to make annotations. The Annotation Tools panel provides a variety of tools for annotating a shared desktop or application.

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pointer</strong></td>
<td>![Pointer Icon]</td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>![Text Icon]</td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the <strong>Edit</strong> menu, choose <strong>Font</strong>. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Annotation Tool</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Line</td>
<td><img src="image" alt="Line Icon" /></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="image" alt="Rectangle Icon" /></td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td><img src="image" alt="Highlighter Icon" /></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Annotation Color</td>
<td><img src="image" alt="Annotation Color Icon" /></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td><img src="image" alt="Eraser Icon" /></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

**Letting a participant annotate shared software**

*Host or Presenter only*

You can let one or more meeting participants annotate a shared desktop (if available), application or Web browser.

You can let several participants annotate shared software at the same time.

**To let a participant annotate shared software:**

1. On the Meeting Controls Panel, select the **Annotate** icon.

The tools panel appears.
Chapter 16: Sharing Software

2  Select the down arrow on the Allow to Annotate button.

3  On the menu that appears, choose which participants can annotate the shared software:

You can choose "All" or select someone from the list.

Note:
- You can stop a participant from annotating shared software at any time. For details, see Stopping a participant from annotating shared software. (on page 241)

Requesting annotation control of shared software

Participant only

If a presenter is sharing a desktop, Web browser or application, you can ask the presenter to allow you to annotate the shared software.

After you have permission, you can:
- Make annotations by highlighting areas on the software, drawing lines and shapes, typing text, and using pointers.
- Clear annotations at any time.
- Change the color that you are using to make annotations.
- Save an image of your annotations on the shared software.

To request annotation control of shared software:

1  In the Meeting Controls Panel, select the Annotate button.

A request message appears on the presenter's screen.

After the presenter allows you to annotate, the Annotation Tools panel appears:
2 Select the tool you want to use.

3 Optional. Choose another annotation tool. For details, see *Using annotation tools* (on page 238).

**Note:** If you are controlling shared software remotely, the presenter must take back control to turn on annotation mode. You and the presenter can then annotate the shared software simultaneously.

### Giving up annotation control

**Participant only**

If the presenter has granted permission to you to annotate, you can stop annotating at any time.

**To stop annotating:**

In the Annotation Tools panel, select the *Stop Annotating* button.

### Stopping an participant from annotating shared software

**Host or Presenter only**

If a participant is annotating shared software, you can turn off the annotation feature.

**To turn off the drawing feature:**

1 On the Meeting Controls Panel, select the *Assign Control* button.
2 On the menu that appears, choose Allow to Annotate.
   A check mark appears next to the names of those who can annotate the shared software.
3 Choose the name of the participant to cancel the selection.

Taking a screen capture of annotations on shared software

If you make annotations on shared software, you can save an image of the shared software, including all annotations and pointers, to a WebEx Universal Communications Format (.ucf) file. You can open a .ucf file on your computer desktop or in the content viewer in a meeting.

**Note:** Participants cannot use this option unless the Host or Presenter grants the Screen Capture privilege to them. As Host, if you are sharing proprietary software, you may want to ensure that this privilege is turned off.

To take a screen capture of annotations on shared software:

1 On the Tools panel, select the Screen Capture button.

   ![Screen Capture button](image)

   The Save As dialog box appears.

2 Choose a location at which to save the file, and then select Save.

**Note:** The file you save is an image of your entire desktop.

Granting participants control of shared software

While sharing the following types of software, the presenter can let a participant control it remotely:

- Application
- Desktop (if available)
- Web browser
A participant who has remote control of shared software can interact with it fully. While a participant is controlling shared software, the presenter's mouse pointer is inactive.

Rules of thumb for controlling shared software:

- Any participant can send a request to control the software remotely. More (on page 243)
- The presenter can then grant control to the participant. More (on page 244)
- Alternatively, the presenter can automatically grant control of shared software to any participant who requests remote control. More (on page 244)
- The presenter can stop a participant from remotely controlling shared software at any time. More (on page 245)

**Caution:** A participant who has remote control of the presenter's desktop can run any programs and access any files on the computer that the presenter has not protected with a password.

### Requesting remote control of shared software

*Participant only*

If the presenter is sharing an application, desktop, or Web browser, you can ask the presenter to grant remote control to you.

Once you assume remote control of shared software, you can interact with it fully.

To request remote control of shared software:

On the Meeting Controls Panel select **Ask to Control**.

A request message appears on the presenter's screen.

**Tip:** While remotely controlling shared software, you can request the presenter to allow you to annotate it. For details, see *Requesting annotation control of shared software.* (on page 240)
Letting a participant remotely control shared software

*Host or Presenter only*

If you are sharing software, you can let a participant control it remotely.

**To let a participant remotely control shared software:**

1. On the Meeting Controls Panel select the down-arrow button on the **Assign** button.

   ![Assign button](image)

   This button is the third button from the left on the Controls panel.

2. On the menu that appears, choose Pass Keyboard and Mouse Control > [name of participant].

Automatically letting participants remotely control shared software

*Host or Presenter only*

While sharing software, you can automatically grant control of the software to a participant who requests control. In this case, a participant who requests remote control automatically takes control of the software that you are sharing. While automatic remote control is turned on, any participant can take control away from any other participant by requesting remote control.

**To automatically let participants control shared software:**

1. On the Meeting Controls Panel select the down-arrow button on the **Assign** button.
On the menu that appears, choose Pass Keyboard and Mouse Control > Auto Accept All Requests.

To stop letting participants control shared software automatically:

1. On the Meeting Controls Panel select the down-arrow button on the Assign button.

2. On the menu that appears, choose Pass Keyboard and Mouse Control. Then select Auto Accept All Requests to remove the check mark and cancel the selection.

**Stopping remote control of shared software**

*Host or Presenter only*

While a participant is remotely controlling a shared application, desktop, or Web browser, you can take back control of the shared software at any time. You can do either of the following:

- Take back remote control of shared software temporarily, allowing a participant to take control at any time.
- Prevent a participant from further controlling shared software.

**To take back control a shared software temporarily:**

On your computer's desktop, select your mouse.

You can now control the shared software.

The participant who was controlling the shared software can take back control at any time by clicking his or her mouse.

**To prevent a participant from further controlling a shared software:**

1. On your computer's desktop, click your mouse.
You can now control the shared software.

On the Meeting Controls Panel select the down-arrow button on the Assign button.

2 On the menu that appears, choose **Pass Keyboard and Mouse Control**. A menu appears, containing a list of all participants in the meeting. A check mark appears to the left of the participant who has remote control.

3 Choose the participant's name to remove the check mark and cancel the selection.

### Sharing applications with detailed color (Windows)

*For Windows users only*

By default, Meeting Manager sends images of shared software using 16-bit color mode, which is the equivalent of your computer's “High Color” (16-bit) setting. This mode provides an accurate representation of color for most shared applications. However, if your shared application contains detailed color images—such as color gradients—the color may not appear accurately on participants' screens. For example, color gradients may appear and color “bands.”

If the accuracy and resolution of color in a shared application is important, you can turn on True Color mode in Meeting Manager. Using this mode, however, may affect the performance of application sharing.

When using True Color mode, you can select one of the following options:

- Better imaging (no image compression)
- Better performance (some image compression)

“Performance” refers to the “speed” at which images appear on participant screens, and “imaging” refers to the quality of the color in shared images.
Chapter 16: Sharing Software

Note: Before turning on True Color mode, ensure that your monitor display is set to True Color (either 24- or 32-bit color). For more information about setting options for your monitor, refer to Windows Help.

To turn on True Color mode:
1 If you are currently sharing an application, stop your sharing session.
2 On the Meeting menu, choose Meeting Options.
   The Meeting Options dialog box appears.
3 Select the True Color Mode tab.
4 Select Enable True Color mode.
5 Select one of the following options:
   - Better imaging
   - Better performance
6 Select OK or Apply.

Sharing applications with detailed color (Mac)

For Mac users only

Before sharing an application or your desktop, you can choose one of the following display modes:

- **Better performance**: The default mode. Lets you display your content faster than you do using the better image quality mode.
- **Better image quality**: Lets you display your content with better image quality. In this mode, your shared content may take longer time to display than in the better performance mode.

Note: Changing the display mode does not affect presentation or document sharing.

To choose a display mode for your shared desktop or applications:
1 In the Meeting window, on the Meeting Center menu, choose Preferences.
   The Preferences dialog box appears.
2 Select Display.
Chapter 16: Sharing Software

The display mode options appear.

3 Select **Better performance** or **Better image quality**, as appropriate.

**Tips for sharing software**

The following tips can help you to share software more effectively:

- **Application sharing only:** To save time during a meeting, ensure that any applications you intend to share are open on your computer. At the appropriate time during the meeting, you can then quickly begin sharing an application, without waiting for the application to start.

- If participants cannot see all of the shared software without scrolling their sharing windows, they can adjust their views of the shared software. They can reduce the size of the shared software in decrements, or scale it to fit inside their sharing windows.

- To improve the performance of software sharing, close all applications that you do not need to use or share on your computer. Doing so conserves processor usage and memory on your computer, thus helping to ensure that Meeting Manager can send images of shared software quickly during a meeting. Also, to ensure that a maximum amount of bandwidth is available for software sharing, close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.

- If you are sharing an application for which the rendering of color on participants' screen is important, you can improve color quality by turning on True Color mode. For details, see *Sharing applications with detailed color* (on page 246).

- **Application and Web browser sharing only:** Avoid covering a shared application or Web browser with another window on your computer's desktop. A
A crosshatched pattern appears in participant sharing windows where the other window is covering the shared application or browser.

- **Application and Web browser sharing only:** If you want to switch your display between shared software and the Meeting window, you can pause software sharing before you return to the Meeting window, and then resume sharing once you return to the shared application. Pausing software sharing conserves processor usage and memory on your computer while you view the Meeting window. For details, see *Pausing and resuming software sharing.* (on page 230)

- **Application and Web browser sharing only:** If you have more than one monitor, when you share an application or web browser, the participants can see it on whichever monitor you are displaying it. If you move the application or Web browser to another monitor, it is still visible to the participants. If you are sharing more than one application, the participants will see the best view if you make sure the applications are displaying on the same monitor.

- Because software sharing requires additional bandwidth during a meeting, it is recommended that you use a dedicated, high-speed Internet connection when sharing software. However, if participants are using dial-up Internet connections, they may notice a delay in viewing or controlling shared software. If you want to share a document, such as a Microsoft Word or Excel document, you can improve the meeting experience for these participants by using document sharing instead of application sharing.
Using Chat

Chat is useful during a meeting if you want to:

- send brief information to all participants
- send a private message to another participant
- ask a question but do not want to use the Q & A option, which provides a formal procedure for asking and answering questions

All chat messages that you send or receive appear on the Chat panel in the meeting window.

The Chat function allows you to perform these tasks:

- Send chat messages *(More... on page 251)*
- Assign sounds to incoming messages *(More... on page 252)*
- Print chat messages *(More... on page 253)*
- Save chat messages *(More... on page 253)*
- Open a chat file during a meeting *(More... on page 254)*

Sending chat messages

During a meeting, the presenter can specify chat privileges for participants. These privileges determine to whom participants can send chat messages.

**To send a chat message:**

1. Open the Chat panel.
2. In the **Send to** drop-down list, select the recipient of the message.
3. Enter your message in the chat text box.
Depending on the operating system you use, follow this step:

- Windows: Click **Send**.
- Mac: Select **enter** on your keyboard.

**Note:** If you join a meeting in progress, you can see only the chat messages that participants send after you join the meeting.

### Assigning sounds to incoming chat messages

You can choose to play a sound for one of these occasions:

- If you are not viewing the Chat panel
- For only the first chat message that you receive in a thread
- Whenever you receive a chat message

**To assign sounds to incoming chat messages:**

1. Open the Preferences dialog box by performing these steps:
   - Windows: On the **Edit** menu, choose **Preferences**.
   - Mac: On the **Meeting Center** menu, choose **Preferences**.
2. Depending on your operating system, follow one of these steps:
   - Windows: Click the **Chat** tab.
   - Mac: Select the **Alerts** button.
3. Select the check box for each action for which you want to play a sound.
4. Select a sound from the appropriate drop-down list.
   - By default, the drop-down list contains the names of all sound files that reside at the default location on your computer.
5. To select a sound that does not appear in the drop-down list, follow these steps:
   - Windows: Click **Browse**, and then select a sound file that resides in another folder.
   - Mac: Select **Others** in the drop-down list.
6. Windows only. To play the currently selected sound, click the button ![Play Sound](image.png).
7. Click **OK**.

**Note:**
Meeting Center saves your sound preferences on your computer. However, if you start or join a meeting on another computer, you need to set your preferences again on that computer.

- If you are using Windows, sound files must have a .wav extension.
- In most cases, the default location for sound files is C:\WINDOWS\Media. You can copy other sound files to the default folder or any other directory to make them available in the Preferences dialog box.

### Printing chat messages

You can print all the chat messages that appear on the Chat panel.

**To print chat messages:**

1. In the Meeting window, on the **File** menu, choose **Print > Chat**.
   
   A print dialog box appears.

2. **Optional.** Specify printer options.

3. Print.

### Saving chat messages

You can save chat messages that appear on the Chat panel to a .txt file. You can then reopen the file for use in any meeting or view the file's content outside a meeting by opening the file in a text editor.

Once you save chat messages to a file, you can save changes to the messages or save a copy of them to another file.

For help in performing these tasks, click the "More" link:

- Save chat messages for the first time in a meeting *More...* (on page 253)
- Save change to a chat file *More...* (on page 254)
- Create a copy of a chat file *More...* (on page 254)

### Saving chat messages to a new file

You can save chat messages you have sent or received to a new chat file.

**To save chat messages to a new file:**

1. In the Meeting window, on the **File** menu, choose **Save > Chat**.
Chapter 17: Using Chat

The **Save Chat As** dialog box appears.

2. Choose a location at which you want to save the file.

3. Type a name for the file.

4. Click **Save**.

Meeting Manager saves the chat messages in a .txt file at the location you selected.

**Saving changes to a chat file**

If you make changes to the messages on your Chat panel, you can save them to an existing chat file.

**To save changes to a chat file:**

1. In the Meeting window, on the **File** menu, choose **Save > Chat**.

2. Meeting Manager saves the changes to the existing chat file.

**Creating a copy of previously saved chat messages**

If you have saved chat messages and want to create another copy of the messages, you can do so by saving the chat messages to a chat file with a different name.

**To create a copy of chat messages that have been previously saved:**

1. In the Meeting window, on the **File** menu, choose **Save As > Chat**.

   The **Save Chat As** dialog box appears.

2. Do either or both of the following:
   - Type a new name for the file.
   - Choose a new location at which you want to save the file.

3. Click **Save**.

Meeting Manager saves the file at the location you chose. The file name has a .txt extension.

**Opening a chat file during a meeting**

If you saved chat messages to a .txt file, you can display those chat messages on your Chat panel by opening the file.
To open a chat file in a meeting:

1. In the Meeting window, on the **File** menu, choose **Open > Chat**.
   
The Open Chat dialog box appears.
2. Select the chat file that you want to open.
3. Click **Open**.
   
The chat messages appear on the Chat panel.

If there are already chat messages in your chat viewer, Meeting Manager appends the messages from the chat file to the existing messages.
Polling Attendees

During a meeting, you can poll attendees by presenting them with a questionnaire. Conducting a poll can be useful for gathering feedback from attendees, allowing attendees to vote on a proposal, testing attendees' knowledge of a topic, and so on.

During the meeting, the presenter is responsible for:

- Preparing a poll questionnaire *More...* (on page 257)
- Conducting a poll during the meeting *More...* (on page 261)

After closing a poll, the presenter can:

- View poll results *More...* (on page 262)
- Share poll results with attendees *More...* (on page 263)
- Save poll results for viewing outside a meeting *More...* (on page 265)

Preparing a poll questionnaire

When preparing a poll questionnaire, you can:

- Create a questionnaire *More...* (on page 257)
- Edit a questionnaire *More...* (on page 259)
- Set a timer for polling *More...* (on page 260)

Creating a poll questionnaire

*Presenter only*
To conduct a poll, you must first create a poll questionnaire. You create a questionnaire in a meeting. To save time during a meeting, you can start the meeting earlier than the scheduled time, create a questionnaire on the Polling panel, save it, and then open it during the actual meeting.

To create a questionnaire (for Windows):

1. Open the Polling panel in a meeting.
2. In the **Question** section, select one of these question types:
   - To create a multiple-answer question, select **Multiple choice**, and then select **Multiple Answers** in the drop-down list.
   - To create a single-answer question, select **Multiple choice**, and then select **Single Answer** in the drop-down list.
   - To create a text question, select **Short answer**.
3. Click **New**.
4. Type a question in the box that appears.
5. In the **Answer** section, click **Add**.
6. Type an answer in the box that appears.
7. To type another answer, click **Add** once you finish typing an answer.
   - The question and answers appear in the Poll Questions area.
8. To add questions, repeat steps 2 to 7.

This figure shows an example of a poll questionnaire.

<table>
<thead>
<tr>
<th>Poll Questions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is your favorite color?</td>
</tr>
<tr>
<td>a. blue</td>
</tr>
<tr>
<td>b. red</td>
</tr>
<tr>
<td>c. green</td>
</tr>
<tr>
<td>d. black</td>
</tr>
<tr>
<td>2. What do you enjoy doing at leisure?</td>
</tr>
<tr>
<td>a. reading</td>
</tr>
<tr>
<td>b. watching movies</td>
</tr>
<tr>
<td>c. traveling</td>
</tr>
<tr>
<td>d. sports</td>
</tr>
<tr>
<td>3. Please give us feedback about this event.</td>
</tr>
<tr>
<td>[ ]</td>
</tr>
</tbody>
</table>
To create a questionnaire (for the Mac):

1. Open the Polling panel in the event.
2. Add a question by clicking this button and then typing the question.
3. Add an answer by clicking this button and then typing the answer.
4. To add more answers, repeat step 3.
5. To add more questions, repeat step 2.
6. To change the question type for a question, click the text "Click here to change question type" that appears under the specific question and then do one of the following:
   - To create a multiple-answer question, select **Multiple Answers**.
   - To create a single-answer question, select **Single Answer**.
   - To create a question that requires a text answer, select **Short Answer**.

**Editing a questionnaire**

You can change the type of a question and edit, rearrange, or delete the questions and answers.

To change the type of a question:

1. Select the question by clicking it, and then select the new type of question in the Question section.
Chapter 18: Polling Attendees

For more information about the different types of questions, see *Creating poll questionnaires* (on page 257).

2. Click Change Type.

To edit any question or answer that you entered:

1. Select the question or answer by clicking it, and then click the Edit icon.

2. Make your changes.

To delete a question or an answer:

Select the question or answer by clicking it, and then click the Delete icon.

To rearrange questions or answers:

Select the question or answer by clicking it, and then click the Move Up or Move Down icon, as appropriate.

To delete an entire questionnaire:

Click Clear All.

If you have not saved the questionnaire, a message box appears, asking whether you want to save it or not.

Displaying a timer during polling

You can specify that a timer displays for attendees and yourself when a poll is in progress.
Chapter 18: Polling Attendees

To display a timer:

1. Open the Polling Options dialog box.
   - If you use Windows, click **Options** at the bottom of your Polling panel.
   - If you use the Mac, click this button on the lower-right portion of the Polling panel.

2. In the dialog box that appears, select **Display**, and then type the length of time in the **Alarm** box.

3. Click **OK**.

Opening a poll

After you finish preparing a poll questionnaire, you can open the poll.

If you prepared your questionnaire in advance and saved it, you must first display it on the Polling panel. For details, see *Opening a poll questionnaire file* (on page 265).

To open a poll:

1. Display your poll questionnaire on the Polling panel, if you have not done so.

2. Click **Open Poll**.

   The questionnaire appears on attendees’ Polling panels. Attendees can now answer the poll.

   As attendees answer the questions, you can watch the polling status on your Polling panel.
Chapter 18: Polling Attendees

262

Windows:
To view each attendee’s polling status, click one of these three buttons.

Mac:
To view each attendee’s polling status, select the text “Click to see detailed status.”

3 Click Close Poll when the time is up.

If you specify a timer and the poll times out, the poll automatically closes.

Attendees can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with attendees. For details, see Viewing and sharing poll results (on page 262).

Viewing and sharing poll results

After closing a poll, you can:

- View the complete results of the poll. More... (on page 262)
- Share group results with attendees. More... (on page 263)

The poll results you can share during a meeting are anonymous. However, Meeting Center records responses from each attendee, in addition to group results, and allows you to save those individual and group results. For more information, see Saving results of a poll (on page 265).

Viewing poll results

Meeting Center bases the percentage for each answer on the total number of attendees in the meeting, not the total number of attendees who submitted answers in the poll.
## Chapter 18: Polling Attendees

### Poll Questions:

<table>
<thead>
<tr>
<th>Questions</th>
<th>Results</th>
<th>Bar Graph</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is your favorite color?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. blue</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>b. red</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>c. green</td>
<td>0/4(0%)</td>
<td></td>
</tr>
<tr>
<td>d. black</td>
<td>0/4(0%)</td>
<td></td>
</tr>
<tr>
<td>No Answer</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>2. What do you enjoy doing at lei...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. reading</td>
<td>3/4(75%)</td>
<td></td>
</tr>
<tr>
<td>b. watching movies</td>
<td>3/4(75%)</td>
<td></td>
</tr>
<tr>
<td>c. traveling</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>d. sports</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>No Answer</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>3. Please give us feedback about...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Sharing poll results with attendees

After you close a poll, you can share the poll results with attendees. The poll results you can share during a meeting are anonymous. However, Meeting Center records responses from each attendee, in addition to group results, and allows you to save those individual and group results. For more information, see Saving results of a poll (on page 265).
To share the results of a poll:

In the Share with attendees section on your Polling panel, select Poll results, and then click Apply.

The results of the poll appear in the attendees’ Polling panels, just as they do on your Polling panel.

Saving and opening poll questionnaires and results

If you have prepared a poll questionnaire, you can:

- Save the questionnaire More… (on page 264)
- Open the saved questionnaire for use in any meeting More… (on page 265)

After you close a poll, you can:

- Save group results to a .txt file More… (on page 265)
- Save responses from individual attendees to a .txt file More… (on page 265)

Saving a poll questionnaire in a meeting

After you create a poll questionnaire in a meeting, you can save it as a .atp file. You can open the file for use in any meeting.

To save a poll questionnaire:

1. On the File menu, choose Save > Poll Questions.

   The Save Poll Questions As dialog box appears.

2. Choose a location at which to save the file.

3. Type a name for the file.

4. Click Save.
Chapter 18: Polling Attendees

Meeting Manager saves the poll questionnaire to a file at the location you specified. Poll questionnaire file names have a .atp extension.

Saving results of a poll

After closing a poll, you can save the responses in one of these ways:

- **Text File group result**—Saves the percentage of attendees who chose each answer in a .txt file
- **Text File individual attendees result**—Saves the responses from each attendee, in addition to the group results, in a .txt file

![Image of dialog box with file name and save as type options]

When you are saving poll results, you can select a format in which you want to save the results.

To save results of a poll:

1. Close the poll if you have not done so.
2. On the **File** menu, choose **Save > Poll Results**.
   
   The Save Poll Results As dialog box appears.
3. Select a location at which to save the file.
4. In the "File name" drop-down list, enter a name for the file.
5. In the "Save as type" drop-down list, select the format in which you want to save the results.
6. Click **Save**.

You can now view poll results by opening the file.

Opening a poll questionnaire file

If you saved a poll questionnaire to a file, you can display the questionnaire on your Polling panel by opening the file.

**Note:** You can open a poll questionnaire file only during a meeting.
Chapter 18: Polling Attendees

To open a poll questionnaire file:

1. Use one of these methods to browse to the file:
   - On the File menu, choose Open > Poll Questions.
   - Click the Open icon on your Polling panel.

   ![Windows Open Poll Questions dialog box](image)
   ![Mac Open Poll Questions dialog box](image)

   The Open Poll Questions dialog box appears.

2. Select the poll questionnaire file that you want to open.
   A poll questionnaire file has a .atp extension.

3. Click Open.
   The poll questionnaire appears on your Polling panel. You can now open the poll to the attendees.
During a meeting, you can publish files that reside on your computer. Meeting attendees can then download the published files to their computers or local servers. Publishing files is useful if you want to provide attendees with a document, a copy of your presentation, an application, and so on.

Files that you publish reside only on your computer - not on a server. Thus, your published files are always protected from unauthorized access during a meeting.
Publishing files during a Meeting

During a meeting, you can publish files that reside on your computer, and meeting attendees can download the files to their computers or local servers.

To publish files during a meeting:

1. In the Meeting window, on the File menu, choose Transfer.
   
   The File Transfer window appears.

2. Click Share File.
   
   The Open dialog box appears.

3. Select the file that you want to publish.

4. Click Open.
   
   The file appears in the File Transfer window.
   
   The file is also now available in each attendee's File Transfer window.

5. Optional. Publish additional files that you want attendees to download.

   **Note:** The number of attendees that have the File Transfer window open, including you, appears in the lower-right corner of the File Transfer window.

To stop publishing files during a meeting:

In the title bar of the File Transfer window, click the Close button.

Meeting Manager closes the File Transfer window in each attendee's Meeting window.
Downloading Files During a Meeting

If a presenter publishes files during a meeting, the File Transfer dialog box automatically appears in your Meeting window. You can then download the published files to your computer or a local server.

To download files during a meeting:

1. In the File Transfer window, select the file that you want to download.

2. Click **Download**.
   
The Save As dialog box appears.

3. Choose a location at which to save the file.

4. Click **Save**.
   
The file downloads to your selected location.

5. If applicable, download additional files.

6. Once you finish downloading files, in the title bar of the File Transfer window, click the **Close** button.

   **Note:** To reopen the File Transfer window at any time, from the **File** menu, choose **Transfer**. This option is available only if the presenter is currently publishing files.
Managing and Taking Notes

When scheduling a meeting, the host can specify the default note-taking options that take effect once the meeting starts. During a meeting, the presenter can change the default note-taking options at any time.

You can choose how to handle meeting notes:

- All participants with access can take private notes. *More...* (on page 275)
- Only one participant takes notes or meeting minutes. *More...* (on page 273)
- Only one participant takes notes for closed captions. *More...* (on page 276)

*Note:* The notes feature is not available on the Mac.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>If the Notes panel is closed, click <strong>Manage Panels</strong> and then select <strong>Notes</strong> from the list and click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>- set up options for taking notes in a meeting <em>More...</em> (on page 272)</td>
</tr>
<tr>
<td></td>
<td>- choose one person to take notes <em>More...</em> (on page 273)</td>
</tr>
<tr>
<td></td>
<td>- Select a participant as closed captionist <em>More...</em> (on page 273)</td>
</tr>
</tbody>
</table>
## Specify note-taking options for a meeting

During a meeting, you can turn the notes option on or off and specify *one* of these options:

- All participants with access to notes can take private notes.
- Only one participant can take notes.
- Only one participant takes notes for closed captions. *More...* (on page 276)

**To specify note-taking options for Windows:**

1. In the Meeting window, on the **Meeting** menu, choose **Options**.
   
   The Meeting Options dialog box appears, with the **General** tab selected by default.

2. Select the note-taking option you want and click **OK**.
   - To turn the notes option on or off, check or uncheck the **Notes** check box.
   - To turn the closed captions option on or off, select or clear the **Enable Closed Captioning** check box.

**To specify note-taking options for the Mac:**

1. On the **Meeting Center** menu, select **Preferences**.

2. Select **Tools**.

3. Select the note-taking option you want and click **OK**.
   - To turn the notes option on or off, check or uncheck the **Notes** check box.
To turn the closed captions option on or off, check or uncheck the Enable Closed Captioning check box.

**Note:**
- Once you change the notes option, any published notes or closed captions are removed from each participant's Notes or Closed Caption panel. Be sure to ask participants to save notes or closed captions before you change the notes option.
- When scheduling a meeting, the meeting host can specify the default note-taking options, which take effect once the meeting starts.

### Choosing a note taker

If the single note taker or closed captions option is set for a meeting, you can designate any participant or closed captionist to be the note taker. When scheduling a meeting, you can set the notes option, or a presenter can set the notes option during a meeting.

**To designate a note taker for Windows:**
1. On the Participants panel, select the participant you want to designate as note taker.
2. Right-click and then select Change Role To > Note Taker.
   A pencil indicator appears to the right of the participant's name in the participant list.

**To designate a note taker for the Mac:**
1. On the Participants panel, select the participant you want to designate as note taker.
2. Select ctrl and then click; then select Change Role To > Note Taker.
   A pencil indicator appears to the right of the participant's name in the participant list.

**Note:**
- If you select another note taker or closed captionist, any notes or closed captions that the previous note taker or closed captionist published remain on each participant's Notes or Closed Caption panel. However, the new note taker or closed captionist cannot edit the existing notes or closed captions.
- For information about selecting a note-taking option during a meeting, see Specifying note-taking options for a meeting (on page 272).
Chapter 20: Managing and Taking Notes

To designate a closed captionist:

1. In the meeting window, in the participant list, select the participant you want to designate as a closed captionist.
2. On the Participants panel, do one of the following:
   - Windows: Right-click and select **Change Role To > Closed Captionist**.
   - Mac: Select `ctrl` and then click. Then select **Change Role To > Closed Captionist**.

   ![A closed caption indicator appears next to the participant's name in the participant list.](image)

Enabling closed captions

You can easily select the option for closed captions and appoint a participant to transcribe the closed captions.

To specify the closed caption option:

1. Depending on the operating system you are using, do one of the following:
   - Windows: In the Meeting window, on the **Meeting** menu, choose **Options**. The Meeting Options dialog box appears, with the **General** tab selected by default.
   - Mac: On the **Meeting Center** menu, select **Preferences**. Select **Tools**.
2. To turn the closed captioning option on or off, check or uncheck the **Enable Closed Captioning** check box.

To learn how to display the Closed Captions panel, see *Managing panels* (on page 153).

To select another participant to transcribe, select the participant's name on the Participants panel; then right-click (Windows) or select `ctrl` and then click (Mac) and then select **Change Role To >Closed Captionist**.
About taking notes

During a meeting, one or more meeting participants with access to the notes feature can take notes on the Notes or Closed Caption panel in the Meeting window. Only one participant performs closed captioning.

If all participants are allowed to take notes, they cannot publish their notes to others during the meeting. However, participants can save their notes at any time during the meeting.

The meeting host can select the single note taker during the meeting. A single note taker can publish notes at any time during the meeting or send a meeting transcript containing the notes to all participants.

If needed, the host can also select a closed captionist. A closed captionist can publish captions in real-time during the meeting and can also send a transcript containing the captions to all participants.

Taking personal notes

If the meeting host or presenter has selected the option to allow participants to take personal notes, you can type your notes on the Notes panel in the Meeting window.

To take personal notes:

1. In the Meeting window, open the Notes panel.
2. Type your notes in the box.

Note: You can save your notes to a text file on your computer. For details, see Saving notes to a file (on page 277).

Taking public notes (meeting minutes)

If the meeting host has designated you as the single note taker for a meeting, you can type notes on the Notes panel in your Meeting window. Your notes are not visible to other meeting participants until you publish them. You can publish your notes at any time during the meeting, or you can send your notes in a meeting transcript to all participants.
Chapter 20: Managing and Taking Notes

To take public notes:
1. In the Meeting window, open the Notes panel.
2. Type your notes in the box.
3. Optional. To publish your notes, so they appear in each participant's Notes panel, click Publish.

**Note:** If the Notes panel is not selected on a participant's Meeting window once you publish notes, the participant is alerted.

For information about selecting a note-taking option during a meeting, see Specifying note-taking options for a meeting (on page 272).

For details about sending public notes in a meeting transcript, see Sending a meeting transcript to participants (on page 278).

Providing closed captions

If the meeting host has designated you as the closed captionist for a meeting, you can type captions on the Closed Captions panel in your Meeting window. To type captions, you can use either a standard keyboard, or a steno keyboard and machine translation software.

Your captions are visible to other meeting participants in real-time, one line at a time. You can also send your captions in a meeting transcript to all participants.

To transcribe closed captions:
1. Open the Closed Caption panel.
2. Type your captions in the box.
3. Once you type a line of captions, do either to publish your captions on each participant's Closed Caption panel:
   - Press the Enter key on your computer's keyboard.
   - Click Publish on the Closed Caption panel.

**Note:**
- If the Closed Captions panel is not selected on a participant's Meeting window once you publish a line of captions, the participant is alerted that captions are available.
- You can save your captions to a text file on your computer. For details, see Saving notes to a file (on page 277).
Saving notes to a file

If you are taking personal or public notes (meeting minutes) or closed captions during a meeting you can save your notes or closed captions to a text file on your computer. You can also save any notes or closed captions that another note taker or closed captionist publishes on your Notes or Closed Caption panel.

Once you save new notes to a file, you can save changes to the notes or save a copy of the notes to another file.

To save new notes:

1. In the Meeting window, do either:
   - On the Notes or Closed Caption panel, click Save.
   - On the File menu, point to Save, and then choose Notes.

   The Save Notes As dialog box appears.

2. Choose a location at which to save the file.

3. Type a name for the file.

4. Click Save.

Meeting Manager saves the file at the location you chose. Its file name has a .txt extension.

To save changes to notes:

In the Meeting window, do either:

- On the Notes or Closed Caption panel, click Save.

- On the File menu, point to Save, and then choose Notes.

Meeting Manager saves the file at the location you chose. Its file name has a .txt extension.

To save a copy of notes to another file:

1. In the Meeting window, on the File menu, point to Save As, and then choose Notes.

   The Save Notes As dialog box appears.

2. Do either or both:
Chapter 20: Managing and Taking Notes

- Type a new name for the file.
- Choose a new location at which to save the file.

3 Click Save.

Meeting Manager saves the file at the location you chose. The file name is saved with a .txt extension.

**Tip:**
Alternatively, you can save all of the following information to files at once:
- Shared presentations or documents
- Chat messages
- Notes
- Poll questionnaire
- Poll results

To save all information at once, on the File menu, choose Save All. In this case, Meeting Manager uses the default file names for the files. Thus, if you have already saved a file using another name, Meeting Manager does not overwrite that file.

### Sending a meeting transcript to participants

You can send a transcript of a meeting to all participants at any time during the meeting. The transcript is an email message that contains general information, such as:
- Meeting topic
- Meeting number
- Meeting starting and ending times
- URL for the Meeting Information page for the meeting on your meeting service Web site
- List of participants who joined the meeting (audio-only participants are not listed)
- Meeting agenda
- Any public notes that you took during the meeting

Optionally, you can attach any of these files to the transcript, if you saved them during the meeting:
- Shared documents
- Chat
- Public notes that you took or that the note taker published during the meeting
Chapter 20: Managing and Taking Notes

- Poll questionnaire
- Poll results

To send a meeting transcript to participants:

1. In the Meeting window, on the **File** menu, choose **Send Transcript**.
   - If you have saved any files during the meeting, the Send Transcript dialog box appears, allowing you to attach the files to the transcript email message.
   - If you have not saved any files during the meeting, a transcript email message opens.

2. If the Send Transcript dialog box appears, select the check box for each file that you want to attach to the transcript, and then click **OK**.
   - The transcript email message opens.

3. Review the email message and make any changes that you want.

4. Send the email message.

**Note:**

- The transcript is sent to all participants who provided their email addresses when joining the meeting, whether or not they are still attending the meeting when you send the transcript. Audio-only participants will not be listed in the transcript.
- For security purposes, a participant who receives a transcript email message cannot see the email addresses for the other participants.
- The transcript contains notes only if you are the meeting host, the public note taker, or the closed captionist, and you have saved the notes to a file. If all participants can take private notes, the transcript email message does not include your private notes, and the option to attach your notes in a file is not available.
- If you saved notes or closed captions to a file, the transcript email message and the attached notes file contain the latest version of notes that you saved.
- If you are the meeting host and end the meeting-and you have not sent a transcript-a message appears, asking you if you want to send a transcript.
When you send video, your video is seen by all participants.

If a video camera is attached to your computer, you can broadcast live video to participants. Live video lets other participants see you, or whatever you focus your webcam on. To see video, participants do not need to have a webcam installed on their computers.

To start or stop sending video, simply select the video icon beside your name.

After you start sending video, you can perform the following tasks depending on your role.
### Setting the main display

If you are the host, you can decide which participant video to show in the main display.

**To set the video for the main display:**

1. Select the name tag on the main display.

#### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| Host Windows | What you can do:  
- Stop or start sending video at will.  
- Set the main display. (on page 282)  
- View video in full-screen mode (on page 283).  
- List participants or show thumbnails. (on page 285)  
- Set webcam options (on page 286). |
| Participant Mac | What you can do:  
- Start or stop sending video at will.  
- View video in theatre mode (on page 283).  
- List participants or show thumbnails. (on page 285)  
- Set webcam options (on page 286). |
2 In the dialog box that appears you can select one of the following:

- **The active speaker.** This is the default. The display focuses on the current speaker and changes as the speaker changes.
- **A specific participant.** The display focuses on only the specific participant that you select.

**Switching to and from full-screen mode**

Full-screen mode displays your video across the entire desktop space and is great to use when you want to see a larger view.
The active speaker (or a specific participant) is shown in the main display with all other participant videos arranged in a row beneath.

To switch to and from full-screen mode, do one of the following:

- Double click the main display
- Select the full-screen mode icon in the upper right corner of the display
Display a list or thumbnail view of participants

Select the participant icon to switch between the participant list or thumbnail views.

Participant list view

Participant thumbnail view
Setting webcam options

If you have a working webcam, you can set options that are available for that webcam directly from your meeting.

To set webcam options:

Windows:
At the top right of the main display select the options icon.

Mac:
At the bottom right of window, select the options icon.

Although you can set options for contrast, sharpness, brightness and other general settings, options can vary depending on your web camera.
Managing video during sharing

When you are sharing information or someone else is sharing information with you, the main video display appears in the upper right corner of your desktop. You can minimize or enlarge this display at will, or move it to any other part of the desktop.

To minimize or adjust the size and position of the main display:

- **Minimize**: Select the arrow icon in the upper left corner.
- **Resize**: Select the bottom right corner and drag the edge.
- **Reposition**: Select and drag the display to another location on the desktop.
## Using My WebEx

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of My WebEx</td>
<td><em>About My WebEx</em> (on page 290)</td>
</tr>
<tr>
<td>set up a user account on your WebEx service Web site</td>
<td><em>Obtaining a user account</em> (on page 291)</td>
</tr>
<tr>
<td>log in to or out from My WebEx</td>
<td><em>Logging in to and out of the WebEx service site</em> (on page 292)</td>
</tr>
<tr>
<td>use your list of meetings</td>
<td><em>Using your list of meetings</em> (on page 293)</td>
</tr>
<tr>
<td>install WebEx Productivity Tools, which let you start One-Click meetings, start instant meetings from applications on your desktop, or schedule meetings from Microsoft Outlook or IBM Lotus Notes</td>
<td><em>Installing WebEx Productivity Tools</em> (on page 142)</td>
</tr>
<tr>
<td>set up a One-Click Meeting</td>
<td><em>Setting Up a One-Click Meeting</em> (on page 137)</td>
</tr>
<tr>
<td>view or set options for your Personal Meeting Room page</td>
<td><em>Maintaining Your Personal Meeting Room Page</em> (on page 304)</td>
</tr>
<tr>
<td>set up or access remote computers, using Access Anywhere</td>
<td><em>Using Access Anywhere (My Computers)</em> (on page 308)</td>
</tr>
<tr>
<td>add, edit, or delete files in your personal storage space for files</td>
<td><em>Maintaining files in your personal folders</em> (on page 309)</td>
</tr>
<tr>
<td>add, edit, or delete information about your contacts in your online address book</td>
<td><em>Maintaining contact information</em> (on page 330)</td>
</tr>
<tr>
<td>change information or settings in your user profile, including personal information and preferences</td>
<td><em>Maintaining your user profile</em> (on page 344)</td>
</tr>
<tr>
<td>manage the scheduling templates you saved</td>
<td><em>Managing scheduling templates</em> (on page 351)</td>
</tr>
</tbody>
</table>
**If you want to...** | **See...**
---|---
set up your Personal Conference number (PCN) accounts, which you can use for the audio portion of Personal Conference meetings | *Maintaining Personal Conference numbers* (on page 353)

generate reports about online sessions | *Generating Reports* (on page 359)

---

**About My WebEx**

My WebEx is an area on your WebEx service Web site in which you can access your user account and personal productivity features. The following features are available, depending on the configuration of your site and user account:

- **Personal list of meetings:** Provides a list of all the online meetings that you are hosting and attending. You can view the meetings by day, week, or month, or you can view all meetings.

- **Productivity Tools Setup:** Optional feature. Lets you set up options for instant or scheduled meetings that you can start from applications on your desktop. If you install WebEx Productivity Tools, you can start or join meetings, sales meetings, training sessions, and support sessions instantly from One-Click or from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers. You can also schedule meetings, sales meetings, events, and training sessions using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

- **Personal Meeting Room:** Optional feature. A page on your WebEx service Web site on which visitors can view a list of meetings that you are hosting and join a meeting in progress. Visitors can also access and download files that you share.

- **Access Anywhere:** Optional feature. Lets you access and control a remote computer from anywhere in the world. For more information about Access Anywhere, refer to the guide *Getting Started with Access Anywhere*, which is available on your WebEx service Web site.

- **File storage:** Lets you store files in personal folders on your WebEx service Web site, where you can access them on any computer that has access to the Internet. Also lets you make specific files available on your Personal Meeting Room page, so visitors to your page can access them.
Chapter 22: Using My WebEx

MC_About My WebEx

- **Address book:** Lets you keep information about your personal contacts on your WebEx service Web site. Using your address book, you can quickly access contacts when inviting them to a meeting.

- **User profile:** Lets you maintain your account information, such as your username, password, and contact information. Also lets you specify another user who can schedule meetings on your behalf, set options for your Personal Meeting Room page, and manage scheduling templates.

- **Personal Conference numbers:** Optional feature. Lets you create Personal Conference number (PCN) accounts, which you can use to set up the audio portion of your Personal Conference meetings.

- **Web site preferences:** Lets you specify the home page for your WebEx service Web site—that is, the page that appears first whenever you access your site. If your site provides multiple languages, you can also choose a language and locale in which to display text on your site.

- **Usage reports:** Optional feature. Lets you obtain information about meetings that you hosted. If you use the Access Anywhere option, you can also obtain information about computers that you access remotely.

Obtaining a user account

Once you obtain a user account, you can use My WebEx features and host s on the Web.

You can obtain a user account in one of two ways:

- The site administrator for your WebEx service Web site can create a user account for you. In this case, you need not sign up for an account on your site, and you can begin hosting s immediately.

- If your site administrator has made the self-registration feature available, you can sign up for an account on your WebEx service Web site at any time.

To obtain a user account using the self-registration feature:

1. Go to your WebEx service Web site.
2. On the navigation bar, click **Set Up > New Account.**
   - The Sign Up page appears.
3. Provide the required information.
4 Click **Sign Up Now**.

You receive an email message, confirming that you have signed up for a user account.

Once your site administrator approves your new user account, you receive another email message containing your username and password.

**Note:** Once you obtain a user account, you can edit your user profile to change your password and provide additional personal information. You can also specify site preferences, such as your default home page and time zone. For details, see *Maintaining your user profile* (on page 344).

---

**Logging in to and out of the WebEx service site**

To manage your online services and maintain your user account, you must log in to your WebEx service Web site. If you do not yet have a user account, see *Obtaining a user account* (on page 291).

**To log in to your WebEx service site:**

1 Go to your WebEx service Web site.

2 In the upper-right corner of the page, click **Log In**.

   The Log In page appears.

3 Enter your username and password.

   Passwords are case-sensitive, so you must type your password exactly as you specified it in your user profile.

4 Click **Log In**.

**Tip:** If you have forgotten your username or password, click **Forgot your password**. Provide your email address, type verification characters, and then click **Submit**. You will receive an email message containing your username and password.

**To log out from your WebEx service site:**

In the upper-right corner of the page, click **Log Out**.
Using your list of meetings

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your list of meetings</td>
<td>About your list of meetings (on page 293)</td>
</tr>
<tr>
<td>open your list of meetings</td>
<td>Opening your meetings list (on page 293)</td>
</tr>
<tr>
<td>maintain your list of meetings</td>
<td>Maintaining your scheduled meetings list (on page 295)</td>
</tr>
</tbody>
</table>

About your list of meetings

On your WebEx service Web site, your My Meetings page in My WebEx includes:

- A list of all the online meetings that you have scheduled, including both listed and unlisted meetings.
- A list of meetings on your site to which you are invited.
- An option to start a One-Click meeting (not available for Event Center).
- Any Personal Conference meetings that you scheduled (if your site and account have the Personal Conferencing feature turned on).

Tip: You can specify that your My WebEx meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see Maintaining your user profile (on page 344).

Opening your meetings list

You can open your personal list of scheduled meetings on your WebEx service Web site to:

- Start a meeting
- Modify a meeting
- Cancel a meeting

You can open your personal list of meetings to which you are invited:
Chapter 22: Using My WebEx

- Obtain information about a meeting
- Join a meeting in progress

To open your meetings list:

1. Log in to your WebEx service Web site, and then click My WebEx.
   The My Meetings page appears, showing your list of scheduled meetings.

   ![My WebEx Meetings](image)

   - Click one of the tabs to navigate to different views of the My Meetings page:
     You can choose Daily, Weekly, Monthly, or All Meetings.

   - Optional. Do either of the following:
     - To view the list of meetings to which you are invited, select The meetings you are invited to from the list.
     - To include meetings in the view that have already occurred, turn on Show past meetings.

   - (Optional) Select options to control the view:
     - To view the list of meetings to which you are invited, select The meetings you are invited to from the list.
     - To include meetings in the view that have already occurred, turn on Show past meetings.

   **Tip:** You can specify that your My WebEx Meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see Maintaining your user profile (on page 344).
Maintaining your scheduled meetings list

Once you schedule a meeting, it appears in your meetings list on your My Meetings page. For more information, see Opening your meetings list (on page 293).

An online meeting remains on your My Meetings page until you delete it. When scheduling a meeting, you can choose to automatically delete the meeting from your list of meetings once both of these conditions occur:

- You start and end the meeting.
- The scheduled time for the meeting has passed.

However, if you required registration for a scheduled meeting, the meeting remains in your list until you remove it. That way, you can still view information about attendees who registered for the meeting at any time after you host the meeting.

To remove a meeting from your list of meetings on your My Meetings page, you must cancel the meeting by deleting it on this page.

For details about the options on the My WebEx Meetings page, see About the My WebEx Meetings page (on page 295).

About the My WebEx Meetings page

How to access this tab

On your WebEx service Web site, click the My WebEx tab.

What you can do here

Access these features:

- A link to your personal meeting room
- A list of meetings you are hosting or are invited to for the specified day, week, or month
- A list of all meetings you are hosting or are invited to
- A link to start a One-Click meeting
## Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To My Personal Meeting Room</td>
<td>Go to your Personal Meeting Room page. Your Personal Meeting Room page lists any meetings that you scheduled and any in-progress meetings that you are currently hosting. Users to whom you provide your personal URL can use this page to join any meeting that you are hosting. They can also download files in any folders that you share.</td>
</tr>
<tr>
<td>Start a One-Click Meeting</td>
<td>Start a One-Click Meeting based on settings you have specified in One-Click Setup. For details, see Setting Up a One-Click Meeting (on page 137).</td>
</tr>
<tr>
<td>Daily</td>
<td>View a list all of the meetings for the specified day. For details, see About the My WebEx Meetings - Daily tab (on page 296).</td>
</tr>
<tr>
<td>Weekly</td>
<td>View a list all of the meetings for the specified week. For details, see About the My WebEx Meetings - Weekly tab (on page 298).</td>
</tr>
<tr>
<td>Monthly</td>
<td>View a list all of the meetings for the specified month. For details, see About the My WebEx Meetings - Monthly tab (on page 301)</td>
</tr>
<tr>
<td>All Meetings</td>
<td>View a list all meetings, or search for meetings by date, host, topic, or words in the agenda. For details, see About the My WebEx Meetings - All Meetings tab (on page 302)</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh the information in the meeting list.</td>
</tr>
</tbody>
</table>

---

### About the My WebEx Meetings page - Daily tab

#### How to access this tab

On your WebEx service Web site, click My WebEx > My Meetings > Daily tab.
Chapter 22: Using My WebEx

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Refresh</strong></td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td><strong>Language link</strong></td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Time zone link</strong></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>The date for the daily list of meetings. The default is the current date.</td>
</tr>
<tr>
<td><strong>Previous Day</strong></td>
<td>Click the Previous Day icon to display a list of meetings for the previous day.</td>
</tr>
<tr>
<td><strong>Next Day</strong></td>
<td>Click the Next Day icon to display a list of meetings for the next day.</td>
</tr>
<tr>
<td><strong>The meetings you host</strong></td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td><strong>The meetings you are invited to</strong></td>
<td>Shows a list all of the meetings or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td><strong>Show past meetings</strong></td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td><strong>Ascending Sort</strong></td>
<td>The Ascending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><strong>Descending Sort</strong></td>
<td>The Descending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>The starting time for each scheduled meeting. Click the box next to a meeting start time to select that meeting. Click the box next to the Time column heading to select or clear all meetings in the list.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for a meeting that you are hosting. Click the topic name to get information about that meeting. If you are the alternate host for a Meeting, the topic appears in italics.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicates the type of online meeting that you are hosting. Available meeting types depend on the configuration of your WebEx service Web site.</td>
</tr>
</tbody>
</table>
Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Assist** | If an Assist has been requested for this meeting, indicates the type of Assist:  
  - None  
  - Dry Run  
  - Consult  
  - Live Event Support  
  - Audio Streaming  
  - Video |
| **Status** | Indicates that the live meeting is in process. |
| **Delete** | The status of the meeting.  
  - **Start:** You can start this meeting that you are hosting at any time by clicking the link.  
  - **Join | End:** (for hosts) For a meeting in progress that you are hosting, you can join or end the meeting. Appears if you left a meeting, or you allowed participants to join the meeting before its starting time and participants have already joined the meeting.  
    - **Join:** Lets you join the meeting in progress.  
    - **End:** Ends the meeting.  
  - **Join:** (for attendees) The meeting that you are invited to has started, and you can now join the meeting.  
  - **Registration:** (for attendees) The meeting that you are invited to requires registration. To display a page on which you can register to attend the meeting, click the link. (Does not apply to sales meetings or support sessions.)  
  - **Delete** | Cancels any meetings that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the meeting. Another message appears, allowing you to inform any invited attendees that you canceled the meeting. (Does not apply to support sessions.) |

About the My WebEx Meetings page - Weekly tab

**How to access this tab**

On your WebEx service Web site, click **My WebEx > My Meetings > Weekly tab.**
# Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Refresh icon</strong></td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td><strong>Language link</strong></td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Time zone link</strong></td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Week link</strong></td>
<td>The beginning and ending date for the weekly list of meetings.</td>
</tr>
<tr>
<td><strong>Previous Week icon</strong></td>
<td>Click the Previous Week icon to display a list of meetings for the previous week.</td>
</tr>
<tr>
<td><strong>Next Week icon</strong></td>
<td>Click the Next Week icon to display a list of meetings for the next week.</td>
</tr>
<tr>
<td><strong>Calendar icon</strong></td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td><strong>The meetings you host</strong></td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td><strong>The meetings you are invited to</strong></td>
<td>Shows a list all of the meetings or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td><strong>Show past meetings</strong></td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td><strong>Day link</strong></td>
<td>Opens the Daily view, which shows the scheduled meetings for the selected day.</td>
</tr>
<tr>
<td><strong>Friday</strong></td>
<td>The Ascending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><strong>Descending Sort</strong></td>
<td>The Descending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Expand button</strong></td>
<td>The Expand button appears next to a Day link. Click this button to expand and display the list of meetings for that day.</td>
</tr>
<tr>
<td><strong>Collapse button</strong></td>
<td>The Collapse button appears next to a Day link. Click this button to collapse and hide the list of meetings for that day.</td>
</tr>
</tbody>
</table>
### Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time</strong></td>
<td>The starting time for each scheduled meeting. Click the box next to a meeting start time to select that meeting. Click the box next to the <em>Time</em> column heading to select or clear all meetings in the list.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for a meeting that you are hosting. Click the topic name to get information about that meeting. If you are the alternate host for a Meeting, the topic appears in italics.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicates the type of online meeting that you are hosting. Available meeting types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Assist</strong></td>
<td>If an Assist has been requested for this meeting, indicates the type of Assist:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Dry Run</td>
</tr>
<tr>
<td></td>
<td>- Consult</td>
</tr>
<tr>
<td></td>
<td>- Live Event Support</td>
</tr>
<tr>
<td></td>
<td>- Audio Streaming</td>
</tr>
<tr>
<td></td>
<td>- Video</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Indicates that the live meeting is in process.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>The status of the meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Start:</strong> You can start this meeting that you are hosting at any time by clicking the link.</td>
</tr>
<tr>
<td></td>
<td>- **Join</td>
</tr>
<tr>
<td></td>
<td>- <strong>Join:</strong> Lets you join the meeting in progress.</td>
</tr>
<tr>
<td></td>
<td>- <strong>End:</strong> Ends the meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Join:</strong> (for attendees) The meeting that you are invited to has started, and you can now join the meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Registration:</strong> (for attendees) The meeting that you are invited to requires registration. To display a page on which you can register to attend the meeting, click the link. (Does not apply to sales meetings or support sessions.)</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Cancels any meetings that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the meeting. Another message appears, allowing you to inform any invited attendees that you canceled the meeting. (Does not apply to support sessions.)</td>
</tr>
</tbody>
</table>
About the My WebEx Meetings page - Monthly tab

How to access this tab
On your WebEx service Web site, click My WebEx > My Meetings > Monthly tab.

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Month</td>
<td>The month for the monthly calendar of meetings. The default is the current month.</td>
</tr>
<tr>
<td>Previous Month</td>
<td>Click the Previous Month icon to display a list of meetings for the previous month.</td>
</tr>
<tr>
<td>Next Month</td>
<td>Click the Next Month icon to display a list of meetings for the next month.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td>Week Number link</td>
<td>Opens the Weekly view, which shows the scheduled meetings for each day of the selected week.</td>
</tr>
<tr>
<td>Day link</td>
<td>Opens the Daily view, which shows the scheduled meetings for the selected day.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the meetings or Personal Conference meetings to which you have been invited.</td>
</tr>
</tbody>
</table>
Chapter 22: Using My WebEx

About the My WebEx Meetings page - All Meetings tab

How to access this tab

On your WebEx service Web site, click My WebEx > My Meetings > All Meetings tab.

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh icon]</td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>![Language link]</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>![Time zone link]</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>![Date]</td>
<td>The date for the daily list of meetings. The default is the current date.</td>
</tr>
<tr>
<td>![Previous Day]</td>
<td>Click the Previous Day icon to display a list of meetings for the previous day.</td>
</tr>
<tr>
<td>![Next Day]</td>
<td>Click the Next Day icon to display a list of meetings for the next day.</td>
</tr>
<tr>
<td>![Search for meetings by date, host, topic, or words in the agenda]</td>
<td>Allows you type or select a date range to search for meetings, or allows you to type text to search in host names, topics, or agendas. Click Search to start the search.</td>
</tr>
<tr>
<td>![Calendar]</td>
<td>Click the Calendar icon to open the Calendar window. Click on any date to select that date as part of your search criteria.</td>
</tr>
<tr>
<td>![The meetings you host]</td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td>Topic</td>
<td>The topic for a meeting that you are hosting. Click the topic name to get information about that meeting. If you are the alternate host for a Meeting, the topic appears in italics.</td>
</tr>
<tr>
<td></td>
<td>Indicates that the live meeting is in process.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
The meetings you are invited to | Shows a list all of the meetings or Personal Conference meetings to which you have been invited.
Show past meetings | Select to include concluded meetings in the list of meetings.
[▲](#)  | The **Ascending Sort** indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.
[▼](#)  | The **Descending Sort** indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.
Time | The starting time for each scheduled meeting. Click the box next to a meeting start time to select that meeting. Click the box next to the **Time** column heading to select or clear all meetings in the list.
Topic | The topic for a meeting that you are hosting. Click the topic name to get information about that meeting. If you are the alternate host for a Meeting, the topic appears in italics.
Type | Indicates the type of online meeting that you are hosting. Available meeting types depend on the configuration of your WebEx service Web site.
Assist | If an Assist has been requested for this meeting, indicates the type of Assist:
- None
- Dry Run
- Consult
- Live Event Support
- Audio Streaming
- Video
[□](#)  | Indicates that the live meeting is in process.
Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The status of the meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Start</strong>: You can start this meeting that you are hosting at any time by clicking the link.</td>
</tr>
<tr>
<td></td>
<td>- **Join</td>
</tr>
<tr>
<td></td>
<td>- <strong>Join</strong>: Lets you join the meeting in progress.</td>
</tr>
<tr>
<td></td>
<td>- <strong>End</strong>: Ends the meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Join</strong>: (for attendees) The meeting that you are invited to has started, and you can now join the meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Registration</strong>: (for attendees) The meeting that you are invited to requires registration. To display a page on which you can register to attend the meeting, click the link. (Does not apply to sales meetings or support sessions.)</td>
</tr>
<tr>
<td>Delete</td>
<td>Cancels any meetings that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the meeting. Another message appears, allowing you to inform any invited attendees that you canceled the meeting. (Does not apply to support sessions.)</td>
</tr>
</tbody>
</table>

### Maintaining Your Personal Meeting Room Page

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your Personal Meeting Room page</td>
<td><em>About your Personal Meeting Room</em> (on page 305)</td>
</tr>
<tr>
<td>access your Personal Meeting Room page</td>
<td><em>Viewing your Personal Meeting Room</em> (on page 305)</td>
</tr>
<tr>
<td>add images and text to your Personal Meeting Room page</td>
<td><em>Setting options for your Personal Meeting Room</em> (on page 306)</td>
</tr>
<tr>
<td>share files on your Personal Meeting Room page</td>
<td><em>Sharing files on your Personal Meeting Room</em> (on page 307)</td>
</tr>
</tbody>
</table>
About your Personal Meeting Room page

Your user account includes a Personal Meeting Room page on your WebEx service Web site. Users who visit your page can:

- View a list of online meetings that you are hosting, either scheduled or in progress.
- Join a meeting in progress.
- View your personal folders and upload or download files to or from your folders, depending on the settings you specify for your folders.

You can customize your Personal Meeting Room page by adding images and text to it.

To provide users with access to your Personal Meeting Room page, you must provide them with your Personal Meeting Room URL. For more information, see Viewing your Personal Meeting Room page (on page 305).

Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

Viewing your Personal Meeting Room page

You can view your Personal Meeting Room page at any time, by going to the link for the page. The link for your Personal Meeting Room page is available on your:

- My WebEx Meetings page
- My WebEx Profile page

To view your Personal Meeting Room page:

1. Log in to your WebEx service Web site, and then click My WebEx.
   The My WebEx Meetings page appears.

2. Click the Go to My Personal Meeting Room link.
   Alternatively, in My WebEx, click My Profile, and then click the Personal Meeting Room URL link in the Personal Meeting Room section.

Your Personal Meeting Room page appears. The following is an example of a Personal Meeting Room page.
Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

Setting options for your Personal Meeting Room page

You can add the following to your Personal Meeting Room page:

- An image (for example, you can add a picture of yourself or your company's product).
- A custom banner image to the header area of your Personal Meeting Room page, if your user account has the “branding” option. For example, you can add your company's logo.
- A welcome message. For example, you can provide a greeting; instructions on joining an online session; information about yourself, your product, or your company.

At any time, you can replace or delete images and text that you add.

To add an image to your Personal Meeting Room page:

1. If you have not already done so, log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 292).
2. On the navigation bar at the top of the page, click My WebEx.
3. Click My Profile.
   The My WebEx Profile page appears.
5. At the bottom of the My WebEx Profile page, click Update.
6. For details about the options for your Personal Meeting Room page, see About your Personal Meeting Room page (on page 305).
Sharing files on your Personal Meeting Room page

You can share folders on your My WebEx Files: Folders page so that they appear on the **Files** tab on your Personal Meeting Room page. For any folder that you share, you can specify whether users can download files from or upload files to the folder.

For more information about your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 305).

**To share files on your Personal Meeting Room page:**

1. Open the My WebEx Files page. For details, see *Opening your personal folders, documents, and files* (on page 310).
2. Under **Name**, locate the folder in which you want to share files.
3. If the file or folder is in a closed folder, click the folder to open it.
4. Click the **Properties** icon for the folder in which you want to share files.

The Edit Folder Properties window appears.

5. Specify sharing options for the folder.
6. Click **Update**.
Chapter 22: Using My WebEx

For details about sharing options, see About the Edit Folder Properties page (on page 317).

Using Access Anywhere (My Computers)

For information about and instructions for using Access Anywhere to set up and access a remote computer, please refer to the guide Getting Started with WebEx Access Anywhere. This guide is available on the Support page on your WebEx service Web site.

About the My Computers page

How to access this page

On your WebEx service Web site, click My WebEx Files > My Computers.

What you can do here

Set up and access remote computers using Access Anywhere.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>The name you have assigned to your remote computer.</td>
</tr>
</tbody>
</table>
| Status         | The status of your remote computer:  
|                |   ▪ **Available**—the computer is available for remote access.  
|                |   ▪ **Offline**—the computer is offline and is not available for remote access. |
| Application    | The application on your remote computer that you have allowed to access, based on what you specified during set up.  
|                |    It may be **Desktop**, if you set up your desktop for access, or it may be a specific application name. |
| Status         | If the computer is available for access, you can click the **Connect** link to connect to your remote computer. |
| Remove         | Removes the selected computer from the list of remote computers. |
Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Up Computer</td>
<td>Sets up the current computer for Access Anywhere and adds it to the list of remote computers.</td>
</tr>
<tr>
<td>Download manual installer</td>
<td>Downloads the manual installer for the Access Anywhere software.</td>
</tr>
</tbody>
</table>

Maintaining files in your personal folders

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal storage space for files</td>
<td>About maintaining files in your folders (on page 310)</td>
</tr>
<tr>
<td>open your personal storage space for files</td>
<td>Opening your personal folders, documents, and files (on page 310)</td>
</tr>
<tr>
<td>create new folders to organize your files</td>
<td>Adding new folders to your personal folders (on page 311)</td>
</tr>
<tr>
<td>upload files to your personal folders</td>
<td>Uploading files to your personal folders (on page 311)</td>
</tr>
<tr>
<td>move or copy files or an entire folder to another folder</td>
<td>Moving or copying files or folders in your personal folders (on page 312)</td>
</tr>
<tr>
<td>change information about files or folders, including their names or descriptions</td>
<td>Editing information about files or folders in your personal folders (on page 313)</td>
</tr>
<tr>
<td>search for files or folders in your personal storage space for files</td>
<td>Searching for files or folders in your personal folders (on page 314)</td>
</tr>
<tr>
<td>download files in your personal storage space to your computer</td>
<td>Downloading files in your personal folders (on page 314)</td>
</tr>
<tr>
<td>share, or publish, files in your personal folders on your Personal Meeting Room, so others can access them</td>
<td>Sharing files on your Personal Meeting Room page (on page 307)</td>
</tr>
<tr>
<td>remove files or folders from your personal folders</td>
<td>Deleting files or folders in your personal folders (on page 315)</td>
</tr>
</tbody>
</table>
About maintaining files in your folders

Your user account includes personal storage space for files on your WebEx service Web site.

In your personal storage space, you can:

- Create folders to organize your files.
- Edit information about any file or folder in your personal folders.
- Move or copy a file or folder to a different folder.
- Share a folder so it appears on your Personal Meeting Room page.

Tip:

- You can use this storage space to access important information when you are away from the office. For example, if you are on a business trip and want to share a file during an online session, you can download the file in your personal folders to a computer, and then share the file with attendees.
- If you share a folder, visitors to your Personal Meeting Room page can upload files to or download them from the folder. For example, you can use your personal folders to exchange documents that you share in your sessions, archive recorded meetings, and so on. For more information about your Personal Meeting Room, see About your Personal Meeting Room (on page 305)

Opening your personal folders, documents, and files

To store files on your WebEx service Web site, or to access files that you stored, you must open your personal folders.

To open your personal folders:

1. Log in to your WebEx service Web site, and then click My WebEx.
2. Click My Files.

   The My WebEx Files page appears, showing your personal folders and files. Depending on the settings for your WebEx Service Web site, you may see different categories of folders and files, and you can click on the heading links to see each category:

   - My Documents
   - My Recordings
   - My Event Recordings (available only in Event Center)
   - My Training Recordings (available only in Training Center)
Chapter 22: Using My WebEx

For details about the My WebEx Files page, see *About the My WebEx Files > My Documents page* (on page 315) and *About the My WebEx Files > My Recordings page* (on page 326).

Adding new folders to your personal folders

To organize your files on your WebEx service Web site, you can create folders in your personal storage space for files.

To create a new folder:

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 310).
2. Under Action, click the Create Folder button for the folder in which you want a new folder.

The Create Folder window appears.

3. In the Folder Name box, type a name for the folder.
4. Optional. In the Description box, type a description to help you to identify the folder's contents.
5. Click OK.

Uploading files to your personal folders

To store files in your personal folders on your WebEx service Web site, you must upload them from your computer or a local server.
You can upload:

- Up to three files at once
- Any file that is less than 5076K

The amount of space available for storing files is determined by your site administrator. If you require more disk space, contact your site administrator.

**To upload files to your personal folders:**

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 310).
2. Locate the folder in which you want to store the file.
3. Under *Action* for the folder, click the *Upload* button for the folder in which you want to store the file.

   The Upload File window appears.

4. Click *Browse*.

   The Choose File dialog box appears.

5. Select the file that you want to upload to your folder.

6. Click *Open*.

   The file appears in the *File name* box.

7. Optional. In the *Description* box, type a description to help you to identify the file.

8. Optional. Select up to two additional files to upload.

9. Click *Upload*.

   The files are uploaded to the folder that you selected.

10. Once you are finished uploading files, click *Finish*.

### Moving or copying files or folders in your personal folders

You can move one or more files or folders to another folder on your WebEx service Web site.
To move or copy a file or folder:

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 310).
2. Locate the file or folder that you want to move.
3. Select the check box for the file or folder that you want move.
   You can select multiple files or folders.
4. Click *Move* or *Copy*.
   The Move/Copy File or Folder window appears, showing a list of your folders.
5. Select the option button for the folder in which you want to move or copy the file or folder.
6. Click *OK*.

**Editing information about files or folders in your personal folders**

You can edit the following information about a file or folder in your personal folders on your WebEx service Web site:

- Name
- Description

You can also specify sharing options for folders that appear on your Personal Meeting Room page. For more information, see *Sharing files on your Personal Meeting Room page* (on page 307).

To edit information about a file or folder:

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 310).
2. Locate the file or folder for which you want to edit information.
3. Click the *Properties* icon for the file or folder for which you want to edit information.

The Edit File Properties or Edit Folder Properties window appears.
In the Description box, type a new name for the file or folder.

In the Name box, type a new name for the file or folder.

4. Click Update.

Searching for files or folders in your personal folders

In your personal folders on your WebEx service Web site, you can quickly locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description.

To search for a file or folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 310).

2. In the Search For box type all or part of the file's name or description.

3. Click Search.

A list of any files or folders that contain the search text appears.

Downloading files in your personal folders

In your personal folders on your WebEx service Web site, you can download any files to your computer or a local server.
1 Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 310).

2 Locate the file that you want to download.

3 Under *Action*, click the *Download* button for the file that you want to download.

   The File Download dialog box appears.

4 Follow any instructions that your Web browser or operating system provides to download the file.

### Deleting files or folders in your personal folders

You can delete files or folders in your personal folders on your WebEx service Web site.

**To delete a file or folder:**

1 Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 310).

2 Under *Name*, locate the file or folder that you want to delete.

3 Select the check box for the file or folder that you want delete.
   
   You can select multiple files or folders.

4 Click *Delete*.

### About the My WebEx Files > My Documents page

**How to access this page**

On your WebEx service Web site, click My *WebEx Files > My Documents*.

**What you can do here**

- Store files that you use in your online sessions or that you want to access when away from your office.

- Specify in which folders that visitors to your Personal Meeting Room can download or upload files.
## Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>The storage space available for your files, in megabytes (MB).</td>
</tr>
<tr>
<td>Used</td>
<td>The amount of storage space that your files occupy, in megabytes (MB). Once this value exceeds your capacity, you can no longer store files until you remove existing files from your folders.</td>
</tr>
<tr>
<td>Search for</td>
<td>Lets you locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description. To search for a file or folder, type all or part of its name or description in the box, and then click <strong>Search</strong>.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the folder or file. Click a folder or file name to open the Folder Information page or File Information page. From the Information page, you can access the properties of a folder or file.</td>
</tr>
<tr>
<td>Path</td>
<td>The folder hierarchy for the folder or file. The <strong>Root</strong> folder is the top-most folder in which all other folders and files reside.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the folder or file, in kilobytes (KB).</td>
</tr>
<tr>
<td>Actions</td>
<td>Click the icons to perform an action on the folder or file that is associated with it.</td>
</tr>
<tr>
<td>Upload file</td>
<td>Available only for files. Click this icon to open the File Upload page, on which you can select up to three files at a time to upload to a specified folder.</td>
</tr>
<tr>
<td>Download file</td>
<td>Available only for files. Click this icon to download the file associated with it.</td>
</tr>
<tr>
<td>Edit File Properties or Edit Folder Properties</td>
<td>Click this icon to open the Edit File Properties page or Edit Folder Properties page, on which you can edit information about the file or folder, respectively.</td>
</tr>
<tr>
<td>Create Folder</td>
<td>Available for folders only. Click this icon to open the Create Folder page on which you can create a new folder in your personal storage space.</td>
</tr>
<tr>
<td>Shared</td>
<td>Specifies the sharing settings for a folder; that is, how others who visit your Personal Meetings Room can access your folder and its files.</td>
</tr>
<tr>
<td>Link or option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>R</strong></td>
<td><strong>Read only:</strong> Visitors to your Personal Meeting Room can view the list of files in the folder and download the files.</td>
</tr>
<tr>
<td><strong>W</strong></td>
<td><strong>Write only:</strong> Visitors to your Personal Meeting Room can upload files to the folder, but they cannot view the files in it.</td>
</tr>
<tr>
<td><strong>R/W</strong></td>
<td><strong>Read and write:</strong> Users can view files in the folder, download files from the folder, and upload files to the folder.</td>
</tr>
<tr>
<td></td>
<td><strong>Password Protected:</strong> Indicates that the folder is password protected. Visitors to your Personal Meeting Room must provide the password you specify to access the folder.</td>
</tr>
</tbody>
</table>

**Select All**
Selects the check boxes for all the folders and files that are visible in the list. You can then click the **Copy** or **Move** button or click the **Delete** link to perform an action on the selected folders or files.

**Clear All**
Clears the check boxes for all the folders and files that are selected in the list.

**Delete**
Deletes the selected folders and files from the list.

**Copy**
Opens a page on which you can copy the selected folder or file to another folder.

**Move**
Opens a page on which you can move the selected folder or file to another folder.

---

**About the Edit Folder Properties page**

**How to access this page**
On your WebEx service Web site, click **My WebEx > My Files > Properties** icon for folder.

**What you can do here**
Specify a name, a description, and sharing options for a folder that you created in your personal folders.
## Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the folder.</td>
</tr>
<tr>
<td>Share</td>
<td>Specify who can access this folder.</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Do not share this folder:</strong> This folder does not appear on your Personal Meeting Room page. Thus, visitors to your page cannot view the folder or access any files in it.</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Share this folder:</strong> This folder appears on your Personal Meeting Room. The drop-down list specifies which users can access the folder, as follows:</td>
</tr>
<tr>
<td></td>
<td>□ With all: All visitors to your Personal Meeting Room can access this folder.</td>
</tr>
<tr>
<td></td>
<td>□ With users with host or attendee accounts: Only visitors to your Personal Meeting Room who have either a host account or an attendee account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td></td>
<td>□ With users with host accounts only: Only visitors to your Personal Meeting Room who have a host account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td>Share as</td>
<td>Enter the name for the folder that will appear on your Personal Meeting Room page.</td>
</tr>
<tr>
<td>Read</td>
<td>Let visitors to your Personal Meeting Room view the list of files in the folder and download the files.</td>
</tr>
<tr>
<td>Write</td>
<td>Let visitors to your Personal Meeting Room upload files to the folder but does not allow them to view the files in it.</td>
</tr>
<tr>
<td>Read &amp; write</td>
<td>Let users view files in the folder, download files from the folder, and upload files to the folder.</td>
</tr>
<tr>
<td>Allow files to be overwritten</td>
<td>Let users upload a file with the same name as an existing file in the folder and replace the existing file. If this option is not selected, users cannot overwrite any files in the folder.</td>
</tr>
</tbody>
</table>
Chapter 22: Using My WebEx

### Use this option…

**Password protected**

Let only visitors to your Personal Meeting Room who know the password view the list of files in the folder, download files from the folder, or upload files to the folder, depending on the read/write settings for the folder.

**Password:** The password that visitors to your Personal Meeting Room must provide to access the folder.

**Confirm:** If you specified a password, type it again to verify that you typed it correctly.

**Update**

Save any changes that you made to folder’s properties, and then closes the Edit Folder Properties window.

**Cancel**

Close the Edit Folder Properties window, without saving any of the changes that you made.

---

### Opening the My Recordings Page

To upload or maintain recordings, you must do so from the My Recordings page on your WebEx service Web site.

**To open the My Recordings page:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Files > My Recordings**.

   The My Recordings page appears, showing your recording files.

For details about the My Recordings page, see *About the My WebEx Files > My Recordings page* (on page 326).

### Uploading a recording file

If you recorded a meeting using the integrated or standalone WebEx Recorder, you can upload the recording file, with a `.wrf` extension, from your local computer to the My Recordings page.

For instructions on editing a recording, see *Editing information about a recording* (on page 320).

**Note:** If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx server automatically uploads the recording file, with an `.arf` extension, to the appropriate tab on the My Recordings page once you stop the Recorder. You do not need to upload it yourself.
To upload a recording file:

1. Go to the My Recordings page. For details, see *Opening the My Recordings page* (on page 319).

2. Click **Add Recording**.

3. On the Add Recording page, enter information and specify options.
   For details about what you can do with each option on the Add/Edit Recordings page, see *About the My WebEx Files > My Recordings page* (on page 326).

4. Click **Save**.

**Editing information about a recording**

You can edit information about a recording at any time.

**To edit information about a recording:**

1. Go to the My Recordings page. For details, see *Opening the My Recordings page* (on page 319).

2. Click the following icon for the recording that you want to edit.

   ![Edit icon]

   The Edit Recording page appears.

3. Make your changes.
   For details about what you can do with each option on the Edit Recording page, see *About the My WebEx Files > My Recordings page* (on page 326).

4. Click **Save**.

**Sending an email to share a recording**

You can send an email one or more people to share your recording with them.

**To send an email to share a recording with others:**

1. Go to the My Recordings page. For details, see *Opening the My Recordings page* (on page 319).

2. Click the appropriate link for your recording type:
   - **Meetings**
   - **Events**
Chapter 22: Using My WebEx

- Sales Meetings
- Training Sessions
- Miscellaneous

3 Open the Share My Recording window:
   - Click the following icon for the recording that you want to share with others.

   ![Icon]

   - Click the linked name of the recording you want to share. On the Recording Information page, click Send Email.

   ![Send Email]

   The Share My Recording window appears.

4 Select recipients for your email:
   - Click Select Recipients to select contacts from your Contacts list
   - Type email addresses in the Send to list, separated by commas.

5 (Optional) Type a message in the Your message box.

6 Click Send.

Your email message will be sent to the selected recipients, and will include information about the recording and a link to play it.
About the Add/Edit Recording page

How to access this page

If you are adding a recording...
1. On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2. Click Add Recording.

If you are editing information about a recording...
1. On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2. Click the More button in the row of the recording that you want to edit.
3. Click Modify.

What you can do here

- Edit general information about a recording, including the topic and description.
- Require a password to play or download the recording.

Options on this page

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Specify the topic of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of this recording.</td>
</tr>
<tr>
<td>Recording file</td>
<td>Click Browse to select the recording file that resides on your</td>
</tr>
</tbody>
</table>
### Use this option.... | To....
---|---
local computer. 

**Duration** | Specify the duration of the recording.

**File size** | Displays the size of the recording file. (Available only when editing recording information.)

**Set password** | Set an optional password that users must provide to view the recording.

**Confirm password** | Confirm the password that users must provide to view the recording.

---

## Playback control options

### Use this option.... | To....
---|---
**Panel Display Options** | Determines which panels are displayed in the recording when it is played back. You can select *any* of the following panels to be included in the recording playback:
- Chat
- Q & A
- Video
- Polling
- Notes
- File Transfer
- Participants
- Table of Contents

Panel display options do not modify the panel display in the actual recording that is stored on the WebEx network.
Use this option... | To...
---|---
Recording Playback Range | Determines how much of the recording is actually played back. You can select *either* of the following:
  - **Full playback**: Plays back the full length of the recording. This option is selected by default.
  - **Partial playback**: Plays back only part of the recording based on your settings for the following options:
    - **Start: X min X sec of the recording**: Specifies the time to start playback; for example, you can use this option if you would like to omit the "dead time" at the beginning of the recording, or if you would like to show only a portion of the recording.
    - **End: X min X sec of the recording**: Specifies the time to end playback; for example, you can use this option if you would like to omit the "dead time" at the end of the recording. You can not specify an end time greater than the length of the actual recording.

The partial playback range you specify does not modify the actual recording that is stored on the server.

Include NBR player controls | Includes full Network Recording Player controls, such as stop, pause, resume, fast forward, and rewind. This option is selected by default. If you would like to prevent viewers from skipping portions of the recording, you can turn off this option to omit Network Recording Player controls from the playback.

### About the Recording Information page

**How to access this page**

On your WebEx service Web site, click **My WebEx > My Files > My Recordings > [recording type] > [topic of a recording]**.

**What you can do here**

- View information about the recording.
- Play back the recording.
- Send an email to share the recording with others.
- Download the recording.
- Enable or disable the recording.
Open the Edit Recording page on which you can edit information about a recording.

### Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The name of the recording. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Create time</td>
<td>The time and date the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>The file size of the recording.</td>
</tr>
<tr>
<td>Create time</td>
<td>The date and time at which the recording was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the recording. The possible options are Enable or Disable.</td>
</tr>
<tr>
<td>Password</td>
<td>Indicates whether a user must provide a password to view the recording.</td>
</tr>
<tr>
<td>Stream recording link</td>
<td>Clicking the link lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).</td>
</tr>
<tr>
<td>Download recording link</td>
<td>Clicking the link lets you download the recording.</td>
</tr>
</tbody>
</table>

Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording. If you want to send the email with your local email client instead, click the link for using the email client under **Share My Recording**.

Clicking the button on the right opens the Edit Recording page. Clicking the button deletes the recording. Clicking the button disables the recording everywhere it is published on your WebEx Service Web site. (Available only for...
Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>enabled recordings.)</td>
</tr>
<tr>
<td>Enable</td>
<td>Clicking the button enables the recording everywhere it is published on your WebEx Service Web site. (Available only for disabled recordings.)</td>
</tr>
<tr>
<td>Back to List</td>
<td>Clicking the button returns you to the recording list.</td>
</tr>
</tbody>
</table>

About the My WebEx Files > My Recordings page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings.

What you can do here
Manage, upload, and maintain your recording files.

Options on this page
View different categories of recordings:
- Meetings
- Events
- Sales Meetings
- Training Sessions
- Miscellaneous

About the My WebEx Files > My Recordings > Meetings page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Meetings.

What you can do here
Manage, upload, and maintain recording files of meetings you host.
## Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refreshes the information on the page.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows you type text to search for within recording names. Click <strong>Search</strong> to start the search.</td>
</tr>
<tr>
<td><strong>You are currently using X % of Y GB</strong></td>
<td>The percentage of available personal storage space on your WebEx Service Web site that is being used by your recordings. This field appears only if your site administrator has turned on the option to show personal recording storage allocation usage. If this field does appear, and you exceed your personal storage allocation, you will not be able to record meetings until some recordings are deleted or the storage allocation is increased by your system administrator.</td>
</tr>
<tr>
<td><strong>Site storage X % of Y GB</strong></td>
<td>The percentage of total available storage space on your WebEx Service Web site that is being used by all recordings on your site. If your site exceeds its storage allocation, users will not be able to record meetings until recordings are deleted or the storage allocation is increased by your system administrator.</td>
</tr>
<tr>
<td><img src="image" alt="Disabled" /></td>
<td>Indicates a disabled recording.</td>
</tr>
<tr>
<td>Topic</td>
<td>The name of the recording. If you record a meeting on the server, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the meeting. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the recording.</td>
</tr>
<tr>
<td>Create Time/Date</td>
<td>The date and time the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Format</td>
<td>The format of the recording file. A recording file can be in WebEx Advanced Recording Format (ARF) or WebEx Recording Format (WRF). You can also store recording files that are in Windows Media Audio/Video (WMV) or Shockwave Flash Object (SWF) format.</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Lets you play the recording (available only for recording files with an .arf extension that were recorded by the Network-Based Recorder). If playback of the file requires a password, you must provide the password.</td>
</tr>
<tr>
<td><img src="image" alt="Share" /></td>
<td>Lets you send an email to share this recording with others.</td>
</tr>
</tbody>
</table>
### About the My WebEx Files > My Recordings > Miscellaneous page

#### How to access this page

Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Miscellaneous.

#### What you can do here

Manage, upload, and maintain recording files of meetings you host.

#### Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Refreshes the information on the page.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows you type text to search for within recording names. Click Search to start the search.</td>
</tr>
<tr>
<td>You are currently using X% of Y GB</td>
<td>The percentage of available personal storage space on your WebEx Service Web site that is being used by your recordings. This field appears only if your site administrator has turned on the option to show personal recording storage allocation usage.</td>
</tr>
</tbody>
</table>
### Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field does appear, and you exceed your personal storage allocation, you will not be able to record meetings until some recordings are deleted or the storage allocation is increased by your system administrator.</td>
</tr>
<tr>
<td><strong>Site storage X % of Y GB</strong></td>
<td>The percentage of total available storage space on your WebEx Service Web site that is being used by all recordings on your site. If your site exceeds its storage allocation, users will not be able to record meetings until recordings are deleted or the storage allocation is increased by your system administrator.</td>
</tr>
<tr>
<td>☢</td>
<td>Indicates a disabled recording.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The name of the recording. If you record a meeting on the server, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the meeting. You can edit the topic at any time.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>The size of the recording.</td>
</tr>
<tr>
<td><strong>Create Time/Date</strong></td>
<td>The date and time the recording was created.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>The length of the recording.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>The format of the recording file. A recording file can be in WebEx Advanced Recording Format (ARF) or WebEx Recording Format (WRF). You can also store recording files that are in Windows Media Audio/Video (WMV) or Shockwave Flash Object (SWF) format.</td>
</tr>
<tr>
<td></td>
<td>Lets you play the recording (available only for recording files with an .arf extension that were recorded by the Network-Based Recorder). If playback of the file requires a password, you must provide the password.</td>
</tr>
<tr>
<td></td>
<td>Lets you send an email to share this recording with others.</td>
</tr>
<tr>
<td></td>
<td>Displays a menu with more options for your recording:</td>
</tr>
<tr>
<td></td>
<td>• Download: Lets you download the recording to your local computer. If downloading the file requires a password, you must provide the password.</td>
</tr>
<tr>
<td></td>
<td>• Modify: Lets you edit information of the recording. For details, see About the Add/Edit Recordings page (on page 322).</td>
</tr>
<tr>
<td></td>
<td>• Disable: Lets you disable the recording in all locations.</td>
</tr>
<tr>
<td></td>
<td>• Delete: Lets you delete the recording from this page.</td>
</tr>
</tbody>
</table>
Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>Indicates that a recording is password-protected.</td>
</tr>
</tbody>
</table>

Maintaining contact information

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal address book</td>
<td>About maintaining contact information (on page 331)</td>
</tr>
<tr>
<td>open your personal address book</td>
<td>Opening your address book (on page 331)</td>
</tr>
<tr>
<td>add a new contact to your personal address book</td>
<td>Adding a contact to your address book (on page 332)</td>
</tr>
<tr>
<td>add multiple contacts to your address book at once</td>
<td>Importing contact information in a file to your address book (on page 335)</td>
</tr>
<tr>
<td>add contacts in Microsoft Outlook to your personal address book</td>
<td>Importing contact information from Outlook to your address book (on page 338)</td>
</tr>
<tr>
<td>view or change information about contacts in your personal address book</td>
<td>Viewing and editing contact information in your address book (on page 338)</td>
</tr>
<tr>
<td>find a contact in your personal address book</td>
<td>Finding a contact in your personal address book (on page 339)</td>
</tr>
<tr>
<td>combine multiple contacts into a single distribution list</td>
<td>Creating a distribution list in your address book (on page 340)</td>
</tr>
<tr>
<td>edit information about a distribution list</td>
<td>Editing a distribution list in your address book (on page 341)</td>
</tr>
<tr>
<td>delete a contact or distribution list</td>
<td>Deleting contact information in your address book (on page 343)</td>
</tr>
</tbody>
</table>
About maintaining contact information

You can maintain a personal online address book, in which you can add information about contacts and create distribution lists. When scheduling a meeting or starting an instant meeting, you can quickly invite any contacts or distribution lists in your personal address book. You can also invite contacts in the Company Address Book for your WebEx service Web site, if one is available.

You can add contacts to your personal address book in any of the following ways:

- Specify information about contacts one at a time.
- Import contact information from your Microsoft Outlook contacts.
- Import contact information from a comma-separated/comma-delimited values (CSV) file.

You can also edit or delete the information about any contact or distribution list in your personal address book.

Opening your address book

You can open your personal address book on your WebEx service Web site, to view or maintain information about your contacts.

To open your address book:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 292).
2. On the navigation bar at the top of the page, click My WebEx.
3. Click My Contacts.

The My WebEx Contacts page appears.
In the View drop-down list, select one of the following contact lists:

- **Personal Contacts**: Includes any individual contacts or distribution lists that you added to your personal address book. If you have a Microsoft Outlook address book or contacts folder, you can import its contacts to this list of contacts.

- **Company Address Book**: Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.

### Adding a contact to your address book

You can add contacts to your personal address book, one at a time.

**To add a contact to your personal address book:**

1. Open your personal address book. For details, see *Opening your address book* (on page 331).
2. In the **View** drop-down list, select **Personal Contacts**.
   
   A list of contacts in your Personal Contacts list appears.
3. Click **Add Contact**.
The Add Contact page appears.

**My WebEx Contacts**

**New Contact**

- Full name:  
- Email address:  
- Company:  
- Job title:  
- URL:  
- Phone number:  
- Phone number for mobile device:  
- Fax number:  
- Address1:  
- Address2:  
- City:  
- State/Province:  
- ZIP/Postal code:  
- Country/Region:  
- User name:  
- Notes: 

![Add Cancel](image)

4. Provide information about the contact.

5. Click **Add**.

For descriptions of the information and options on the New Contact page, see *About the New/Edit Contact page* (on page 334).

**Note:**
- You cannot add contacts to your Company Address Book.
- If you want to add multiple contacts, you can them all at once, instead of adding one contact at a time. For details, see *Importing contact information in a file to your address book* (on page 335).
About the New/Edit Contact page

How to access this page

On your WebEx service Web site, click My WebEx > My Contacts > Add Contact or [check box for contact] > Edit.

What you can do here

Enter information about a new or existing contact for your personal address book.

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name</td>
<td>Enter the contact's first and last name.</td>
</tr>
<tr>
<td>Email address</td>
<td>Enter the contact's email address.</td>
</tr>
<tr>
<td>Language</td>
<td>Set the language in which any email messages that you send to the contact using your WebEx service site appear. Available only if your WebEx service Web site can be displayed in two or more languages.</td>
</tr>
<tr>
<td>Company</td>
<td>Enter the company or organization for which the contact works.</td>
</tr>
<tr>
<td>Job title</td>
<td>Enter the contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>Phone number/Phone number for mobile device/Fax number</td>
<td>Enter the contact's phone numbers. For each number, you can specify the following:</td>
</tr>
<tr>
<td>Country Code</td>
<td>Specify the number that you must dial if the contact resides in another country. To select a different country code, click the link to display the Country Code window. From the drop-down list, select the country in which the contact resides.</td>
</tr>
<tr>
<td>Area or city code</td>
<td>Enter the area or city code for the contact's phone number.</td>
</tr>
<tr>
<td>Number</td>
<td>Enter the phone number.</td>
</tr>
<tr>
<td>Extension</td>
<td>Enter the extension for the phone number, if any.</td>
</tr>
<tr>
<td>Address 1</td>
<td>Enter the contact's street address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>Enter additional address information, if necessary.</td>
</tr>
</tbody>
</table>
## Importing contact information in a file to your address book

You can add information about multiple contacts simultaneously to your personal address book, by importing a comma-separated values (CSV) file. A CSV file has the `.csv` file extension; you can export information from many spreadsheet and email programs in CSV format.

### To create a CSV file:

1. Open your address book. For details, see *Opening your address book* (on page 331).

2. In the **View** drop-down list, ensure that **Personal Address Book** is selected.

3. Click **Export**.

4. Save the `.csv` file to your computer.

5. Open the `.csv` file that you saved in a spreadsheet program, such as Microsoft Excel.

6. Optional. If contact information exists in the file, you can delete it.

7. Specify information about the new contacts in the `.csv` file.

   **Important:** If you add a new contact, ensure that the UID field is blank. For information about the fields in the `.csv` file, see *About the Contact Information CSV template* (on page 336).

8. Save the `.csv` file. Ensure that you save it as a `.csv` file.

### To import a CSV file containing new contact information:

1. Open your address book. For details, see *Opening your address book* (on page 331).
Chapter 22: Using My WebEx

2 In the View drop-down list, ensure that Personal Contacts is selected.
3 In the Import From drop-down list, select Comma Delimited Files.
4 Click Import.
5 Select the .csv file in which you added new contact information.
6 Click Open.
7 Click Upload File.
   The View Personal Contacts page appears, allowing you to review the contact information you are importing.
8 Click Submit.
   A confirmation message appears.
9 Click Yes.

Note: If an error exists in any new or updated contact information, a message appears, informing you that no contact information was imported.

About the Contact Information CSV template

How to access this template
On your WebEx service Web site, click My WebEx > My Contacts > View > Personal Address Book > Export.

What you can do here
Specify information about multiple contacts, which you can then import to your personal address book.

Fields in this template

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UUID</td>
<td>A number that your WebEx service site creates to identify the contact. If you add a new contact to the CSV file, you must leave this field blank.</td>
</tr>
<tr>
<td>Name</td>
<td>Required. The contact's first and last name.</td>
</tr>
<tr>
<td>Email</td>
<td>Required. The contact's email address. The email address must be in the following format: <a href="mailto:name@company.com">name@company.com</a></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Company</td>
<td>The company or organization for which the contact works.</td>
</tr>
<tr>
<td>JobTitle</td>
<td>The contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>OffCntry</td>
<td>The country code for the contact's office phone—that is, the number that</td>
</tr>
<tr>
<td></td>
<td>you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>OffArea</td>
<td>The area or city code for the contact's office phone number.</td>
</tr>
<tr>
<td>OffLoc</td>
<td>The contact's office phone number.</td>
</tr>
<tr>
<td>OffExt</td>
<td>The extension for the contact's office phone number, if any.</td>
</tr>
<tr>
<td>CellCntry</td>
<td>The country code for the contact's cellular or mobile phone—that is, the</td>
</tr>
<tr>
<td></td>
<td>number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>CellArea</td>
<td>The area or city code for the contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellLoc</td>
<td>The contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellExt</td>
<td>The extension for the contact's cellular or mobile phone number, if any.</td>
</tr>
<tr>
<td>FaxCntry</td>
<td>The country code for the contact's fax number—that is, the number that</td>
</tr>
<tr>
<td></td>
<td>you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>FaxArea</td>
<td>The area or city code for the contact's fax number.</td>
</tr>
<tr>
<td>FaxLoc</td>
<td>The contact's fax number.</td>
</tr>
<tr>
<td>FaxExt</td>
<td>The extension for the contact's fax machine, if any.</td>
</tr>
<tr>
<td>Address 1</td>
<td>The contact's street address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>The additional address information, if necessary.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The contact's state or province.</td>
</tr>
<tr>
<td>ZIP/Postal</td>
<td>The contact's ZIP or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the contact resides.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name with which the user logs in to your WebEx service Web site,</td>
</tr>
<tr>
<td></td>
<td>if the contact has a user account.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional information about the contact.</td>
</tr>
</tbody>
</table>
Importing contact information from Outlook to your address book

If you use Microsoft Outlook, you can import the contacts that you maintain in your Microsoft Outlook address book or folder to your personal address book on your WebEx service Web site.

**To import contacts from Outlook to your personal address book:**

1. Open your address book. For details, see *Opening your address book* (on page 331).
2. In the View drop-down list, select **Personal Contacts**.
3. In the Import from drop-down list, select **Microsoft Outlook**.
4. Click **Import**. The Choose Profile dialog box appears.
5. In the **Profile Name** drop-down list, select the Outlook user profile that includes the contact information that you want to import.
6. Click **OK**.

**Note:**

- When you import contacts in Outlook, your WebEx service Web site retrieves contact information from the Outlook address book or folder in which you have chosen to keep personal addresses. For information about keeping personal addresses in Outlook, refer to Microsoft Outlook Help.
- If your personal address book already includes a contact who is also in your Outlook contacts list, the contact is *not* imported. However, if you change the contact's email address in your personal address book, importing the contact from Outlook creates a *new contact* in your personal address book.

Viewing and editing contact information in your address book

In your personal address book, you can view and edit information about individual contacts in your Personal Contacts list. You can view, but not edit, information about contacts in your Company Address Book.

**To view or edit contact information:**

1. Open your address book. For details, see *Opening your address book* (on page 331).
2 In the View drop-down list, select one of the following:
   - Personal Contacts
   - Company Address Book
   A list of contacts appears.

3 Locate the contact whose information you want to view or edit. For details about locating a contact, see Finding a contact in your personal address book (on page 339).

4 Under Name, select the contact whose information you want to view or edit.

5 Do one of the following:
   - If the contact is in your Personal Contacts list, click Edit.
   - If the contact is in your Company Address Book, click View Info.
   Information about the contact appears.

6 Optional. If the contact is in your Personal Contacts list, edit the information that you want to change on the Edit Contact's Information page.
   For descriptions of the information and options of the Edit Contact's Information page, see About the New/Edit Contact page (on page 334).

7 Click OK.

Finding a contact in your personal address book

You can quickly locate a contact in your personal address book, using one of several methods.

To search for a contact in your address book:

1 Open your address book. For details, see Opening your address book (on page 331).

2 In the View drop-down list, select a contacts list.

3 Do any of the following:
   - In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, the name Susan Jones appears under S.
   - To search for a contact in the list you are currently viewing, type text that appears in either the contact's name or email address in the Search for box, and then click Search.
If the entire list of contacts does not fit on a single page, view another page by clicking the links for the page numbers.

Sort your personal contacts or company address book by name, email address, or phone number by clicking the column headings.

Creating a distribution list in your address book

You can create distribution lists for your personal address book. A distribution list includes two or more contacts for which you provide a common name and appears in your Personal Contacts list. For example, you can create a distribution list named Sales Department, which includes contacts who are members of your Sales Department. If you want to invite members of the department to a meeting, you can select the group rather than each member individually.

To create a distribution list:

1. Open your address book. For details, see Opening your address book (on page 331).
2. Click Add Distribution List.
   
   The Add Distribution List page appears.

3. In the Name box, type the name of the group.
4. Optional. In the Description box, type descriptive information about the group.
5 Under **Members**, locate the contacts that you want to add to the distribution list, by doing any of the following:

- Search for a contact, by typing all or part of the contact's first or last name in the **Search** box.
- Click the letter that corresponds to the first letter of the contact's first name.
- Click **All** to list all contacts in your Personal Contacts list.

6 Optional. To add a new contact to your Personal Contacts list, under **Members**, click **Add Contact**.

7 In the box on the left, select the contacts that you want to add to the distribution list.

8 Click **Add** to move contacts you selected to the box on the right.

9 After you finish adding contacts to the distribution list, click **Add** to create the list.

   In your Personal Contacts list, the **Distribution List** indicator appears to the left of the new distribution list:

   ![Planning Committee](image)

For descriptions of the information and options on the Add Distribution List page, see **About the Add/Edit Distribution List page** (on page 342).

### Editing a distribution list in your address book

You can add or remove contacts from any distribution list that you have created for your personal address book. You can also change a group's name or descriptive information.

**To edit a distribution list:**

1 Open your address book. For details, see **Opening your address book** (on page 331).

2 In the **View** drop-down list, select **Personal Contacts**.

   A list of the contacts in your Personal Contacts list appears, including any distribution lists that you have created. The **Distribution List** indicator appears to the left of a distribution list:

   ![Planning Committee](image)
Under **Name**, select the name of the distribution list. The Edit Distribution List page appears.

### Edit Distribution List

**Distribution List Information:**

- **Name:** Distributors
- **Description:** SuperSimo distributors for Western Region.

**Members**

Search [Go]

**Personal contacts**

| Index | A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z | All |
| Name  | A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z | All |

Use Ctrl to select multiple users

- Christine Huilo
- Lisa Grantham
- Marcel Tillman
- Sallen Chen

**Selected contacts**

- John Mullen
- Lisa Wei

[Add Contact] [Update] [Cancel]

3. Edit information about the distribution list.

4. Click **Update**.

For descriptions of the information and options on the Edit Distribution List page, see *About the Add/Edit Distribution List* (on page 342).

### About the Add/Edit Distribution List page

#### How to access this page

On your WebEx service Web site, click **My WebEx > My Contacts > Add Distribution List**. Or, select distribution list in Personal Contacts list.
What you can do here
Add contacts to your distribution list or remove contacts from your distribution list.

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the distribution list. For example, if you want to add a distribution list that includes members of your company's sales department, you might name the list <strong>Sales Department</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally enter descriptive information about the distribution list, to help you identify it later.</td>
</tr>
<tr>
<td>Search</td>
<td>Find a contact, by typing all or part of the contact's first or last name.</td>
</tr>
<tr>
<td>Index</td>
<td>Find a contact, by clicking the letter that corresponds to the first letter of the contact's first name. To list contacts for which you identified with a number, click #. To list all contacts in your Personal Contacts list, click All.</td>
</tr>
<tr>
<td>Add&gt;</td>
<td>Add a one or more selected contacts to your distribution list.</td>
</tr>
<tr>
<td>&lt;Remove</td>
<td>Remove one or more selected contacts from your distribution list.</td>
</tr>
<tr>
<td>Add Contact</td>
<td>Add a new contact to your Personal Contacts list and add the contact to your distribution list.</td>
</tr>
<tr>
<td>Add</td>
<td>Add a new distribution list to your Personal Contacts list.</td>
</tr>
<tr>
<td>Update</td>
<td>Update an existing distribution list that you have edited.</td>
</tr>
</tbody>
</table>

Deleting contact information in your address book

You can delete any contact or distribution lists that you have added to your personal address book.

To delete a contact or contact group:

1. Open your address book. For details, see *Opening your address book* (on page 331).

2. In the **View** drop-down list, select **Personal Contacts**.
3 In the list that appears, select the check box for the contact or distribution list that you want to delete.

4 Click **Delete**.

   A message appears, asking you to confirm the deletion.

5 Click **OK**.

## Maintaining your user profile

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining your user profile</td>
<td><em>About maintaining your user profile</em> (on page 344)</td>
</tr>
<tr>
<td>edit your user profile</td>
<td><em>Editing your user profile</em> (on page 351)</td>
</tr>
</tbody>
</table>

### About maintaining your user profile

Once you obtain a user account, you can edit your user profile at any time to do the following:

- Maintain personal information, including your
  - Full name
  - Username (if your site administrator provides this option)
  - Password
  - Contact information (including your street address, email address, and phone numbers)
  - Tracking codes that your organization uses to keep records of your meetings (such as project, department, and division numbers)
- Specify whether to display links to your company's partner sites in the My WebEx navigation bar, if your site administrator set up partner links
- Manage any scheduling templates that you saved
- Set options for your Personal Meeting Room options, including the images and welcome message that appear on the page
- Set default options for your online sessions, including
Chapter 22: Using My WebEx

- The default session type that you want to use, if your account includes multiple session types
- Whether your scheduled meetings are automatically removed from your list of meetings once the meeting ends
- Whether the Quick Start page appears in the content viewer once you start a meeting
- The users who can schedule meetings on your behalf

Set Web site preferences, including:
- The home page that appears when you access your WebEx service Web site
- The time zone in which meeting times appear
- The language in which your Web site displays text, if your site includes multiple languages
- The locale (the format in which your Web site displays dates, times, currency values, and numbers)

About the My WebEx Profile page

**How to access this template**

On your WebEx service Web site, click My WebEx > My Profile.

**What you can do here**

Manage the following:
- Account information
- Personal information
- Partner integration options
- Scheduling templates (does not apply to Support Center)
- Personal Meeting Room information
- Meeting options
- Web page preferences, including your home page and language
- Support Center CSR Dashboard options (Support Center only)
## Personal Information options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| Username           | Specify the username for your account. You can change this name only if the administrator for your WebEx service Web site provides this option.  
**Tip:** If you need to change your username, but cannot edit it on this page, ask your site administrator to change your username or create a new account for you. |
| Change Password    |  
- **Old password:** Type the old password for your account.  
- **New password:** Specify the new password for your account. A password:  
  - Must contain at least four characters  
  - Can consist of a maximum of 32 characters  
  - Can include any letters, numbers, or special characters, but not spaces  
  - Is case sensitive  
- **Retype New password:** Verify that you typed your password correctly in the **New password** box. |
| Call-in authentication | If enabled by your site administrator, allows you to be authenticated and placed into the correct teleconference without needing to enter a meeting number whenever you dial into any CLI (caller line identification) or ANI (automatic number identification) enabled teleconference. Selecting this option for a phone number in your user profile maps your email address to that phone number. Caller authentication is available only if you have been invited to a CLI/ANI enabled teleconference by email during the meeting scheduling process. Caller authentication is not available if you are dialing in to a CLI/ANI enabled teleconference. |
| Call-back          | When selected for a phone number in your user profile, allows you to receive a call from the teleconferencing service if it is using an integrated call-back feature. If your site includes the international call-back option, participants in other countries receive a call back. For more information about this option, ask your site administrator. |
| PIN                | If enabled by your site administrator, allows you to specify a call-in authentication PIN to prevent “spoofers” from using your number to dial into a teleconference. If your site administrator sets the authentication PIN as mandatory for all accounts using call-in authentication on your site, you must specify a PIN number or caller authentication will be disabled for your account. This option is available only if you have selected the **Call-in authentication option** for at least one of the phone numbers in your profile. The PIN can also be used to provide a secondary level of authentication for calls where the host is... |
**Partner integration options**

Your site administrator can set up custom links to the Web sites of your company's partners, and then display the links on the My WebEx navigation bar. For example, if your company uses another company's Web site to provide a service, your site administrator can provide a link to that company's site in your My WebEx navigation bar. You can then show or hide that link.

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display partner links in My WebEx</td>
<td>Shows or hides partner site links in the My WebEx navigation bar.</td>
</tr>
</tbody>
</table>

**Calendar Work Hours options**

Use these options to specify working hours to use with scheduling calendars.

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>Select the start time for your daily work calendar.</td>
</tr>
<tr>
<td>End time</td>
<td>Select the end time for your daily work calendar.</td>
</tr>
</tbody>
</table>

**Scheduling template options**

Use these options to manage scheduling templates that you set up using the scheduling options on your site.

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Info</td>
<td>Shows the settings you set for the selected template.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the scheduling options on your site for the selected template.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected template from your profile.</td>
</tr>
</tbody>
</table>
## Use this option... | To...
---|---
Select All | Selects all the scheduling templates, allowing you to delete them all at once.

### Personal Meeting Room options

| Use this option... | To... |
---|---|
**Personal Meeting Room URL** | Go to your Personal Meeting Room page. You can click the URL from the My Profile page to preview your current Personal Meeting Room page.  
Your Personal Meeting Room page shows online sessions that you scheduled and any in-progress sessions that you are currently hosting.  
Users to whom you provide your personal URL can use this page to join any meeting that you are hosting. They can also download files in any folders that you share. |
**Welcome Message** | Enter the message that appears on your Personal Meeting Room page. A message can be a maximum of 128 characters, including spaces and punctuation.  
To specify a message, type it in the box, and then click **Update**. |
**Upload Image** | Upload an image file from your computer or another computer on your network to your Personal Meeting Room page. For example, you can upload a picture of yourself, your company’s logo, or a picture of your company’s product. Visitors to your page can see the image that you upload.  
The image can be an maximum of 160 pixels wide. If you upload a larger image, its width is automatically reduced to 160 pixels. However, the image’s aspect ratio is maintained.  
**Browse:** Lets you locate an image.  
**Upload:** Uploads the image that you selected.  
**Current Image:** Displays the image that currently appears on your Personal Meeting Room page.  
**Delete:** Removes the current image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page. |
**Customize branding of header area** | Upload a banner image to the non-scrolling header area for your Personal Meeting Room page. For example, you can upload your company’s logo or an advertisement. Visitors to your page can see the image that you upload. Available only if your site administrator has turned on this option for your account.  
The image can be an maximum of 75 pixels high. If you upload...
## Chapter 22: Using My WebEx

### Use this option... | To...
---|---
A larger image, its height is automatically reduced to 75 pixels. However, the image's aspect ratio is maintained. | **Brow*se**: Lets you locate a banner image.  
**Upload**: Uploads the banner image that you selected.  
**Current Image**: Displays the banner image that currently appears on your Personal Meeting Room page.  
**Delete**: Removes the current banner image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page.

### Productivity Tools Options

**Use this option...** | **To...**
---|---
Automatically download Productivity Tools when logging in to the WebEx service site | Specify that WebEx Productivity Tools should be downloaded automatically when you log in to the WebEx service site. If this option is turned off, you can still download Productivity Tools manually.

### Session Options

**Use this option...** | **To...**
---|---
Automatically delete meetings from My Meetings when completed | Specify that once a scheduled meeting ends, the meeting is automatically removed from your list of scheduled meetings on the My Meetings page, if the scheduled starting time has passed. If you do not select this option, the meeting remains on your list of meetings until you delete it.  
You can change this default setting when scheduling a meeting.  
Applies only to meetings and sales meeting. Does not apply to events, support sessions, or training sessions.

| **Default session type** | Specify the default session type that you host, if your user account lets you host different types of online sessions.  
For more information about session types, ask the site administrator for your WebEx service.  
You can change this default setting when scheduling a meeting. |
Use this option... | To...
--- | ---
Quick Start | Specify whether the Quick Start page appears in the content viewer once you start a meeting. The Quick Start lets you start sharing activities quickly, as an alternative to starting them from a menu or toolbar.
- **Show Quick Start to host and presenter:** The Quick Start appears in the content viewer for the host and presenter.
- **Show Quick Start to attendees:** The Quick Start appears in the content viewer for attendees. Select this option only if you intend to let attendees share information during your meetings.
You can change this default setting when scheduling a meeting.

Scheduling permission | Type the email addresses for any users whom you want to let schedule meetings for you. Separate email addresses with either a comma or a semicolon.
- **Select From Host List:** Open the Select Host page, which contains a list of all users who have accounts on your WebEx service Web site. On this page, you can select users whom you want to let schedule meetings for you.

Web page preferences options

Use this option... | To...
--- | ---
Home page | Set the first page that appears when you access your WebEx service Web site.

Time zone | Set the time zone in which you reside.
If you select a time zone for which daylight saving time (DST) is in effect, your WebEx service Web site automatically adjusts its clock for daylight saving time.
**Note:** The selected time zone appears:
- Only on your view of your WebEx service Web site, not other users' views
- In all meeting invitations that you send using your WebEx service Web site

Language | Set the language in which your WebEx service Web site displays text.
**Note:** The languages that appear in this list are limited to the languages that have been set up for your Web site.

Locale | Set the format in which your Web site displays dates, times, currency values, and numbers.
Editing your user profile

Once you obtain a user account, you can edit your user profile at any time to change account login information, contact information, and other options available for your account.

To edit your user profile:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 292).
2. On the navigation bar, click My WebEx.
3. Click My Profile.
4. Edit the information on the page.
5. When you are finished editing your user profile, click Update.

For descriptions of the information and options on the My Profile page, see About the My WebEx Profile page (on page 345).

Managing scheduling templates

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing your scheduling templates</td>
<td>About managing scheduling templates (on page 351)</td>
</tr>
<tr>
<td>view, edit, or delete a scheduling template</td>
<td>Managing scheduling templates (on page 352)</td>
</tr>
</tbody>
</table>

About managing scheduling templates

Scheduling templates let you save the options you set for a meeting for later use. Once you save a scheduling template, you can use it to quickly schedule another meeting, instead of setting the same options again. If you saved a scheduling template using the Save As Template option when scheduling a meeting, you can manage the template, as follows:

- View the options you set in the template.
Chapter 22: Using My WebEx

- Edit the options you set in the template.
- Delete the template.

Managing scheduling templates

You can view, edit, or delete any scheduling templates that you saved.

To manage scheduling templates:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 292).
2. On the navigation bar, click My WebEx.
3. Click My Profile.
   The My Profile page appears.
4. Under Scheduling Templates, select a template in the list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The name of the recording. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Create time</td>
<td>The time and date the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>The file size of the recording.</td>
</tr>
<tr>
<td>Create time</td>
<td>The date and time at which the recording was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the recording. The possible options are Enable or Disable.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
**Password** | Indicates whether a user must provide a password to view the recording.  
**Stream recording link** | Clicking the link lets you play the recording (available only for recording files with the `.arf` extension that were recorded by NBR).  
**Download recording link** | Clicking the link lets you download the recording.  
**Play Now** | Clicking the button lets you play the recording (available only for recording files with the `.arf` extension that were recorded by NBR). If you want to download the recording, you can also click the link for downloading under **Play Recorded a meeting Now**.  
**Send Email** | Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording. If you want to send the email with your local email client instead, click the link for using the email client under **Share My Recording**.  
**Modify** | Clicking the button opens the Edit Recording page.  
**Delete** | Clicking the button deletes the recording.  
**Disable** | Clicking the button disables the recording everywhere it is published on your WebEx Service Web site. (Available only for enabled recordings.)  
**Enable** | Clicking the button enables the recording everywhere it is published on your WebEx Service Web site. (Available only for disabled recordings.)  
**Back to List** | Clicking the button returns you to the recording list.

## Maintaining Personal Conference numbers

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining your Personal Conference number (PCN) accounts</td>
<td><strong>About maintaining Personal Conference number accounts</strong> (on page 354)</td>
</tr>
</tbody>
</table>
Chapter 22: Using My WebEx

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>add or edit a PCN account to obtain audio conferencing numbers or specify access codes</td>
<td>Adding or editing a Personal Conference number account (on page 354)</td>
</tr>
<tr>
<td>use your PCN account</td>
<td>Using your Personal Conference numbers (on page 357)</td>
</tr>
<tr>
<td>delete a PCN account</td>
<td>Deleting a Personal Conference number account (on page 359)</td>
</tr>
</tbody>
</table>

About maintaining Personal Conference number accounts

If your WebEx service website includes the Personal Conferencing feature and the Personal Conference number (PCN) option, you can create up to three PCN accounts. When scheduling a Personal Conference meeting, you can select a PCN account to use for your the audio portion of the Personal Conference meeting. You can also use your PCN account to start an instant audio conference from any phone, without scheduling it first.

Your PCN account also specifies the access code that you want to use to start the audio portion of the Personal Conference meeting, and the access codes that you want attendees to use to join the audio portion of the Personal Conference meeting.

You can delete a personal audio conferencing account at any time.

Adding or editing a Personal Conference number account

You can add up to three Personal Conference number (PCN) accounts. You can edit a PCN account at any time to change the following:

- The access code that you want to use to start the audio portion of the Personal Conference meeting
- The access codes that you want participants to use to join the audio portion of the Personal Conference meeting

To add or edit a Personal Conference number account:

1. Log in to your WebEx service Web website, and then select My WebEx.
2. Select Personal Conferencing.
   
   The Personal Conferencing page appears.
3 Select **Add Account** or, if you have already added an account, Select **Edit** by that account.

The Add/Edit Personal Conference Number page appears.

4 Edit the information on the page.

5 When you are finished add or editing the account, select **Close**.

For descriptions of the information and options on the Personal Conferencing page, see the topic *About the Personal Conferencing page* (on page 356).

For descriptions of the information and options on the Add/Edit Personal Conference Number page, see the topic *About the Add/Edit Personal Conference Number page* (on page 357).
Chapter 22: Using My WebEx

About the Personal Conferencing page

How to access this page

On your WebEx service Web site, click My WebEx > Personal Conferencing.

What you can do here

- Add, edit, or delete a Personal Conference number (PCN) account.
- View information about your existing PCN accounts.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Personal Conference number** | Shows the numbers for your Personal Conference number (PCN) accounts.  
With a PCN account, you can use the same conference numbers for all your meetings, including Personal Conference meetings that you schedule on your WebEx service Web site or that you start instantly from a phone.  
A PCN account also lets you specify the access codes that you want to use to start the audio portion of the Personal Conference meeting, and the access codes that you want attendees to use to join the audio portion.  
For details about the information in a Personal Conference number account, see About the Add/Edit Personal Conference Number page (on page 357). |
| **Account [x]** | Add new Personal Conference number (PCN) accounts or view and edit information about each of your PCN accounts.  
**Add account:** Opens the Create Personal Conference Number page, on which you can obtain a Personal Conference number (PCN) account. Appears only if you have not yet added the maximum of three accounts.  
**Default account:** Indicates that the PCN account is the default account that is selected when you schedule a Personal Conference meeting.  
**Set as default:** If you set up more than one PCN account, you can click this link to specify which account is your default account. |
| **Edit** | Open the Edit Personal Conference Number page, on which you can change the access codes for your PCN account.  
For details about the information in a PCN account, see About... |
Chapter 22: Using My WebEx

About the Add/Edit Personal Conference Number page

How to access this page

On your WebEx service website, click My WebEx > Personal Conferencing > Add Account or Edit.

What you can do here

Specify the audio conference access codes that you must provide to start the audio portion of a Personal Conference meeting or that attendees must provide to join the audio portion of a Personal Conference meeting.

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access code</strong></td>
<td>Specify the access code:</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Host access code</strong> (for you): Specify the access code that you must enter when you start a Personal Conference meeting. This code must be 8 digits in length.</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Attendee access code</strong> (for attendees): Specify the access code that attendees must enter to join the audio portion of a Personal Conference meeting. This code must be 8 digits in length.</td>
</tr>
<tr>
<td><strong>Allow attendee to join before host</strong></td>
<td>Allows attendees to join a Personal Conference meeting before the host starts it.</td>
</tr>
</tbody>
</table>

Using your Personal Conference numbers

Once you add a Personal Conference number (PCN) account, the account information provides the call-in numbers and access codes that you and attendees use to participate in the audio portion of a Personal Conference meeting.
To use your PCN account for a scheduled Personal Conference meeting:

1. When scheduling your meeting, on the Required Information page of the Advanced Scheduler, select the **Personal Conference** meeting type.
2. On the Audio Conference page, select a Personal Conference number account when setting audio conference options for the meeting.
3. At the scheduled time, dial the call-in number for your PCN account.
4. Follow the voice instructions to provide your access code.

Each invited attendee receives an email message containing the call-in number and the attendee access code that you assigned to him or her.

### Controlling the audio portion of a Personal Conference meeting

If you use your Personal Conference number (PCN) account to start the audio portion of a Personal Conference meeting, you and the participants can use the following keypad commands:

**Host commands**

<table>
<thead>
<tr>
<th>To...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial the phone number of a participant whom you want to add to the audio conference</td>
<td>*1</td>
</tr>
<tr>
<td>Lock the audio conference, preventing anyone else from joining it</td>
<td>*5</td>
</tr>
<tr>
<td>Unlock the audio conference</td>
<td>*5</td>
</tr>
<tr>
<td>Mute your microphone</td>
<td>*6</td>
</tr>
<tr>
<td>Unmute your microphone</td>
<td>*6</td>
</tr>
<tr>
<td>Let participants continue the audio conference without the host</td>
<td>*8</td>
</tr>
<tr>
<td>Then hang up your phone.</td>
<td></td>
</tr>
<tr>
<td>Mute all attendees</td>
<td>##</td>
</tr>
<tr>
<td>Unmute all attendees</td>
<td>99</td>
</tr>
<tr>
<td>Play the participant count</td>
<td>*#</td>
</tr>
</tbody>
</table>
Chapter 22: Using My WebEx

To… Enter…
---
Hear all keypad commands that you can use **

Attendee commands

<table>
<thead>
<tr>
<th>To…</th>
<th>Enter…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute your microphone</td>
<td>*6</td>
</tr>
<tr>
<td>Unmute your microphone</td>
<td>*6</td>
</tr>
<tr>
<td>Play the participant count</td>
<td>*#</td>
</tr>
<tr>
<td>Hear all keypad commands that you can use</td>
<td>**</td>
</tr>
</tbody>
</table>

Deleting a Personal Conference number account

You can delete a Personal Conference number (PCN) account at any time.

To delete a Personal Conference number account:

1. Log in to your WebEx service Web site, and then select My WebEx.
2. Select Personal Conferencing.
   The Personal Conferencing page appears, showing your PCN accounts.
3. Under the account that you want to delete, select Delete.
   A confirmation message appears.
4. Click OK.

Generating Reports

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of what reports you can generate from your WebEx service Web site</td>
<td>About generating reports (on page 360)</td>
</tr>
<tr>
<td>generate usage reports that provide information about each session that you have hosted on your site</td>
<td>Generating reports (on page 361)</td>
</tr>
</tbody>
</table>
About generating reports

If your user account includes the reports option, you can view the following reports:

---

**Note:**
- For some reports, if you click on the report link within 15 minutes after the meeting ends, you will see a preliminary version of that report. The preliminary report provides quick access to data before the final, more accurate data is available. The preliminary report contains only a subset of the information that is available in the final report.
- When the final, more accurate data is available, which is usually 24 hours after the meeting ends, the preliminary report is replaced by the final report.
- You can download both preliminary reports and final reports as comma-separated values (CSV) files.

---

**General Meeting Usage reports**

These reports contain information about each online session that you host. You can view the following reports:

- **Summary Usage report:** Contains summary information about each meeting including topic, date, start and end time, duration, number of attendees you invited, number of invited attendees who attended, and type of voice conference you used.

  **Note:** Initially, this report appears as a Preliminary Usage Summary Report, but after the final, more accurate usage data is available, it is replaced by the Final Usage Summary Report.

- **Summary Usage report CSV (comma-separated values) file:** Contains additional details about each meeting, including the minutes that all participants were connected to the meeting and tracking codes.

- **Session Detail report:** Contains detailed information about each participant in a meeting, including the time the participant joined and left the meeting, the attentiveness during the meeting, and any information that the attendee provided.

  **Note:** Initially, this report appears as a Preliminary Session Detail Report, but after the final, more accurate session detail data is available, it is replaced by the Final Session Detail Report.

---

**Access Anywhere usage report**

This report shows information about the computers that you access remotely, including the date and start and end times for each session.
Generating reports

You can generate usage reports that provide information about each online meeting that you have hosted on your site.

You can export or download the data to a comma-separated values (CSV) file which you can then open in a spreadsheet program such as Microsoft Excel. You can also print reports in a printer-friendly format.

To generate a report:

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Reports**. The My Reports page appears.
3. Choose the type of report you want to generate.
4. Specify your search criteria, such as a date range for which you want to view report data.
5. Click **Display Report**.
6. To change the order in which report data is sorted, click the column headings. The report data is sorted by the column that has an arrow next to the column heading. To reverse the sort order, click the column heading. To sort using another column, click that column's heading.
7. Do one of the following, as appropriate:
   - If you are viewing a general meeting usage report and want to display the report in a format that is suitable for printing, click **Printer-Friendly Format**.
8. If you are viewing the usage report for an a meeting and want to view the content in the report, click the link for the meeting name.
9. To export the report data in comma-separated values (CSV) format, click **Export Report** or **Export**.
10. If available, click links on the report to display more details.
Index


.atp files • 272, 273
  contact group • 353
during meeting • 176
during training session • 276
event templates
  scheduling events
    in meeting transcript • 179
    in meeting transcripts • 179
to participants • 179

  updated information to attendees • 92
files, overview • 320
for downloading during training session • 276
in address book • 353
in personal folders, overview • 320
information about • 330
information about files • 323
information about in personal folders • 323
.txt files
  for chat messages • 261
.ucf files
  opening • 212
  saving documents • 212
  saving presentations • 212
  saving whiteboards • 212

A
Access Anywhere
  using • 318
Access Anywhere Usage report
  description • 373
access codes for personal conference number account
  specifying • 367
account, user
  obtaining • 299
adding
contacts to address book • 344
meetings to calendar program • 20
new personal folders for file storage • 321
pages to shared documents • 205
personal conference number account • 367
slides to shared presentations • 205
address book
  adding contacts • 344
  creating contact group • 351
  importing contacts from file • 346
  importing contacts from Outlook • 349
  opening • 343
  searching for contacts • 350
  using, overview • 342
 annotating, shared software
  using annotation tools • 246
Annotation Color tool
  overview • 196
annotation tools
  for shared software, descriptions • 246
annotation tools, for shared documents
  Annotation Color tool, • 196
  Eraser tool, overview • 196
  Highlighter tool, overview • 196
  Line tool, overview • 196
  Pointer tool, overview • 196
  Rectangle tool, overview • 196
  Text tool, overview • 196
annotations, on shared documents
  clearing • 210
annotations, on shared documents
  selecting font • 210
answering polls
  stopping • 249
  taking screen capture • 250
  using tools • 246
application, shared
  ensuring good imaging of color • 254
attendees
  allowing to take personal notes • 280
  creating greeting for • 176
  creating message for • 176
  preventing from joining meeting • 177
audio files
  sharing a Web content • 218
B

bringing application to front on shared remote computer • 236
browsers, Web sharing • 218

C

calendar programs
overview • 20
calendar. See meeting calendar • 24
canceling
meetings • 95
Personal Conference meetings • 112
changing type of, editing, rearranging, deleting poll question • 267
chat messages
choosing sound alerts • 117
printing • 261
saving • 261, 262
sending • 259
checking system for UCF compatibility • 4
choosing
note taker • 281
clearing
all annotations on shared documents • 210
all pointers on shared documents • 211
selected annotations on shared documents • 210
your annotations on shared documents • 210
your pointers on shared documents • 211
closing
panels • 159
color in shared application, ensuring good imaging • 254
computer, setting up
Meeting Manager • 2
overview • 1
contact group
creating in address book • 351
contact information
adding to address book • 344
creating contact group • 351
importing to address book from file • 346
importing to address book from Outlook • 349
maintaining, overview • 342
searching for in address book • 350
viewing or editing in address book • 350
content viewer
resizing • 161
creating
poll questionnaires • 265

date • 25
selecting on meeting calendar • 25
daylight saving time, adjusting meeting times • 28
deleting
annotations on shared software • 246
contacts • 355
contacts from address book • 355
files • 325
files or folders • 325
from address book • 355
from personal folders • 325
meetings from My Meetings • 303
questionnaires • 267
shortcuts for One-Click Meeting • 154
displaying timer
during polling • 268
distribution list
creating in address book • 351
document sharing
before meeting starts • 83
starting • 197
docs, shared
adding blank pages • 205
advancing pages automatically • 202
annotating • 210
clearing pointers • 211
printing pages • 213
saving to file • 212
downloading
files • 325
from personal folders • 325
Meeting Manager • 1
published files during a meeting • 277
published files during a training session • 277
published files during an event • 277
shortcuts, for One-Click Meeting • 148
shortcuts, WebEx One-Click panel • 148
drawing annotations
on shared documents • 210
on shared presentations • 210
E

editing
  contact group in address book • 353
  contact information in address book • 350
  information about files in personal folders • 323
  information about recordings • 330
  Personal Conference meetings • 111
  personal conference number account • 367
  scheduled meetings • 92

email messages
  registering for meetings • 14

ending
  meeting • 180

eraser
  using to delete annotations on shared software • 246

Eraser tool
  overview • 196

erasing
  all annotations on shared documents • 210
  all pointers on shared documents • 211
  selected annotations on shared documents • 210
  your annotations on shared documents • 210
  your pointers on shared documents • 211

exchanging files
  during a meeting • 277
  during an event • 277
  during a training session • 277
  during event • 276
  during training session • 276

expelling
  attendee from a meeting • 178

Flash files
  sharing as Web content • 218

folders, personal
  adding new for file storage • 321
  moving files • 323
  opening • 321
  overview • 320
  searching for files • 325

font
  selecting for annotations • 210

G

generating reports • 373, 374

greeting
  creating for attendees • 176
  meeting information • 28

H

files
  .atp • 272, 273
  .ucf (Universal Communications Format) for multimedia • 212
  choosing sounds for alerts • 117
  choosing sounds for participant actions • 117
  during a meeting • 277
  during an event • 277
  during a training session • 277
  during an event • 276
  exchanging during a meeting • 277
  exchanging during a training session • 277
  exchanging during an event • 277
  exchanging during event • 276
  exchanging during training session • 276
  for chat • 261
  for poll questionnaire • 272
  for poll questionnaires • 273
  from personal folders • 325
  in personal folders • 323, 325
  in your personal folders, overview • 320
  moving or copying in personal folders • 323
  searching in personal folders • 325
  sharing on Personal Meeting Room page • 317
  stop publishing during event • 276
  stop publishing during training session • 276
  to personal folders • 322

header, custom
  adding to Personal Meeting Room page • 316

hiding
  contents of screen on shared remote computer • 235

Highlighter tool
  overview • 196

high-resolution color in shared application ensuring good imagi • 254

home page for site
  setting • 364
host key
  using to reclaim host role • 175
host role
  reclaiming • 175

i
images
  adding to Personal Meeting Room page • 316
importing
  contacts to address book from file • 346
  contacts to address book from Outlook • 349
information on meeting
  obtaining • 176
installing
  Meeting Manager • 2
  WebEx One-Click • 148

j
joining meetings
  from email invitations • 9
  from host's personal page • 11
  from meeting calendar • 10
  using meeting number • 11

k
keyboard
  disabling on shared remote computer • 234
keypad controls
  for audio-only meeting • 371

l
language and locale for site
  setting • 364
  leaving
meetings • 178
Line tool
  overview • 196
list of meetings, personal
  maintaining • 303
  overview • 301
locking
  access to meeting • 177
  shared remote computer • 236
logging in to and out from site • 300
maintaining
  contact information, overview • 342
  personal conference number accounts, overview • 367
  personal list of meetings • 303
  Personal Meeting Room page, overview • 315
making
  another participant the host • 174
manual installer
  Meeting Manager • 2
media players for UCF media files
  checking if installed on com • 4
meeting calendar
  Daily view • 24
  Monthly view • 24
  obtaining information • 19
  overview • 23
  refreshing • 28
  registering for meetings • 15
  removal of meetings • 23
  searching for meeting • 26
  selecting date • 25
  selecting time zone • 28
  sorting • 27
  Today view • 24
  Weekly view • 24
Meeting Manager
  overview • 1
  setting up • 2
  system requirements • 2
  uninstalling • 3
meeting minutes
  saving to file • 285
  taking during meeting • 283
meeting number
<table>
<thead>
<tr>
<th>Meeting Services</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System requirements</td>
<td>2</td>
</tr>
<tr>
<td>Meetings</td>
<td></td>
</tr>
<tr>
<td>Canceling</td>
<td>95</td>
</tr>
<tr>
<td>Editing</td>
<td>92</td>
</tr>
<tr>
<td>Ending</td>
<td>180</td>
</tr>
<tr>
<td>Leaving</td>
<td>178</td>
</tr>
<tr>
<td>Obtaining information</td>
<td>17</td>
</tr>
<tr>
<td>Registering</td>
<td>16</td>
</tr>
<tr>
<td>Restricting access</td>
<td>177</td>
</tr>
<tr>
<td>Scheduling for host</td>
<td>101</td>
</tr>
<tr>
<td>Searching for on meeting calendar</td>
<td>26</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Meetings, Joining</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>From email invitations</td>
<td>9</td>
</tr>
<tr>
<td>From host's personal page</td>
<td>11</td>
</tr>
<tr>
<td>From meeting calendar</td>
<td>10</td>
</tr>
<tr>
<td>Using meeting number</td>
<td>11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding to Personal Meeting Room page</td>
<td>316</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mouse</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabling on shared remote computer</td>
<td>234</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Multimedia</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharing as Web content</td>
<td>218</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Computers</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Using</td>
<td>318</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Contacts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding contacts</td>
<td>344</td>
</tr>
<tr>
<td>Creating contact group</td>
<td>351</td>
</tr>
<tr>
<td>Importing contacts from file</td>
<td>346</td>
</tr>
<tr>
<td>Importing contacts from Outlook</td>
<td>349</td>
</tr>
<tr>
<td>Opening</td>
<td>343</td>
</tr>
<tr>
<td>Searching for contacts</td>
<td>350</td>
</tr>
<tr>
<td>Using, overview</td>
<td>342</td>
</tr>
<tr>
<td>Viewing or editing contact information</td>
<td>350</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Files</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding folders</td>
<td>321</td>
</tr>
<tr>
<td>Maintaining, overview</td>
<td>320</td>
</tr>
<tr>
<td>Moving or copying files or folders</td>
<td>323</td>
</tr>
<tr>
<td>Opening</td>
<td>321</td>
</tr>
<tr>
<td>Searching for files</td>
<td>325</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Meetings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintaining</td>
<td>303</td>
</tr>
<tr>
<td>Overview</td>
<td>301</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Profile</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing</td>
<td>364</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note Taker</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Choosing</td>
<td>281</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting minutes</td>
<td>283</td>
</tr>
<tr>
<td>Options for meetings</td>
<td>280</td>
</tr>
<tr>
<td>Saving to file</td>
<td>285</td>
</tr>
<tr>
<td>Taking personal</td>
<td>283</td>
</tr>
<tr>
<td>Turning on or off during a meeting</td>
<td>280</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>One-Click Meeting</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>143</td>
</tr>
<tr>
<td>Removing shortcuts</td>
<td>154</td>
</tr>
<tr>
<td>Setting up</td>
<td>144</td>
</tr>
<tr>
<td>Setting up on service Web site</td>
<td>144</td>
</tr>
<tr>
<td>Starting from service Web site</td>
<td>149</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>One-Click panel</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing from computer</td>
<td>154</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>One-Click Settings page</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Descriptions</td>
<td>144</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>One-Click shortcuts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing from computer</td>
<td>154</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Opening</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Outlook</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding meetings</td>
<td>20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>For taking notes</td>
<td>280</td>
</tr>
</tbody>
</table>

| Saved chat files | 262 |
| Saved document | 212 |
| Saved presentation | 212 |
| Saved whiteboard | 212 |
| Shared documents | 197 |
| Shared presentations | 197 |
| Shared whiteboard | 200 |
| User profile | 364 |
| Your list | 329 |
adding new • 205
clearing annotations • 210
clearing pointers • 211
printing • 213
adding to calendar • 110
canceling • 112
definition • 107
editing • 111
setting up • 108
starting • 108, 370
using keypad controls during a Personal Conference meeting • 371
adding or editing • 367
deleting • 372
maintaining, overview • 367
obtaining • 367
using • 370
using to start a Personal Conference meeting • 370
adding new for file storage • 321
moving or copying files • 323
opening • 321
searching for files or folders • 325
add images and text • 316
overview • 315
setting options • 316
sharing files • 317
viewing • 315
saving to file • 285
taking during meeting • 283
joining meetings from • 11
obtaining information about meetings • 19
registering for meetings • 16
using on shared software • 246
overview • 196
adding blank slides • 205
annotating • 210
clearing pointers • 211
printing slides • 213
saving to file • 212
chat messages • 261
pages in shared documents • 213
shared whiteboards • 213
slides in shared presentations • 213
saving to file • 285
taking during meeting • 283
turning on for a meeting • 280
files during event • 276
files during training session • 276
seeing Access Anywhere • 318
adding to calendar • 110
canceling • 112
definition • 107
editing • 111
setting up • 108
starting • 108, 370
using keypad controls during a Personal Conference meeting • 371
adding or editing • 367
deleting • 372
maintaining, overview • 367
obtaining • 367
using • 370
using to start a Personal Conference meeting • 370
adding new for file storage • 321
moving or copying files • 323
opening • 321
searching for files or folders • 325
add images and text • 316
overview • 315
setting options • 316
sharing files • 317
viewing • 315
saving to file • 285
taking during meeting • 283
joining meetings from • 11
obtaining information about meetings • 19
registering for meetings • 16
using on shared software • 246
overview • 196
adding blank slides • 205
annotating • 210
clearing pointers • 211
printing slides • 213
saving to file • 212
chat messages • 261
pages in shared documents • 213
shared whiteboards • 213
slides in shared presentations • 213
saving to file • 285
taking during meeting • 283
turning on for a meeting • 280
files during event • 276
files during training session • 276
seeing Access Anywhere • 318
annotations on shared software • 250
chat messages • 261
copy of chat messages • 262
documents, shared • 212
notes to file • 285
poll questionnaires • 272
presentations, shared • 212
shared documents • 212
shared presentations • 212
shared whiteboards • 212
whiteboards, shared • 212
scheduled meetings
adding attendees • 92
changing agenda • 92
changing day and time • 92
editing • 92
scheduling meetings
and Microsoft Outlook • 52
Attendee Privileges page, overview • 87
enhancing security • 52
for someone else • 101
requiring password • 52
selecting document to share • 83
scheduling templates
about managing • 364
screen capture
taking of annotations on shared software • 250
screen resolution
reducing for shared remote computer • 233
searching • 26
for contacts in address book • 350
for files in personal folders • 325
for meeting on meeting calendar • 26
sending
chat messages • 259
Session Detail report
description • 373
setting up
for Access Anywhere • 318
for remote access • 318
for Windows • 2
Meeting Manager • 2
Meeting Manager, overview • 1
One-Click Meeting • 144
Personal Conference meetings • 108
setting up One-Click Meeting
on service Web site • 144
shared remote computer. See remote computer, shared • 232
sharing
Flash files, as Web content • 218
S
saving
poll results with participants • 271
streaming audio, as Web content • 218
streaming video, as Web content • 218
Web browsers • 218
Web content, overview • 217
sharing documents. See documents, shared • 83
sharing window
overview • 221
shortcuts
for One-Click Meeting, downloading • 148
shortcuts, for One-Click Meeting
removing • 154
shortcuts, WebEx One-Click panel
downloading • 148
slides, in shared presentations
adding • 205
clearing annotations • 210
clearing pointers • 211
printing • 213
software sharing
See also software, shared • 221
software, shared
ensuring good imaging of color • 254
using annotation tools • 246
viewing • 221
sorting
meeting calendar • 24, 26, 27, 28, 30, 32, 35, 37
sound alerts
assigning to chat messages • 117
assigning to participant actions • 117
starting
document sharing • 197
meeting before scheduled time • 93
meeting from email message • 93
Personal Conference meetings • 108
presentation sharing • 197
remote computer sharing • 229
teleeconference-only meeting • 370
Web browser sharing • 227
whiteboard sharing • 200
starting a One-Click Meeting
from Meeting Center • 149
from service Web site • 149
stopping
annotations on shared software • 249
remote computer sharing • 231
streaming audio
sharing as Web content • 218
streaming video
sharing as Web content • 218
Summary Usage report
description • 373
Summary Usage report CSV file
description • 373
system requirements
Meeting Manager • 2
taking notes
as single note taker • 283
meeting minutes • 283
personal • 283
specifying options • 280
taskbar icon shortcut • 149
teleeconference-only meeting
starting • 370
WebEx One-Clickinstalling • 148